Canon

RAW Image Processing, Viewing and Editing Software

Digital Photo Professional
Ver. 4.8
Instruction Manual

Content of this Instruction Manual

DPP stands for Digital Photo Professional.

In this manual, the screens used in the basic
operation instructions are from Windows 8.1.

» indicates the selection procedure of the menu.

Square brackets are used to indicate items such
as menu names, button names and window
names that appear on the computer screen.

Text inside < > indicates a key on the keyboard.

p.** indicates a reference page.

Click to move to the relevant page.

indicates the function for advanced

users who are experienced in handling image

processing software.

"2 : Marks helpful information when a problem
arises.

-
~

N1/
s

: Marks tips for using the software skillfully.

: Marks information that should be read
before use.

: Marks additional information you may find
helpful.

&

Switching Between Pages
Click on arrows on the bottom right of the screen.

@ : next page
() : previous page
: return to a page you had previously
displayed
Click on the chapter headings on the right side
of the screen to switch to the contents page of
that chapter. Also, click the item you want to

read about on the table of contents to move to
the relevant page.
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READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions
of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single
computer. You may physically transfer the SOFTWARE from one computer to another provided
that the SOFTWARE is used on only one computer at a time. You shall not install or use the
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware
configuration where the SOFTWARE is accessible to more than one CPU or to more than one
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE,
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART,
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or
copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for
use of the SOFTWARE. No updates, fixes or support will be made available for the
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose,
maintain and match the hardware and software components of your computer system. Thus
Canon does not guarantee uninterrupted service or correction of errors or that the functions or
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the
SOFTWARE is warranted only against defective material under normal use for a period of ninety
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt.
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge
when returned by you at your expense to your point of purchase and proven to be defective
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE
SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON'’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until
expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate
without notice to you if you fail to comply with any of the terms of this Agreement and you must
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software
Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in
the United States of America shall be governed and construed in all respects in accordance with
the laws and regulations of the State of New York, without reference to choice of law principles.
The terms of this Agreement as it relates to purchases of the Software in Canada shall be
governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of
the SOFTWARE is subject to the United States, Canada and other applicable copyright and
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its
affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY
AUTHORIZED OFFICER OF CANON.

.
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Introduction

Main Features of DPP

Following are the main tasks you can perform with images you have
downloaded to your computer.

* indicates processing that can be performed with JPEG or
TIFF images as well as RAW images.

View and organize images
Play back movies and save still photos

Adjust an image
Various image adjustments while maintaining the original image

Freely apply a Picture Style

View your image before and after adjustment in the same window

Trim and adjust the angle of an image

(trimming)

Resize an image
Correction of lens aberration
Digital Lens Optimizer

Automatic/manual dust erasure processing

JPEG/TIFF

Convert from a RAW image to a JPEG or

TIFF image and save
Process large numbers of RAW images in batches
Transfer the image to image editing software

Print an image
Link with EOS Utility for remote shooting

JPEG/TIFF

Color management compatibility
CMYK simulation for commercial printing

@ In DPP Ver. 4.8.20 or later, clicking [Check for updates] in the [Help]

menu allows you to check for update files on the server and
download any update files that are available.

To use this function, an environment with Internet access
(subscription to a provider and an in-place line connection) is
required. Internet Service Provider (ISP) connection fees or access
point connection fees may apply.
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System Requirements

OS (operating

Windows 10, Windows 8.1, Windows 7*

system)

Model PC with one of the above OS preinstalled
(Upgraded machines not supported)

CPU Core 2 Duo 2.0 GHz or higher (recommended Core i
series or later)

RAM 2.0 GB or more of RAM (4.0 GB or more

(memory) recommended)

Hard disk Installation: Min. 300 MB of available space

drive Operation: Min. 600 MB of available space
Resolution: XGA (1024 x 720) or more (1600 x 1200

Display or more recommended)

Colors: 16-bit color (65536 colors) or more

* May also be installed on a 32-bit version PC, but with restrictions on
operation. On 32-bit OSs, (32bit) is displayed on the [About Digital
Photo Professional 4] in [Help]. For information on restrictions, see
descriptions indicated with in this manual.

In DPP, to play back MOV or MP4 movies shot using a supported
camera, and to save still photos from movies, a 64-bit version of
Windows 8.1 or later is required.

* With Microsoft .NET Framework 4.5 installed

Supported Cameras

EOS-1D X Mark Il, EOS-1D X, EOS-1D C, EOS-1D Mark IV, EOS-1Ds
Mark 1ll, EOS-1D Mark Ill, EOS-1D Mark Il N, EOS-1Ds Mark Il, EOS-1D
Mark Il, EOS-1D, EOS-1Ds, EOS 5DS/EOS 5DS R, EOS 5D Mark 1V,
EOS 5D Mark Ill, EOS 5D Mark Il, EOS 5D, EOS 6D Mark Il, EOS 6D,
EOS 7D Mark Il, EOS 7D, EOS 80D, EOS 70D, EOS 60D/EOS 60Da,
EOS 50D, EOS 40D, EOS 30D, EOS 20D/EOS 20Da, EOS 10D, EOS
D2000, EOS D6000, EOS D30, EOS D60, EOS 77D, EOS REBEL T6S/
760D, EOS REBEL T7i/800D, EOS REBEL T6i/750D, EOS REBEL T5i/
700D, EOS REBEL SL2/200D, EOS REBEL SL1/100D, EOS REBEL T7/
2000D/1500D, EOS REBEL T6/1300D, EOS REBEL T5/1200D, EOS
REBEL T4i/650D, EOS REBEL T3i/600D, EOS REBEL T2i/550D, EOS
REBEL T1i/500D, EOS DIGITAL REBEL XSi/450D, EOS DIGITAL
REBEL XS/1000D, EOS REBEL T3/1100D, EOS DIGITAL REBEL XTi/
400D DIGITAL, EOS DIGITAL REBEL XT/350D DIGITAL, EOS REBEL
T100/4000D/3000D, EOS DIGITAL REBEL/300D, EOS M6, EOS M5,
EOS M3, EOS M2, EOS M, EOS M10, EOS M100, EOS M50,
PowerShot G3 X !, PowerShot G1 X Mark 11", PowerShot G7 X',
PowerShot G9 X!, PowerShot SX60 HS™!, PowerShot G5 X ',
PowerShot G7 X Mark II"', PowerShot G16 ', PowerShot $120 ",
PowerShot G1 X!, PowerShot G15 ', PowerShot S110™", PowerShot
$100™", PowerShot G9 X Mark I, PowerShot G1 X Mark I11'”,
PowerShot G9' 2, PowerShot G102, PowerShot G11™""2, PowerShot
G122, PowerShot S90 "2, PowerShot $95 12, PowerShot SX11S™"°2,
and PowerShot SX50 HS™ "2
*1 For RAW images, functions that are not in the camera (such as the
Auto Lighting Optimizer) and functions such as the Digital Lens
Optimizer cannot be used. However, Picture Styles, even if not in the
camera, can be used with the exception of some functionality.
*2 The following functions are unavailable.
- Basic Adjustment tool palette:
White balance [Fine-tune]
A portion of [Gamma adjustment]
Automatic gradation and luminance adjustment
Midpoint adjustment
Input white points range expansion
- Dust Delete/Copy Stamp tool palette
- Compositing tool
- HDR tool
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Supported Images

Image data
Image type Extension
.CR3
RAW | Images in the Canon RAW format .CR2
images | shot on supported cameras* TIF
Still .CRW
photos JPEG | Exif 2.2, 2.21 or 2.3-compatible JPEG JPG/.JPEG
images | images
TIFF | Exif-compatible TIFF images TIF/.TIFF
images P 9 ' '
Movies Movies shot with supported cameras MSX

* Compatible with RAW images shot with EOS D6000 or EOS D2000
that have been converted to RAW images using the CR2 Converter
and have the “.CR2” extension.
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RAW IMages ......ovieiiieeeeeee e
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When RAW Development is to be Done ................
Advantages of a RAW Image ..........coovevvvvicinnennnn.
Editing JPEG and TIFF Images........ccccevvvvceieieeeeeennns
Tool Palettes........co.oeeeeii e,

Editing with the Basic Adjustment Tool

Palette ...
Adjusting Brightness...........ooiiii
Changing the Picture Style............ccccooeeeeeiiiiiniee,
Using a Picture Style File..........................
Adjusting Color Tone by Changing White
BalanCe........oooiiiiiii e
Adjusting Color Tone Using Click White
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Tuning White Balance .............................. 51
Adjusting Contrast ...........ccvvveeeeieeiiii 52
Adjusting Brightness of Shadows/
Highlights .......eeeeee e 52
Changing Color Tone and Color Saturation........... 53
Adjusting Dynamic Range........................ 54
Adjusting Gradation and Luminance
Automatically ..........euveeeeiiiiiicee e, 55
Using the Auto Lighting Optimizer ..........cccc.......... 56
Adjusting Image Sharpness...........ccccceeeeeeeeeeenee. 57
Editing with the Tone Adjustment Tool
Palette......eeeeeeeeeee e 59
Adjusting Brightness and Contrast ........................ 59
Adjusting Color Tone Using Click White
BalancCe.......ccoviiiiiee e 60
Adjusting Tone Curve............................. 61
Adjusting Dynamic Range....................... 63
Using the Auto Lighting Optimizer ......................... 63
Editing with the Color Adjustment Tool
Palette........oeeeiiiee e 64
Editing with the Color Adjustment Tool
Palette......cccveeieeeeee e, 64
Editing with the Detailed Adjustment Tool
Palette........oeeeeieieee e 66
Reducing NOISE ..........cooovuiiiiiiiieeee e 66
Adjusting Image Sharpness..........ccccooevvveeiiiiinnnn. 67
Reducing Color Moiré in an Image ...........ccccvuuue.... 67
Editing with the Trimming/Angle Adjustment
Tool Palette.........uueeeiiiie e 68
Editing with the Lens Correction Tool Palette............ 71
Correcting Lens Aberration.............ccoevviiiiiinn. 71
Making Corrections...........ccccvveeeeeeeeeeeiieeciiieeee. 72
Shooting Distance Information Slider .................... 74

Correcting Multiple Images ata Time.................... 75
Digital Lens Optimizer .............cccccooiiiiiiiieeee 75
Using the Digital Lens Optimizer ..........ccc..ccccoooe. 76
Adjusting Image Sharpness..........cccccovvevviiieeeeeen.n. 78
Editing with the Partial Adjustment
Tool Palette ........oveeeeeiiiiee e 79
Making Partial Adjustments to Images
([Brightness], [Contrast], [Hue], [Saturation]).......... 79
Making Partial Adjustments to Images ([Reduce color
(0011 T1=] ) IR 81
Adjustment Groups.........ooooiiiiiiiiieeee e 82
Editing with the Dust Delete/Copy Stamp
Tool Palette ... 83

Performing Automatic Dust Erasure Processing .... 83
Automatic Dust Erasure Processing in the Main

WINAOW .....coviiiieiiccieee e 84
Manually Erasing Dust (Repair Function)............... 85
Erasing Unwanted Parts of an Image (Copy Stamp
FUNCLON)......ooi e 87
Setting Work Color Space............ccccccuvvvieeeeeeeeeeeeee, 88
Using the Soft-Proof Colors Function......................... 89
Specifying the Size when Opening RAW Images....... 90
Saving Editing Results..................cccuuneee 91
Saving Editing Contents to an Image ..................... 91
Saving as a separate image .............occccciieieeeenennn. 91
Re-Editing an Image.............cccccovvveeeeeee... 93
Utilizing Adjustment Contents (Recipe)..... 94
Copying a Recipe and Applying to Another
IMAGE....cc e 95
Savinga Recipeas aFile......ccccccooiiiiiiiiiiieee. 95
Loading and Applying Recipes........cccccevveeeeeeeeennnn. 96
(Lrecmire_) Adjusting by Comparing Multiple
0 F=Te T=Y TSSO 97
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Editing Efficiently .................cccc 98
Editing in the Edit Image Window .......................... 98
Changing the Thumbnail Display Position to
Horizontal..........covviiiiiiiiiieeeee e, 99
Gathering and Editing Images in the Collection
WINAOW ... 100

Compositing Images..................ccooeeee 102
Compositing Methods............ccccvviiieeeeieeeceiie, 105

Creating HDR (High Dynamic Range)

IMAGES ..eeiiiieeee e 106

Using the Dual Pixel RAW Optimizer......... 109

Microadjustment of the Position of Maximum
Sharpness and Resolution Using the Depth Information

Contained within the Dual Pixel RAW File ............. 109
Reposition the Viewpoint or Foreground Bokeh for a
More Pleasing Result............cccvvveeeeeieieiiiiiie, 110
Reduces the Appearance of Ghosting in
IMAGES ...t 111
Transferring a RAW Image to
PROtOSNOP....ooiieeeeeeeeece e 113
Customizing the Main Window Toolbar...... 114
Printing Images.........ccoooviiiii e, 115
Printingan Image..........ccccoovieeieeieee 116
Printing with Shooting Information........................... 117
Printing a Thumbnail List (Contact Sheet Printing).. 118
Plug-in printing.........oooooic e 119
Processing Large Numbers of RAW Images...... 120
Batch Apply White Balance to Images (Personal White
BalancCe).......oovvvviieeiiiiii e 121
Registering Personal White Balance ................... 121
Applying Personal White Balance........................ 122

Batch Save as JPEG or TIFF Images (Batch
Processing)....ccceeeeeeeiiiieiccceeeeee e 123

Batch Transfer Images to Image Editing

SOfWAIE ..o 125
Batch Change the File Name of Images................... 126
Changing the File Name of Images in the Order in the
Main WindOw ..........ceeeiiiiiieeiiiiiiiiirieeeeee e 126
Remote Shooting ... 127
Remote Shooting............ccoooiiiiiiiiii 128

Registering Click White Balance in the Camera... 131
Playing Back Movies and Saving Still Photos.... 133

Playing Back Movies and Saving Still Photos .......... 134
Specifying Preferences.........cccccceeeeiiiiiiiieniennn, 137
Specifying Preferences.............ccoccviviveeeeiecieee, 138
General Settings.........ccevvieiiiiiiiiiiieeeee e, 138
Image proCesSiNg .......ccoovvvieiiiieieieeee e 139
Color Management..........ccccccooeeeeiiiiiieeieeeeeeeeee, 141
View Settings.......coooeiiiiiiiiiee e 142
Properties Display Settings ..........ccccvvveeeeeeieiiinnn. 143
ReferenCe ... 144
Troubleshooting...........eeveiiiiiiiiiii e, 145
Deleting the Software (Uninstalling) ......................... 146
Image Frame Information in the Main Window and
Edit Image Window.............cccooviiiiieiie 147
GlOSSANY ...ttt 148
INAEX e 150
About This Instruction Manual .............................. 154

Trademarks .......ooeee e 154

* Sections with and in “4 Editing Images”

support not only RAW image editing but also JPEG/TIFF image
editing.

: All the functions explained in the section support
JPEG/TIFF image editing.

: Certain functions explained in the section support

JPEG/TIFF image editing.
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Starting up DPP

Double-click the desktop icon.

A

-

]

Network

| Ve )
Digital Photo Double-click

Professional 4

DPP starts up and the main window (thumbnail layout) appears.

v

Main window (thumbnail layout)

|§| If you drop a DPP-supported image file onto the icon on the

desktop, you can start up DPP and display the folder where the
image file is saved.

Introduction/
Contents

Dowrfi@ading
Images

Viewing
Images

Sorting
Images

Editing
Images

T

Printing
Images
S —
Processing

Large Numbers
of RAW Images

Remote
Shooting

—

Playing Back
ovies and Saving

Still Photos

Specifying
Preferences

|

Reference/
Index

|

00
©



Downloading Images to Your Computer

Download the images saved on the memory card inserted in the

camera. Downloading Images Using Your Card Reader
You can also download images to the computer using a third-party card
Downloading Images Using the Software “EOS Utility” reader
You can download images with “EOS Utility”, communication software Load the memory card into the card reader.
for the camera. ' o ) Start up DPP beforehand.
e el rriesing mage,lr o e 05 Open [My Gomputer] ) [EOS. DIGITAL] and drag the

[DCIM] folder to the [Desktop].

(& Digita A

The [DCIM] folder is copied to your computer.

All images are saved in folder units inside the [DCIM] folder.
Copying images to your computer will take some time when there
is a large number of images saved on the memory card.
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D Viewing Images

-

Viewing Images in the Main Window (Thumbnail Layout) ........... 12
Changing the Thumbnail Display..................cceeuunneee. 13
Using the Thumbnails Control Panel ........ 14
Using the Thumbnail Display Filter/Sort
FUNCHON ... 15
Displaying the Histogram Palette.............. 16
Enlarging and Viewing an Image in the Preview Window ............ 17
Enlarging and Viewing a Specific Area....................... 18
Displaying the Navigator Palette................ 18
Checking the Image in Detail ...................... 19
Displaying the Main Window (Multi-layout)................. 19
Checking an Image Using the Preview Control Panel......... 20
Changing the Magnification...............cccccceeeeeeiinn. 20
Comparing with a Pinned (Fixed) Image ................ 20
Displaying Multiple Images at the Same Time ....... 21
Displaying Grid Lines.............oooiiiiiiiiiiiiiiieee e 21
Displaying AF Points ............ccooeiiiiiiiiiiieeeeeeeeeee, 21
Displaying Areas Beyond the Set Range with Warning
Indicators (Highlight/Shadow Warning) .................. 22
Comparing Pre- and Post-Editing Images (Single-
Image Display)......cceeeeeeiiiiiiiiiieeeeeeee e 22

Comparing Pre- and Post-Editing Images (before/after
comparison) Arrange vertically/horizontally (two-
screen display) / Split vertically/horizontally (split-

image disSplay) .....ccccuvviiiiiiiieee e 23
Displaying Image Properties...........cccceveeeeeeeeeenenn. 23
Checking an Image in Multi-Function Preview ........... 24
Checking an Image in Second Windows.................... 25

Opening and Closing Window Panels (Panes)........ 26
Changing the Display Method and Order of Palettes ....... 27
Changing the Display Method (Dock/Float) of Palettes....... 27
Rearranging Palettes...........cccccceiiiiiiiiiiiiiiciieeeeees 27

=3 LYo [0 ] =T 28
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Viewing Images in the Main Window (Thumbnail Layout) Ditoductiod
Images downloaded to your computer are displayed as a thumbnails list —

in the main window (thumbnail layout). You can double-click an image to
open the preview window (p.17) and display the image at large size.

Downloading
Images

Main window Toolbar

Sorting
Images

Editing
Images
N
Printing
Images

Processing
Large Numbers
of RAW Images

Remote
Check marks (p.32, p.33) Forward/Reverse Shooting

Ratings (p.32, p.33)

Rotate image —

For information on icons displayed on the frame of a thumbnail, Playing Back
ovies and Saving

see “Image Frame Information in the Main Window and Edit ) ) ) i
Image Window” (p.147). ® On 32-bit OSs, up to only 1000 images can be displayed per AAdEE

folder. Starting with the 1001st image, images are handled in the =
same way as non-supported images. Try to maintain 1000 images Specifying

Preferences
or less per folder.

|§| For information on movie files, see “Playing Back Movies and Reference/
Saving Still Photos” (p.134). Index
When aspect ratio information is attached to an image shot with —_—
any supported camera other than the EOS 5D Mark Il, the image
is displayed as a cropped image (p.68). @ @
In the main window, in addition to this view (thumbnail layout),
you can select multi-layout. Multi-layout allows you to check the @
image in detail (p.19).




Changing the Thumbnail Display

You can change the size of the thumbnail images displayed in the main
window and select the information displayed for thumbnails.

Select the [Thumbnails] menu P desired item.

Thumbnails

Open preview screen Ctrl+Q

v | Thumbnail control panel  Ctrl+ Alt+N

Pin Alt+0

Apply display filter
Sort 3
Group RAW and JPG versions

v | Display split files as one thumbnail

Hide file name
+ | Default
With shooting info

List view
_—

Size 1 (84x=84) Ctrl+1
Size 2 (126=126) Ctrl+2

+ | Size 3 (168x168) Ctrl+3
Size 4 (252x252) Ctrl+4
Size 5 (384=384) Ctrl+5
Size 6 (512=512) Ctrl+6
AF points Ctrl+]

The display changes to the selected item.
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Using the Thumbnails Control Panel

The thumbnails control panel integrates various settings for viewing thumbnails.
By using this panel, you can view and specify the settings for thumbnails efficiently.

Thumbnails control panel functions

(1)
(2)
@)
(4)
®)
(6)
(7)

(1) (2) (3) (4) (5)(6) (7) (8) (9) (10)

Ot MOl Change the size of thumbnails
u Display thumbnails without file names
E Display standard thumbnails

E Display thumbnails with information

=} Display thumbnails in list

H Specify properties display settings (p.143)

Display a RAW image and JPEG image as a single image
Display a RAW image and JPEG image that were shot together
as a single image. When this setting is specified, viewing and
editing of images are as follows.

* Image displayed: Only the RAW image is displayed in all
windows.

» Edited image: The content which has been edited with any of
DPP’s functions (the tool palette etc.) will be applied to the
RAW image only. However, if you have used the following
functions, the adjustments will be applied to both the RAW
image and the JPEG image.

Deleting an image (p.38)

Moving or copying an image (p.38)
Checkmarking (p.32 to p.33)
Rating (p.32 to p.33)

Rotating an image (p.12)

(8) Display or play back split movie files as single movies
When you play back split movie files in DPP, this setting plays
back all the movie files in a continuous sequence from the
beginning.

» This is set to ON by default.

» Only the thumbnail for the first movie file is displayed.

» This setting will be kept and applied the next time DPP is
started up.

* When the following functions are used, they apply to all the
remaining split movie files, not just the first movie file:
[Copy], [Cut], [Delete], [Add to collection], [Rename Tool]

* When the Filter/Sort function (p.15) is used with thumbnails,
the function is only applied to the first movie file.

©) [Eselect all thumbnails
(10)

Cancel all thumbnail selections

The thumbnails control panel is displayed in the main window by
default. If it is not displayed, such as when screen settings have
been changed, you can display it by selecting [Thumbnail control
panel] in the [Thumbnails] menu.

In multi-layout (vertical thumbnails, p.19), only the thumbnail view
setting (Default thumbnail display) is possible.
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Using the Thumbnail Display Filter/Sort

Function

This function allows you to display only thumbnails that match the
selected filtering option or to specify an option for sorting thumbnails.

Set the [Filter] button on the [Filter/Sort pane] in the

main window to [ON].

File name

Specify settings.
(1) (5) 3) (4)

File name
¥ lens

All

Filter menu (2)

Filter menu list menu lists upward or downward

You can drag the bottom edge of the [Filter/Sort pane] to adjust

the display area of the filter menu lists upward or downward.

(1) Thumbnail display filter ON/OFF

By setting to [ON], only thumbnails matching the filtering option set

with (2) the filtering options menu are displayed.

Drag to adjust display area of filter

(2) Filtering options menu

Select a filtering option for the thumbnail display filter.

« After selecting a filtering item in the list box that appears by clicking
[¥] at the right on the filter menu, options appear in the filter menu
list. Select an option.

* You can select multiple options in the filter menu list.

(Hold down the <Shift> key and left-click with the mouse for
consecutive selection. Hold down the <Ctrl> key and left-click with
the mouse to select individually.)

* The filter menus/filter menu lists are prioritized from left to right.
You can specify filtering options from left to right to narrow down
filtering.

(3) Sorting options
Select an option for sorting thumbnails. If files were added, a “*” is
temporarily displayed after the option name. [Custom] is displayed if
you sorted thumbnails in a chosen way.

(4) Sort order selection
Select the order (ascending/descending) for sorting thumbnails.

(5) Filter lock button
When the filter lock button is clicked, filter settings will be kept and
applied when you switch to a different folder or the next time DPP is
started up. When the filter lock button is not clicked, filter settings
automatically change to [OFF] when you switch to a different folder
or the next time DPP is started up.

|§| In addition to thumbnail display, this function can also be used in
multi-layout.
You can open/close the panel by clicking the [¥] button at the
upper right of the [Filter/Sort pane].
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Displaying the Histogram Palette

The histogram palette shows a histogram of the selected image. You
can quickly check a histogram without opening a tool palette.

Select the [View] menu » [Histogram palette].
The histogram palette appears.

Histograrm

IRGE [

You can select any of the following four histograms from the
menu that appears when you right-click with the mouse.
[Brightness only], [RGB separately], [YRGB separately], [RGB
together]

You can click the [] button at the bottom right of the main
window to show/hide the [Histogram] palette.
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Enlarging and Viewing an Image in the Preview Window

Double-click

The preview window appears.
Up to 36 windows can be displayed at the same time for the
preview window.

([32bit) On 32-bit OSs, up to 4 windows can be displayed at the
same time.)

Preview window Tool palette

i 6l e

Click the [Eq] in the upper right of the preview window to close
the preview window.

|§| By selecting the [Preview] menu » [AF points] in the preview
window, you can display the AF points selected in the camera at
the time of shooting. However, AF points are not displayed for
images whose image size has been changed and then been
converted and saved (p.91), images for which you selected an
effect other than [Shot settings] as correction of fisheye lens
distortion aberration, or images which have had settings specified
during RAW processing on the camera for distortion correction or
chromatic aberration correction.
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Enlarging and Viewing a Specific Area

Click the area you want to enlarge.

The area you clicked is enlarged to 100% (actual pixel size).
Click again to revert to the full view.
To change the display area drag on the image.

-:\@/3 To display an image in an enlargement ratio other than 100%

Select any enlargement ratio from the [Preview] menu.

|§| While in the preview window, you can select the [Preview] menu »
[Preview control panel] to use various preview functions. For details,
see “Checking an Image Using the Preview Control Panel” (p.20).

Displaying the Navigator Palette

The navigator palette shows the enlargement area of a selected image.

Select the [View] menu » [Navigator palette].
The navigator palette appears.

Mavigator

When an image is enlarged in the preview or other window, the
enlargement display area is indicated in the navigator palette.
The area to be enlarged can be changed by dragging the
enlargement display area on the image.

Mavigator

r ]

Change the enlargement
display area by dragging

—— a
" o
L T T

i |

You can click the [ [} ] button at the bottom right of the main
window to show/hide the [Navigator] palette.
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Checking the Image in Detail

Displaying the Main Window (Multi-layout)

By switching the main window to “multi-layout”, you can use the preview control panel to check the image in detail.

Click a change layout button at the bottom of the main window (thumbnail layout).
The main window (multi-layout) appears.
In the main window (multi-layout), you can select from two layouts, with horizontal thumbnails or vertical thumbnails.

Click the area you want to enlarge in the image displayed in the preview display area to display the image at actual pixel size (100%). Click the
image again to revert to full display.

Main Window (thumbnail layout) Multi-layout (horizontal thumbnails)

Preview
display area

Thumbnail
display area

Layout change button

Horizontal thumbnails

Vertical thumbnails
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Checking an Image Using the Preview Control Panel

With Preview control panel, you can check the image in detail.

You can use this panel in the main window (multi-layout) and edit image
window. If the preview control panel is not displayed, you can display it
by selecting [Preview control panel] from the [Preview] menu. By
default, the [[E]] button and [] button are selected. When you select a
movie, the displayed content changes. For information on the display
when movies are selected, see “Playing Back Movies and Saving Still
Photos” (p.134).

Changing the Magnification

200% - |E:] |-§-) v Y Y |E| m - u:n:n:n - GJ - ﬂ -

Display the image at actual pixel size (100%).

El

Click the [ [§ ] button to display the image at the set
magnification displayed. If the [[ElE]] button is used to
enlarge/reduce the image, the magnification set for this
button also changes accordingly*.
*Excluding actual pixel size (100%)

Enlarge/reduce the image.

Revert the zoomed image back to fit-to-window view.

Comparing with a Pinned (Fixed) Image

You can split the window into two sections, and compare the images on
the left and right by “pinning” an image in the left section then scrolling
images in the right section. It improves efficiency of image selection.

K1 200% v ( -E-‘) 71 " |E| m - n:u:n:u - OJ - -

Select an image and click the [[g]] button.

Pinned (fixed) image

The window divides into left and right, and the selected image is
pinned.

When you pin an image and perform scrolling, the image on the
left (pinned image) remains and only the image on the right is
scrolled, which is convenient for image selection.

To pin another image, select the image, then select [Pin] from the
menu that appears when you right-click with the mouse.

After pinning an image, you can click the [] button to switch
between top-bottom and left-right split screens.
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Displaying Multiple Images at the Same Time

u"n"n:n v oj v ﬂ v

x1 2000+ © @ [F~[A~[d~ [ & ~

Select multiple images, and click the [[&]] button.

The selected image is displayed.
You can display up to 8 images.

® On 32-bit OSs, this function is not available.
(The [[&]] button is not displayed.)

Displaying Grid Lines

u"n"n:n v Oj v ﬂ v

x1 2006~ © @ [FA~MA~[~ @ B ~

Click the [[] button beside the [[E]] button, and set
the spacing between grid lines on the menu that
appears.

To set the spacing, enter values (8 to 256, in pixels), or move the
slider.

After specifying settings, click the [Close] button and close the
window.

Select an image and click the [[E]] button.

The image with grid lines is displayed.
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changed and then been converted and saved (p.91), images for
which you selected an effect other than [Shot settings] as correction @ @
of fisheye lens distortion aberration, or images which have had
settings specified during RAW processing on the camera for @
distortion correction or chromatic aberration correction.



Displaying Areas Beyond the Set Range with Select an image and click the [EF]] button.
Warning Indicators (Highlight/Shadow On the opened image, if there is an area that exceeds the value
Warning) entered in step 1, the highlighted part of that area is displayed in

red and the shadowed part is displayed in blue. If you selected
different warning colors, the parts are displayed in the specified
colors.

You can set up warning indicators for both highlighted and shadowed
parts, which is effective for checking the clipped highlights and shadows
and preventing excessive adjustment of an image. Where the area on
the image has exceeded the set range, you can display the highlighted

part in red and the shadowed part in blue. Comparing Pre- and Post-Ed|t|ng |mages
(Single-Image Display)
x1 2000~ © @ [F~[[A~[~- W 2- &% - oF- H-

x1 200%~ © @ [ -[{A~[d~ [ B~ & -~ Oz5- H~

Click the [[]] button beside the [EF]] button, and

specify settings on the menu that appears. Select an image that is being edited and click the

[[iE] button.

Highlight/shadow warning display settin... n By clicking the button, the display switches between the image
before editing and the current image (being edited).

Show shadow warnings
Threshold{0-64) 32
Warning color -
Show highlight warnines
Threshold{(192-255) 254
Warning color -

Ciloze

Checkmark the [Show highlight warnings] and [Show shadow
warnings] checkboxes and enter the warning values.

You can also select different warning colors from the dialog that
appears when you click the [[ .. ]] button.

After specifying settings, click the [Close] button and close the
window.
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Comparing Pre- and Post-Editing Images
(before/after comparison) Arrange vertically/
horizontally (two-screen display) / Split
vertically/horizontally (split-image display)
You can display before and after versions of an adjusted image in the
same window and check the adjustment results.

This function allows you to adjust an image while comparing the original
image and image being edited.

x1 200%~ ©@ ® [Fv[{~[C~& ®=®~- & - %~ H-

Select an image that is being edited and click the
[[EH] button.

0

o il | B e

The image is displayed in two-screen display (Arrange vertically).

The image before editing is on the left, and the currently edited is
on the right.

Change the image display.

The display switches in the following order by clicking the [[Ei]]
button.

Arrange vertically (two-screen: left/right) > Arrange horizontally
(two-screen: top/bottom) = Split vertically (split-image: left/right)
- Split horizontally (split-image: top/bottom)

Displaying Image Properties

Display the shooting and recipe information for an image in the screen.

You can select items to be displayed.

x| 200% v |%) |-B vvv |E| EH v dm v QJ L v
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Select [Display settings for preview properties] from the
[Properties to display] pulldown menu.

Specify display items with the [Add >>] button and [<< Remove]
button. ltems that can be selected appear in the list box at left,
and actually displayed items appear in the list box at right. You
can also change the display order with the [Move Up] button and
[Move Down] button.

After specifying settings, click the [OK] button.

With the [Preview properties font] option, you can specify the font
used for information displayed in the preview window.

Select an image and click the [[[i]] button.

The image and properties selected in step 2 are displayed in the
screen.

If the recipe contents of an image being edited are displayed in
before/after comparison (two-screen display/split-image display),
edited items are displayed in red.

|§| All the property items may not be displayed depending on the
combination of window, preview window, or the size of thumbnails.

Checking an Image in Multi-Function Preview

The preview window shows the coordinates of the mouse cursor and the
work color space. By switching to multi-function preview, you can also
check image details in the same way as the main window (multi-layout).

Select the [Tools] menu » [Preview screen display
settings], and then [Multi-function preview] from the
dialog that appears.

Open the preview window (p.17).

A multi-function preview with various functions at the bottom of
the screen is displayed.

& Digital Photo Professional 4 - [IMG 0001.CR2]

File Edit View Thumbnails Preview Label Adjustment Tools Window H

Bl sl 200% v |© @  [AriE-Fa- 60 &~ & - 9

For how to use the displayed functions, see “Viewing an Image in
the Main Window (Thumbnail Layout)” (p.12) and “Checking an
Image Using the Preview Control Panel” (p.20 to p.24).
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Checking an Image in Second Windows

Second windows are preview windows that you can open additionally
for thumbnails and image previews. You can display up to 4 second
windows for an single image to check the focus in all parts of the image,
etc.

Select an image, and then select [Show second
screen] from the menu that appears when you right-
click with the mouse.

v i
ol ©.  Digital Photo Prafessional 4 - (IMG_0001.CR2) &3

o il | B [ e

A second window is displayed.

To display an additional second window, repeat the operation.
You can change the size of second windows as desired.

Click the displayed image to switch between actual pixel size
(100% view) and fit-to-window view.

When you magnify an image in the second window, the right-
clicked position on the image will be the center for the
magpnification.

@ On 32-bit OSs, second windows cannot be displayed.
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Opening and Closing Window Panels (Panes)

Panels (panes) at the top, bottom, left, and right of each window can be
closed to suit the tasks being performed.
You can use DPP in an optimal layout.

Click the [[J"l]] for a panel to open or close.

Example: main window (thumbnail layout)

When a panel is closed, you can point to [[JJ"l}] with the mouse
to temporarily open the panel.
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Changing the Display Method and Order of Palettes

For any palette (tool palette, navigator palette, histogram palette, quick
check palette, and camera control palette), you can change how the
palette is displayed (docked/floating), or the display order of multiple
docked palettes.

Changing the Display Method (Dock/Float) of Palettes

Right-click on the palette’s title bar (where its name
is shown) and click [Dock/float] in the dialog that
appears.
A docked palette is then displayed floating, and a floating palette
is then displayed docked.

To revert to the original display method, repeat the same
operation again.

Rearranging Palettes

When multiple palettes are docked, you can rearrange their order from
top to bottom.

Right-click on the palette’s title bar (where its name
is shown) and click [Move one up] or [Move one
down] in the dialog that appears.

The order of the palettes is changed.
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Exiting DPP el

H H 1 1 N —
In the main window, select the [File] menu » [EXxit]. —
Downloading
: . Images
Close window Ctrl+W
Save Ctrl+5
Save As... Ctrl+Shift+5
Convert and save... Ctrl+D
Batch process... Ctrl+B
Save still image from movie...  Ctrl+5Shift+D .
Sorting
Print... Ctrl+P |mages
Print with detailed setting... Ctrl+Alt+P
Print contact sheets Alt+5Shift+P
Plug-in printing 3 Editlng
Add to collection Ctrl+G Images
Rermnove from collection Ctrl+5hift+G
Clear collection Printing
Select collection > Images
Delete collection 3 —_
Bookmark Processing
Remove bookmark Large Numbers
: of RAW Images
Move to Recycle Bin Del - )
Exit Alt+F4
[ - Remote
DPP exits. Shooting
N —
Playing Back
ovies and Saving
Still Photos
Specifying
Preferences
Reference/
Index
 ——
|§| A confirmation dialog box for saving the images appears when you @ @
try to exit DPP without saving the adjusted image. Click the [Yes to
all] button to save the adjustment contents (recipe) to all the images @
adjusted.



3 Organizing and Sorting Images

Efficiently Checking/Sorting Images........................ 30
Sorting IMages ........uvvvveeeiiiiieieeiceeceeeeeeee e, 32
Attaching Check Marks..........ccccvveeeeeeeeeeeiiiicce, 32
Setting Ratings .......c.oooiiiiiiii 32
Sorting Images in the Main Window ..............ccccce...... 33
Attaching Check Marks in the Main Window .......... 33
Setting Ratings in the Main Window....................... 33
Arranging Images in the Main Window....................... 35
Arranging by TYPE ..oooeeeeiiiiiieeeeee e, 35
Arranging Freely ... 35
Displaying a RAW Image and JPEG Image as a Single
=T [ TSRS 36
Checking Image Information................cccvvvveiiiiininnnnnns 37
Organizing IMages .........ccceeieeiieeeeeeeeeeeee e 38
Deleting an Unwanted Image............ccccooeceeeeeeiininenn. 38
MoVING IMAagES .......ueiiiieiiiiiiie e 38
Moving Images in Folders ...........cccccevveiiiiiiieeeeeee. 39
Registering Frequent-Use Folders (Bookmark
Registration) .........ccccccoooiiiiiiiii e 39
Deleting Bookmarks ..............ccoeecciiiiieeieeieeee e, 39
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Efficiently Checking/Sorting Images

You can enlarge images displayed as thumbnails in the main window
and efficiently check each image. You can sort images into groups.
Note that this function does not apply to movie files.

Select multiple images to check in the main window.

Display the quick check window.
Click the [Quick check] button.

File Edit View Thumbpails Preview Label Adjustment Tools Window Help

Edit Irmage Clui ek Remote Shooting

Folder Eank mark Filter ON OFF o

=-[ i Deskiop
The quick check window appears.

Click the [E] or [[H] button to switch between
images to be checked.
Quick check window

All the images displayed in the main window can be checked in
the quick check window.

If you click the [[l] button, the first image is displayed, and if you
click the [[§]] button, the last image is displayed.

Click the [[B]] button to return to the main window.
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Click the area you want to enlarge.

The area you clicked is displayed at 100% (actual pixel size).
To change the display position, drag on the image.

If you click the [ ] button, you can display the image at 50%.
Click again to revert to the full view.

To exit, click the [[BJ] button.

In addition to 100% and 50%, you can display images at 12.5%,
25%, 200%, 300%, and 400%. Click the [] button beside the

] button on the screen, and select a magnification from the
menu that appears.

If you click the [ [EZ] button (the selected magnification appears
on the button), the image appears at the selected magnification.
However, after the quick check window is closed, the image
returns to its original 50% view.

When [AF Point] is checkmarked, you can display the AF points
selected in the camera at the time of shooting. However, AF
points are not displayed for images which have had their image
size changed and then been converted and saved (p.91), which
have had settings specified during RAW processing on the
camera for distortion correction and chromatic aberration
correction, which are composited, or which are created as HDR
(High Dynamic Range) images.

Y

-@Q)> Convenient functions of the quick check window

To check only selected images

You can use the quick check window to check only selected images
by selecting the desired images from those displayed in the main
window and then performing step 1.

Switching between images using the keyboard

You can also switch between images by pressing the <—> or <«>
key.

Switching between screens using the keyboard

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

Operations using the menu

Each operation can also be performed with the menu which appears
when you right-click with the mouse on an image.
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Sorting Images

You can sort images by attaching check marks or setting ratings
(indicated with [ %] marks) for each subject or theme.

Attaching Check Marks

Display the image you want to attach a check mark
to, and then click any one of [El] to [A].

Thurmbnail position

o Bottom

@ L=it
\/1 \.-»'2 v"3 v"4 \.»'5 . Click

The selected check mark appears in the upper left of the window.

Check mark

Click the [Clear] button to remove the check mark.

|§| The values of check marks attached to images in versions before
DPP 4 are not maintained.
You can also attach check marks from the menu that appears by
right-clicking with the mouse on an image in the main window.

Setting Ratings
Display the image you want to rate, and then click
any one of the [¢].

o Bottom . Left
\/1 \/2 \/3 \/4 \/5

Click

I+ <

B 4F roints

Info

The rating is set and an icon corresponding to the selected [§¢]
appears in the upper left of the window.

(Window shown with a rating of three [%])

To set [Reject], click the [Reject] button. Click the [Reject] button
again to cancel.

Rating icon

To cancel the rating, click the same [¢%] as when the settinwas
made on the right of the window.

@ As the file structure of the image data is changed when a rating is
set to an image, it may not be possible to check the image
information in third-party software.
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Sorting Images in the Main Window

You can also sort images in the main window by attaching check marks

or setting ratings (indicated with [§%] marks) for each subject or theme.

Attaching Check Marks in the Main Window

Select the images you want to attach a check mark
to, and then click any of [[El ] to [E&]-

.".fi_n o : Select

o

IMG_0001.CR2

4

. e *13*'14 = = .F;W:. I = T T S Click
The selected check mark appears in the upper left of the image
frame.

Check mark

. il | B | el

Click the check mark again to remove the check marks.

Setting Ratings in the Main Window

Select the images you want to rate, and then click
any of the [¢].

.‘l.r:im-

o | B W e
Select

Click (changes to [3%] after clicking [2])

The rating is set and an icon corresponding to the selected [§¢]
appears in the image frame.
(Sample window shown with a rating of three [¢%] as an example)

Rating icon

To cancel the rating, click the same [s%] as when the setting was
made.

Set [Reject] with the [Label] menu or the quick check window
(p-30).
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Vs

i@i— To select multiple images in the main window

Click on desired images while holding down the <Ctrl> key. To select
multiple consecutive images, click on the first image, and then click on
the last image while holding down the <Shift> key.

|§| The [Label] menu can also be used to attach check marks and set
ratings.

You can display and change the rating settings set in DPP with other

EOS software and with any supported EOS DIGITAL camera (for the

EOS 7D, version 2.0.0 or later firmware) except the EOS-1D Mark 1V,

EOS-1Ds Mark lll, EOS-1D Mark lll, EOS-1D Mark Il N, EOS-1Ds

Mark I, EOS-1D Mark Il, EOS-1D, EOS-1Ds, EOS 5D Mark Il, EOS

5D, EOS 50D, EOS 40D, EOS 30D, EOS 20D/EOS 20Da, EOS 10D,

EOS D2000, EOS D6000, EOS D30, EOS D60, EOS REBEL T2i/

550D, EOS REBEL T1i/500D, EOS DIGITAL REBEL XSi/450D, EOS

DIGITAL REBEL XS/1000D, EOS DIGITAL REBEL XTi/400D

DIGITAL, EOS DIGITAL REBEL XT/350D DIGITAL, and EOS

DIGITAL REBEL/300D.

» EOS Utility version 2.9 or later:

Ratings set in DPP are displayed. However, [Reject] is not
displayed and you cannot change rating settings.

» With any supported camera (for the EOS 7D, version 2.0.0 or
later firmware) except the EOS-1D Mark IV, EOS-1Ds Mark I,
EOS-1D Mark Ill, EOS-1D Mark Il N, EOS-1Ds Mark Il, EOS-1D
Mark Il, EOS-1D, EOS-1Ds, EOS 5D Mark I, EOS 5D, EOS 50D,
EOS 40D, EOS 30D, EOS 20D/EOS 20Da, EOS 10D, EOS
D2000, EOS D6000, EOS D30, EOS D60, EOS REBEL T2i/
550D, EOS REBEL T1i/500D, EOS DIGITAL REBEL XSi/450D,
EOS DIGITAL REBEL XS/1000D, EOS DIGITAL REBEL XTi/
400D DIGITAL, EOS DIGITAL REBEL XT/350D DIGITAL, and
EOS DIGITAL REBEL/300D:

Ratings set in DPP are displayed in the playback screen. You can
also change rating settings. However, you cannot display or
change settings for [Reject].

Reversely, you can also display and change in DPP the rating
settings set for images on any supported EOS DIGITAL camera
(for the EOS 7D, version 2.0.0 or later firmware) except the EOS-
1D Mark 1V, EOS-1Ds Mark lll, EOS-1D Mark Ill, EOS-1D Mark I
N, EOS-1Ds Mark Il, EOS-1D Mark I, EOS-1D, EOS-1Ds, EOS
5D Mark Il, EOS 5D, EOS 50D, EOS 40D, EOS 30D, EOS 20D/
EOS 20Da, EOS 10D, EOS D2000, EOS D6000, EOS D30, EOS
D60, EOS REBEL T2i/550D, EOS REBEL T1i/500D, EOS
DIGITAL REBEL XSi/450D, EOS DIGITAL REBEL XS/1000D,
EOS DIGITAL REBEL XTi/400D DIGITAL, EOS DIGITAL REBEL
XT/350D DIGITAL, and EOS DIGITAL REBEL/300D.

.
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Arranging Images in the Main Window

You can arrange images in the order of the types of check marks you
have attached to images, or in the order of date and time at which the
images were shot. You can also freely arrange images by moving them
individually.

Arranging by Type

Select the [Thumbnails] menu » [Sort] » desired item.

The images are arranged in the order according to the selected
item.

Main sort items
File name: ascending order

Description

Images are sorted by file name in
alphanumeric order (0 to 9 » A to Z).

Extension: ascending order
RAW images - JPEG images = TIFF
images > MOV movies > MP4 movies.

Images are sorted in the following order:

Shooting Date/Time: Images are sorted by shooting date and
ascending order time from the earliest.

Check mark: ascending order Images with check marks take priority
and are sorted in number order.

Rating: ascending order

Camera Model Name:
ascending order

Sorted in order of fewest [$%].

Sorted in order of least digit used in the
camera model name. (Ex.: EOS-1D X —»
EOS 6D)

Lens: ascending order Sorted in order of shooting lens with

shortest focal length.
ISO speed: ascending order Sorted in order of lowest speed.

Shutter speed: ascending order Sorted in order of fastest shutter speed.

Aperture value: ascending order Sorted in order of lowest aperture value.

Focal length: ascending order Sorted in order of shooting lens with
shortest set focal length.

* You can also arrange images by [Image Size], [RAW Type], and
[Recipe editing status].
* Descending order sorts all items in the reverse of ascending order.

Arranging Freely

Drag and drop the image to the desired location.

Di Pre nal 4 - [Fold er

The image moves to the desired location.

You can also select multiple images (p.34) and move them.

The order of rearranged images is temporarily registered as
[Custom] in the [Filter/Sort pane] and maintained until you exit
DPP or select another folder in the folder area.

Select the [Thumbnails] menu P [Sort] » [File name] and [Ascending]
to revert to the order before the images were rearranged.

:@E Maintaining the order of rearranged images

You can maintain the order of rearranged images even if you exit DPP
or select another folder in the folder area.
Maintain order without changing image file names
You can use the [View Settings] tab sheet in [Preferences] to maintain
the order of images without changing the image file names (p.142).
Maintain order and change image file names
You can use the rename function to maintain the order of images and
change the image file names all at once in the order they were
rearranged (p.126).
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Displaying a RAW Image and JPEG Image as a Single Image

You can display and handle a RAW image and JPEG image shot
simultaneously as a single image. In particular, you can halve the
number of images displayed in the main window and you can streamline
the checking of a large number of images shot simultaneously.

Select the [Thumbnails] menu » [Group RAW and
JPG versions].
The main window display updates and the simultaneously shot
RAW image and JPEG image are displayed as a single image
with the [(R+J)] mark (p.147).

? RAW images with the extension “.CR2” or “.CR3” can be
displayed as a single image

Images that can be displayed as a single image are images shot with a
camera that shoots RAW images with the extension “.CR2”, “©.CR3”, and
JPEG images simultaneously. Images that have been simultaneously
shot with a camera that shoots RAW images with the extension “.CRW”
or “.TIF” cannot be displayed as a single image.

-I\@/E When a single image is displayed

Image displayed

The RAW image is displayed in all windows.

Edited image

The content which has been adjusted with any of DPP’s functions (the
tool palette etc.) will be applied to the RAW image only.

However, if you have used the following functions, the adjustments
will be applied to both the RAW image and the JPEG image.

* Deleting an image (p.38)

» Moving or copying an image (p.38)

Checkmarking (p.32, p.33)

Rating (p.32, p.33)

* Rotating an image (p.12)

Images added to the [Collection] window

When you add a RAW image and JPEG image displayed as a single
image to the [Collection] window, the single image is marked with the
[(R+J)] mark. However, because the RAW and JPEG images are
actually added individually, the number of images shown on the
[Collection] tab sheet increases by 2.

@ If you cancel selection of [Group RAW and JPG versions], the RAW
image and JPEG image are displayed as separate images.
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Checking Image Information

Select the image for which you want to check the
image information.

Select the [View] menu » [Info].

The image information window appears.

Select a tab sheet and check information.

Image information window

[Exif Information]  [XMP/IPTC Information] [Recipes]
tab sheet tab sheet tab sheet
IMG_0001.CR2 x| IMG_0001.CR2 x| IMG_0001.CR2

Exif Tnformation | XMP/IPTC Information | Recipes Exif Information | XMF/IPTE Tiformation | Recipes Exif Information | XMP/IFTG Information |} RECIREs |
Hem Value ~ [Deseription - Tem Valie
[Document Title]
File Hame MG_0001GR2 Brightness adiustment  0.00
il Sice fy, HRHHRRRARRR White balance (At}
Ficture Style {Landscape)
GCamers Model Ganon EOS XXX [Greator] Contrast 00
Fir myvare Firmware Version XX PHETETEOEE Shadow 01
) SO . Highlight 0
Shooting Date/Time  XX0OX/KKKAN KA [reator's job Title] Color tone 0
Cuner's Hame MO0 Color saturation 00
Shooting Mode Aperture~Priority AE it Lingar off
Eeeon Black point 00
TulShutter Speed) 1440
v{Shutter Speed) HHGOGHRO0 Midpoint 000
Av(Aperture Valus) 55 \hits point 000
letering Made valuative Metering arpneEss treneth : 4.0 Finer
s Mod Evalustive M E:;;’}'{D:;;}‘QVQ‘H] Sh Strenath = 44 Fi
Exposure Compensa., 0 Auto Lighting Optimizer  Standard
RGE tone curves Orieinal
150 Speed 200 [Keymords] Reduce luminance roise 9.0
futo 180 Speed ON HHHIRRHRRN Reduce chrominance noise 110
- Color adjustment off
Lens EFI7-40mm 1/4L LSM [Copyright Status] o o
Focal Length 40mm RRIHHHHOKRK Saturation ~1000
Image Size KUK oo ] Fled ot
; i el Orange off
Aspect ratio a2
XHIOHHAORK Yellow ot
Tmage Quality A reen o
Flash ot [Sopyrisht info URLT fa o
RO
FE lock OFF Blue oft
Furpl ot
White Balance Mode  Aut M'f;;"a o
AF Mode Manual focusing Lens correction On
Picturs Styls Landsoaps Digital Lens Optimizer ~ Off
sh . Feripheral illumination ~ 40.0
arpness v Chromatic aharration mnn RN AN
< > <

-

Shooting information is displayed in the [Exif Information] tab
sheet, while IPTC* information appended to the image after
shooting is displayed in the [XMP/IPTC Information] tab sheet.
IPTC* information provides additional comments on images,
such as captions, credits and the shooting location. The
information is sorted into 5 different categories and can be
viewed by selecting [Description], [IPTC Contact], [IPTC Image],
[IPTC Content] or [IPTC Status] from the list box in the [XMP/
IPTC Information] tab sheet.

* International Press Telecommunications Council (IPTC)

The contents of the [Exif Information] tab sheet will vary
depending on the camera model.

Recipe contents applied to an image are displayed in the
[Recipes] tab sheet.

A/
~

@< Convenient uses in the main window

Switching displays

If a different image is selected in the main window when the image
information window is displayed, the image information for that image
will be displayed.

Difference with the thumbnail with shooting information
Detailed shooting information for each image is displayed in the
image information window. However, if you want to only check the
main shooting information, you can check it for each image in
[Thumbnails] menu » [With shooting info] (p.13).

.
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Organizing Images
This section explains how to delete unwanted images, move or copy
images, etc., to organize your images.

Deleting an Unwanted Image

Be aware that you cannot recover deleted images.

Select an unwanted image in the main window.

Select the [File] menu » [Move to Recycle Bin].

Close window Ctrl+W
Save Ctrl+5
Save As.. Ctrl+5hift+5
Convert and save... Ctrl+D
Batch process.. Ctrl+B
Save still image from movie...  Ctrl+5Shift+D
Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Print contact sheets Alt+5hift+P
Plug-in printing 4
Add to collection Ctrl+G
Remowve from collection Ctrl+Shift+G
Clear collection
Select collection »
Delete collection 3
Bookmark
Remove bookmark

[ Move to Recycle Bin Del
Exit Alt+F4

The image is moved to the [Recycle Bin] and is deleted from DPP.
The images are deleted completely from your computer when the
[Empty Recycle Bin] operation is performed on the [Recycle Bin]
on the desktop.

Moving Images

You can move or copy images to a separate folder and sort by shooting
date or themes.

Drag the image to be moved or copied.
To move: Drag the image and release when the image is in the
destination folder.
To copy: Drag the image while holding down the <Ctrl> key and
release when the image is in the destination folder.
Eile Edit View Thumbnpails Preview Label Adjustment Tools Window Help

Edit Image Cluic ke Rer

Folder Anok mar ON

=[] Desktop

£ . Documents
| u Downloads

E Pictures

£ r' Videos
0S (C)

DATA2 (D)

- DATA (E)
REMOVABLE DISK (&)
BD-RE DRIVE ()
REMOVABLE DISK (K)
REMOVABLE DISK (L)

--= REMOVABLE DISK (M)

Libraries

Ji
“Hin
l! \
'
F4.0 } i F5.6

The images are moved or copied to the destination folder.

) . Travel
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Moving Images in Folders

You can move or copy folders that contain images, and sort the images
by folders.

Drag the folder to be moved or copied.
To move: Drag the folder and release when the folder is in the
destination folder.
To copy: Drag the folder while holding down the <Ctrl> key and
release when the folder is in the destination folder.
File Edit View Thumbpails Preview Label Adjustment Tools Window Help
Edlit Irrmge

Folder Bookmark Filter

=1l Desktop
B-L3 This PC

L ‘l"i_ [

B DATA2 (D)
= DATA (E)
B REMOVABLE [ ISK (1)
¢ BD-RE DRIVE (1)
© = REMOVABLE L ISK (K)
- REMOVABLE [ ISK (L)
‘... REMOVABLE [ ISK (M)
i Libraries
}::t‘_'l Network
--W |Holiday

F5 6

The folders are moved or copied to the destination folder.

Registering Frequent-Use Folders (Bookmark Registration)

You can register frequently used folders in bookmarks.
Registered folders are displayed in the [Bookmark] tab sheet in the main
window.

Select the folder for which a bookmark is to be
registered.

File Edit View Thumbnails Preview La Adjustme Tools Window Help

. Documents
Downloads

E Pictures
L) ' Travel e
N " i

L

- REMOVABLE DISK (1)
= BD-RE DRIVE (1)
~ REMOVABLE DISK (K
= REMOVABLE DISK (L)
= REMOVABLE DISK (M)
8 Libraries

IMG_0001.CR2 =

Select

i I [Fioliday
F4.0

Select the [File] menu » [Bookmark].

The folder selected in step 1 is registered in the [Bookmark] tab
sheet in the main window.

Deleting Bookmarks
You can delete a folder registered in [Bookmark].

Select the [File] menu » [Remove bookmark].
The selected folder is deleted from bookmarks.
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4 Editing Images

RAW IMages .....ccuiiiiiiiiieece e 42
RAW IMages. ....cceeeiiiiieeeeee e 42
RAW Development ..........eeeeeiiiiiiiieicicceeeeeee e 42
When RAW Development is to be Done.................... 42
Advantages of a RAW Image ..........cccccvvveeeeeeeeeeeeenn, 42

Editing JPEG and TIFF Images ............ccceevveiiinnnnn. 43

Tool Palettes .........coovviviiiii e 44

Editing with the Basic Adjustment Tool

Palette ... 46
Adjusting Brightness .........ccocoooiiiiiiiiiiiiiiiieeeeeeeeeeees 46
Changing the Picture Style ..............cccoeeeiiiiviennnen... 47
Using a Picture Style File ..........cc.cccccveee.n.e. 49
Adjusting Color Tone by Changing White Balance.... 49
Adjusting Color Tone Using Click White Balance...... 50
Adjusting White Balance with Color
Temperature .........ceeeeeeeieieeeeeeccccceee e, 51
Tuning White Balance...........ccccccccoeveeeennen. 51
Adjusting Contrast ..........cceeeveieeiiiiiiiiiee e 52
Adjusting Brightness of Shadows/

HighlightS .....eeeeeieeee e 52
Changing Color Tone and Color Saturation............... 53
Adjusting Monochrome .........cccccccoeiiiiiiiiiiieee. 53
Adjusting Dynamic Range..........ccc..ccco........ 54
Adjusting Gradation and Luminance Automatically ... 55
Using the Auto Lighting Optimizer............cccceeeeeee.... 56
Adjusting Image Sharpness.........ccccceeeeeeiveieeiieieeeeeenn. 57
Detailed Setting of Image Sharpness .................... 58

Editing with the Tone Adjustment Tool

Palette .......oooeeee 59

Adjusting Brightness and Contrast..............ccccoeeeee. 59
Adjusting Color Tone Using Click White Balance........ 60
T Adjusting Tone CUrVe ........cceveeveeveeeeeeene. 61
Example of a Tone Curve Operation...................... 62
D Adjusting Dynamic Range...........ccccccvveveee.. 63
Using the Auto Lighting Optimizer..............cccccccceee. 63
Editing with the Color Adjustment Tool
Palette .....ooveeie e 64
Editing with the Color Adjustment Tool
Palette ..o 64
Adjusting a Specific Color Gamut........................... 64
Adjusting Hue and Saturation for an Entire
IMAGE.. ..o 65
Adjusting in Monochrome..........ccccceeveveeeeeiiieccnnnee, 65
Editing with the Detailed Adjustment Tool
Palette ..o 66
Reducing NOISE .........coooiiiiiieeeeeeeeeeeeeeeeee e 66
Adjusting Image Sharpness..........cccceeeeeevviieiiicenneeennn. 67
Reducing Color Moiré in an Image..........ccccceeeeeeeeeenes 67
Editing with the Trimming/Angle Adjustment
Tool Palette ... 68
Editing with the Lens Correction Tool Palette.......... 71
Correcting Lens Aberration............cccccvvieiiiiiiiiiinnee. 71
Making Corrections...........ccccueeiieiiieeeeeieceeeeeeenn 72
Effects of Distortion Correction for Fisheye
LENSES ..t 73
Shooting Distance Information Slider ......................... 74
Correcting Multiple Images ata Time............cc........... 75
Digital Lens Optimizer ...............cccce 75
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Using the Digital Lens Optimizer ...........cccccccceeeeeen. 76
Adjusting Image Sharpness............cccoccviiiniieennn, 78
Editing with the Partial Adjustment
Tool Palette .........coeiviiiiii 79
Making Partial Adjustments to Images ([Brightness],
[Contrast], [Hue], [Saturation])..........cccccuvmrveeneeeeennin. 79
Making Partial Adjustments to Images ([Reduce color
MOITE] ).t e e e e 81
Adjustment GroupS .........eeeeeeeiieeeeiiieiiieeeeeee e 82
Editing with the Dust Delete/Copy Stamp
Tool Palette ..o 83
Performing Automatic Dust Erasure Processing ....... 83
Automatic Dust Erasure Processing in the Main
WINAOW ... 84
Manually Erasing Dust (Repair Function).................. 85
Erasing Unwanted Parts of an Image (Copy Stamp
FUNCLION) ..o 87
Setting Work Color Space........cccccoeeeevviviiciiieeeeennnnn. 88
Using the Soft-Proof Colors Function....................... 89
Specifying the Size when Opening RAW Images .... 90
Saving Editing Results................cccccce. 91
Saving Editing Contents to an Image ........................ 91
Saving as a separate image ..............cccoeeeeenrrvrnennn.. 91
Re-Editingan Image........c....cccoeiiiinns 93

Utilizing Adjustment Contents (Recipe).... 94
Copying a Recipe and Applying to Another Image.... 95
Savinga Recipeas aFile.....cccccooiiiiiiiiiiiii 95
Loading and Applying Recipes ..........cccoooieeeeeneeeennn. 96

(Geeemer ) Adjusting by Comparing Multiple

IMAGES ... 97
Editing Efficiently .............ccooooii 98

Editing in the Edit Image Window..............ccuvvvveeee.... 98

Changing the Thumbnail Display Position to

Horizontal ..........coooiiiiiiiiicee e 99

Gathering and Editing Images in the Collection

WINAOW...ceiiiiiiecccc e 100
Compositing Images .......cccceeveevvevnnnnn. 102

Compositing Methods............cccociiiiiiiiii, 105
Creating HDR (High Dynamic Range)
IMAgES....cooiiie s 106
Using the Dual Pixel RAW Optimizer........ 109

Microadjustment of the Position of Maximum Sharpness
and Resolution Using the Depth Information Contained

within the Dual Pixel RAW File..........cccovvvveeiiinnenen. 109
Reposition the Viewpoint or Foreground Bokeh
for a More Pleasing Result ..., 110
Reduces the Appearance of Ghosting in
[ F=To L= TS 111
T Transferring a RAW Image to
PhotOSNOP ..eeieiii e 113

Customizing the Main Window Toolbar .... 114

* Sections with and in “4 Editing Images”
support not only RAW image editing but also JPEG/TIFF image

editing.

: All the functions explained in the section support
JPEG/TIFF image editing.

: Certain functions explained in the section support
JPEG/TIFF image editing.

——
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RAW Images
RAW Images

A RAW image is image data that has recorded output data of imaging
sensor. As image processing is not performed inside the camera when a
photo is taken and the photo has been recorded in the special form of
“‘RAW image data + Image processing conditions information at the time
of shooting”, special software is needed to view or edit the image.

* “RAW” means “in a natural condition” or “not processed or refined”.

RAW Development

If described in terms of film, the concept of a RAW image is a shot
image not yet developed (latent image).

With film, the image appears for the first time when it is developed. In
the same way, for RAW images too, you cannot view them as images on

your computer unless you perform subsequent image signal processing.

Therefore, even though it is digital, this processing is called
“‘development”.

When RAW Development is to be Done

DPP automatically carries out this “development” processing when
RAW images are displayed in DPP. As a result, RAW images displayed
in DPP are images whose development processing has been
completed.

With DPP, you can view, edit and print RAW images without being
particularly conscious of the development processing.

Advantages of a RAW Image

RAW images are recorded in the format “RAW image data + Image
processing conditions information at the time of shooting”. When you
open a RAW image in DPP, the image is automatically developed and
you can view the image as an image to which image processing
conditions at the time of shooting have been applied.

Even if you perform various adjustments to the image you have opened
(it undergoes automatic development processing each time), only the
image processing conditions (development conditions) change and the
“original image data itself” remains unaffected. Therefore, it is the
perfect data for users who want to get creative with the images after
shooting, as you do not have to worry about image deterioration.

In DPP, the “Image processing conditions information” that can be
adjusted is called a “Recipe” (p.94).

e

&H RAW image

Rm— Contents adjusted using the tool
palettes can be handled
—I individually as a recipe file
(extension “.dr4”) (p.94, p.95).

In DPP, all the adjustments (image processing conditions information)
made with the tool palettes can be saved in the image as data called a
“recipe” (p.95), or can be saved, downloaded and applied to other
images as a separate recipe file (extension “.dr4”, p.96). However, a
recipe file with saved RAW image adjustments cannot be applied to
JPEG or TIFF images.
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Editing JPEG and TIFF Images

With DPP, you can adjust JPEG and TIFF images in the same way as
RAW images using the tool palettes below.

» Tone Adjustment tool palette

* Color Adjustment tool palette

* Detailed Adjustment tool palette

 Trimming/Angle Adjustment tool palette

* Partial Adjustment tool palette

* Dust Delete/Copy Stamp tool palette

* Settings tool palette
Because adjustments made with these tool palettes (the recipe) only
change the image processing conditions, the “original image data itself”
remains unaffected. Consequently, there is none of the image
deterioration that normally accompanies editing and you can readjust
your image any number of times.

*mg‘

JPEG, TIFF image data

L
.i

Image processing conditions information

B Contents adjusted using the tool
palettes can be handled
—I individually as a recipe file
(extension “.dr4”) (p.94, p.95).

In DPP, all the adjustments (image processing conditions information)
made with the tool palettes can be saved in the image as data called a
“recipe” (p.95), or can be saved, downloaded and applied to other
images as a separate recipe file (extension “.dr4”, p.96). However,
recipe data with saved JPEG or TIFF image adjustments cannot be
applied to RAW images.
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Tool Palettes

With DPP, you can adjust images with the tool palettes by switching
between various tool palette windows according to your editing
requirements. Since adjustments made with the tool palettes only
change the image processing conditions, the “original image data itself”
remains unaffected. As there is no image deterioration that normally
accompanies editing, you can readjust your image any number of times.
The various functions of the tool palettes are explained in more detail
under the respective topics.

Trimming/Angle Partial
Adjustment tool Adjustment tool
palette palette

Lens Tool palette

Correctiontool

palette

Basic 4| = Dust Delete/
Adjustment Copy Stamp

tool palette tool palette

Detailed Settings tool
Adjustment palette

tool palette

Tone Co_Ior
Adjustment Q?;JS;T:{:
tool palette p

hove midpaint to

Basic Adjustment tool palette
Makes basic adjustments to a RAW image (p.46).

Tone Adjustment tool palette

Adjusts the tone curve and applies the Auto Lighting Optimizer (p.59).

Color Adjustment tool palette

Adjusts the hue, saturation and luminance of a specific color space. The
hue and saturation for an entire image can also be adjusted (p.64).

Detailed Adjustment tool palette

Reduces noise and adjusts the image sharpness (p.66).

Trimming/Angle Adjustment tool palette
Crops an image and adjusts the image angle (p.68).

Lens Correction tool palette

Corrects lens aberration in the image (p.71) and applies the Digital
Lens Optimizer (p.76).

Partial Adjustment tool palette

Adjusts the selected area of an image (p.79).

Dust Delete/Copy Stamp tool palette
Erases dust from an image and corrects image by copying sections
of the image (p.83).

Settings tool palette

Configures the work color space (p.88).

Introduction/
Contents

T

Downloading
Images

Viewing
Images

Sorting
Images

il

Printing
Images

Processing
Large Numbers
of RAW Images

Remote
Shooting

|

Playing Back

ovies and Saving
Still Photos

Specifying
Preferences

Reference/
Index

S —

00




g% Using the different tool palettes

We recommend that you use the Basic Adjustment tool palette to make
adjustments to RAW images. However, if you find that the Basic
Adjustment tool palette does not offer a sufficient range of adjustments,
or if you want to use specific functions that are only available in the Tone
Adjustment tool palette (p.59), completing initial adjustments with the
Basic Adjustment tool palette and then using the Tone Adjustment tool
palette to make just the minimum of adjustments needed is
recommended.
For noise reduction (p.66) and lens aberration correction (p.72), you
should first complete necessary adjustments in the Basic Adjustment
and Tone Adjustment tool palettes, and then adjust with the Detailed
Adjustment tool palette (p.66) and Lens Correction tool palette (p.71).
You can click the [] button at the bottom right of the main window
to show/hide [Tool palette].
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JPEG/TIFF

Editing with the Basic Adjustment Tool Palette

The Basic Adjustment tool palette makes basic adjustments to RAW
images. With this tool palette, you can adjust the image brightness, set
Picture Style, adjust the white balance, adjust the contrast, adjust the
color tone and saturation, adjust the dynamic range, apply the Auto
Lighting Optimizer and adjust the image sharpness.

Note that the only adjustments you can make to JPEG/TIFF images are
applying the Auto Lighting Optimizer and adjusting the image
sharpness.

Select an image in the main window, etc.

Display the Basic Adjustment tool palette.

0 (Auto)

Fine-tune

Picty 3 |,

(Standard} - Browss
G tment

Move midpoint to match

Adjusting Brightness

The brightness of an image can be adjusted. Move the slider to the right
to make the image brighter and to the left to make the image darker.

Tool palette

Reverts the image to
the original settings

Enter a numerical
value

Drag the slider left or right

@ The adjustment range is —3.0 to +3.0 (in 0.01-stop increments when
entering a value).
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Changing the Picture Style

If the image looks different from what you visualized at the time of
shooting, you can get it closer to what you expected by changing the
Picture Style. Even if you have saved the image (p.91) with
[Monochrome] (p.53) selected, you can still change to another Picture
Style at any point by simply selecting a Picture Style other than
[Monochrome].

Ficture Style
Ky (Standard) o
Gamma adjustment A

B Lincar

0 50 40 20 00 20 40

Reverts the image to
the original settings

Select

Move midpoint to match

Picture Style

L+ [@

Description

The Picture Style set with the camera when the
image was shot.

When a mode in the Creative Zone is selected on the
camera, the Picture Style set is displayed in ().

When a mode in the Basic Zone is selected on the
camera, [Shot settings] is displayed in ( ), and image
characteristics that are according to the selected
shooting mode are applied.

The image looks vivid.
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Picture Style

(Picture Style file
registered in the

camera)

[Picture Style file
applied in DPP]

Description

Displayed when selecting an image shot with the
Picture Style file registered in the camera.

In the list, the name of the Picture Style file is
displayed in ().

The name of the Picture Style file applied in DPP is
displayed in[].

5

You can retain the [Color tone], [Color saturation], [Contrast],
[Unsharp mask] and [Sharpness] settings, even if you change the
Picture Style.

[Auto] is not applied to images shot with the EOS-1D Mark 1V,
EOS-1Ds Mark Ill, EOS-1D Mark lll, EOS-1D Mark II N, EOS-1Ds
Mark Il, EOS-1D Mark Il, EOS-1D, EOS-1Ds, EOS 5D Mark II,
EOS 5D, EOS 7D, EOS 60D/EOS 60Da, EOS 50D, EOS 40D,
EOS 30D, EOS 20D/EQOS 20Da, EOS 10D, EOS D2000, EOS
D6000, EOS D30, EOS D60, EOS REBEL T2i/550D, EOS
REBEL T1i/500D, EOS DIGITAL REBEL XSi/450D, EOS
DIGITAL REBEL XS/1000D, EOS REBEL T3/1100D, EOS
DIGITAL REBEL XTi/400D DIGITAL, EOS DIGITAL REBEL XT/
350D DIGITAL, EOS DIGITAL REBEL/300D, PowerShot G3 X,
PowerShot G1 X Mark Il, PowerShot G7 X, PowerShot G9 X,
PowerShot SX60 HS, PowerShot G5 X, PowerShot G16,
PowerShot S120, PowerShot G1 X, PowerShot G15, PowerShot
S110, PowerShot S100, PowerShot G9, PowerShot G10,
PowerShot G11, PowerShot G12, PowerShot S90, PowerShot
S95, PowerShot SX1 IS, or PowerShot SX50 HS. When changing
the Picture Style with several images selected, although you can
select [Auto] if images shot with any supported camera other than
the above are included, [Auto] will not be applied to the images
shot with the above cameras.

You can apply [Fine Detail] to all images shot with supported
camera models except the PowerShot G3 X, PowerShot G1 X
Mark Il, PowerShot G7 X, PowerShot G9 X, PowerShot SX60
HS, PowerShot G5 X, PowerShot G16, PowerShot S120,
PowerShot G1 X, PowerShot G15, PowerShot S110, PowerShot
S100, PowerShot G9, PowerShot G10, PowerShot G11,
PowerShot G12, PowerShot S90, PowerShot S95, PowerShot
SX1 1S, and PowerShot SX50 HS.

You cannot select [Auto] with multiple-exposure RAW images
created with the camera.

.
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Using a Picture Style File

A Picture Style file is a Picture Style extension file.

With DPP, you can apply to RAW images Picture Style files that you
have downloaded from Canon Web site effective for various scenes or
Picture Style files created with “Picture Style Editor”. When using a
Picture Style file, save it to your computer beforehand.

Click the [Browse] button in the [Picture Style] panel.

¥

B Lin==r

60 =40 -20 00 20 40

The [Open] dialog box appears.

Select a Picture Style file saved on your computer,
and click the [Open] button.
The Picture Style file you selected is applied to an image.

To apply a different Picture Style file, follow the procedure from
step 2 again.

|§| The Picture Style files that you can apply to the camera are files with
the “.PF2” or “.PF3” extension only.

Adjusting Color Tone by Changing White Balance

If the color tone of the photographed image does not appear natural,
change the white balance to make it appear natural. You can make the
color tone natural by setting the light source to match the scene at the
time of shooting an image of, for example, pale-colored flowers.

Tool palette

White balance adjustment

Reverts the image to

* 1 the original settings

&

CICE—

Select

i3 () is the white balance set on the camera when the image was shot.

* When a mode in the Creative Zone is selected on the camera,
the white balance set is displayed in ().

« When a mode in the Basic Zone is selected on the camera,
[Shot settings] is displayed in (), and image characteristics that
are according to the selected shooting mode are applied.

? The color tone does not become more natural even when the
white balance is changed

If the color tone of the image does not appear natural after changing the
white balance, adjust the white balance using click white balance (p.50).

-I\@/E Tune with color tone
To make further fine adjustments to color tone after adjusting the white

balance, you can use [Color tone] (p.53) for tuning towards your expectations.

@ You cannot register the adjustment results as personal white
balance (p.121) when you have selected [jf%( )] from the list box.
You cannot change or adjust white balance with multiple-
exposure RAW images created on the camera.

ﬁl Refer to your camera’s Instruction Manual for details on each white
balance setting.

of RAW Images
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Adjusting Color Tone Using Click White Balance

You can adjust white balance using a selected part of an image as the
standard for white to make the image appear natural. Using click white
balance is effective when using it in parts of an image where white color
tone has changed under the influence of a light source.

Tool palette

I
]

Click

The coordinates of the cursor position and

the RGB values (8-bit conversion) Reverts the

image to the
original settings

The color of the image is adjusted with the point you selected as
the standard for white.

If you click on another point in the image, the white balance is
adjusted again.

To finish click white balance, right-click with the mouse or click
the [[El}] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white area.

ﬁl You cannot change or adjust white balance with multiple-exposure
RAW images created on the camera.
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Adjusting White Balance with Color Temperature
White balance can be adjusted by setting a numerical value for color
temperature.

Select [Color temperature] from the [White balance
adjustment] list box.

Set the color temperature.

Tool palette

hite balance adjustment

E 4
+

Color temperature -

s

Displays the value of
the setting

Drag the slider left or right

|§| The adjustment range is 2000 to 10000K (in 10K increments).

Tuning White Balance

This is a function that makes fine adjustments to the white balance.
Using this function, you can achieve the same effects as third-party
color temperature conversion filters and color correction filters. The
adjustable range is £10 steps. This function is aimed particularly at high-
end users who are familiar with the roles and effects of color
temperature conversion filters and color correction filters.

Tune the white balance by dragging the point in the
adjustment screen in the [Fine-tune] panel.

Fine=tune

Enter the values to set

Drag Drag the sliders left
or right
B stands for blue, A for amber, M for magenta and G for green.
The color is adjusted towards the color to which the point moves.
You can also fine-tune your adjustment by using the sliders or
entering the adjustment values.

© To register the adjustment outcomes as a personal white balance
(p.121), select a setting other than [ ( )] from the [White
balance adjustment] list box before tuning the white balance. If
you selected [f%( )] from the list box and tuned the white
balance, you cannot then register the outcomes as a personal
white balance.
You cannot change or adjust the white balance in multi-exposure
RAW images generated on the camera.

|§| The adjustable range is 0 to £10. (in 0.1-stop increments when
entering a value).
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Adjusting Contrast

Modulation and degree of contrast can be adjusted. Move the slider to
the right to make contrast stronger and to the left to make contrast
weaker.

Reverts the image to
the original settings

Picture Styvle

Yy (Standard) - Bire

Gamma adjustment ¥

hove midpoint to match

Drag the slider left or
right (9 steps)

Ldvanced

Enter a setting (in 0.1-
stop increments)

gl=]

zaturation

Adjusting Brightness of Shadows/Highlights
You can adjust the brightness of shadows and highlights in an image.

By adjusting only shadows or highlights in an image, you can reduce the
effects of clipping in shadows and highlights.
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Changing Color Tone and Color Saturation

Tone and overall color saturation can be adjusted.
If Picture Style (p.47) is set to [Monochrome], [Color tone] and [Color
saturation] switch to [Filter effect] and [Toning effect] (this page).

Picture Style

Yy (Standard) =

Gamma adjustment

tone

zaturation

Color tone:

Reverts the image to
the original settings

Drag the sliders left or
right

—+—
—+—

Enter a setting (in 0.1-
stop increments)

Move the slider to the right to make tones
more yellowish, and to the left to make tones
more reddish.

Color saturation: Adjusts the overall color intensity for the

image. Move the slider to the right for more
intense colors, and to the left for less intense
colors.

|§| The adjustment range is —4 to +4.

Adjusting Monochrome

When the Picture Style (p.47) is set to [Monochrome], you can create
monochrome photographs with effects similar to filtering, or with a look
of monotone color photograph.

Select [Monochrome] in the [Picture Style] list box.

[~ Reverts the image to

SE e orginal setiings

Gamma adjustment ¥

60 -40 -20 00

fidva

Contrast

Displays the values of
the settings
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Filter effect: Creates a monochrome photograph where the white of
clouds and the green of trees are emphasized.

Filter Example of effect
None General monochrome image without filter effect.
Blue sky is reproduced more naturally and white
Yellow
clouds emerge clearly.
Orange Blue sky becomes somewhat darker. The
9 brightness of the setting sun increases further.
Blue sky becomes quite dark. Autumn leaves
Red :
become clear and bright.
Human skin tones and lips become softer. The
Green

green leaves of trees become clear and bright.

Toning effect: Creates a monochrome photograph to which a single
color has been added.
You can choose from [None], [Sepia], [Blue], [Purple]
and [Green].

Y
~

=< Increase the [Contrast] to emphasize the filter effect

To emphasize the filter effect, set the [Contrast] slider to the right.

Adjusting Dynamic Range

Dynamic range (width of gradation expression) from dark points to bright
points in an image can be adjusted.

Fict

|4

Iy (Standard) - Browse.

Gamma adjustment

SO0 —En =AN =N iyl

¥

B Linear

A0

Move downwards
Output white points

=
=
=
Ak

0.00

Ak

Highl
Ciolor

Ciolor

Move to the left or right
Input black points

000

oo
oo
oo
0n
0n

Al

ArRArRAERAEE A

Move to the left or right
Input white points

Move to the left or right
Mid (medium tone) point

Move upwards
Output black points

You can also adjust
the dynamic range by
entering values

The horizontal axis shows the input level and the vertical axis

shows the output level.

Checkmark the [Move midpoint to match] checkbox to link the
mid-point to your adjustments to the input white points and input

black points.
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AL/

=< [Linear] - A function for advanced adjustment

Use [Linear] when you adjust images using image editing software that
has advanced editing functions. Note that when [Linear] is
checkmarked, the image becomes dim.

|§| [Contrast], [Highlight], [Shadow], and [Auto Lighting Optimizer]
(p.56) will not function when [Linear] is checkmarked.

Adjusting Gradation and Luminance Automatically

In order to give the image desirable gradations and luminance,
automatic adjustments are applied for an appropriate dynamic range.

Click the [Auto] button.

I~

n (Standard) - Browse. ..

Gamma adjustment ¥

In order to give the image desirable gradations and luminance,
the dynamic range is automatically adjusted.

White points, midpoint, and black points in the [Gamma
adjustment] panel as well as [Highlight] and [Shadow] in the
[Advanced] panel are adjusted automatically.
Settings that are reset and those that are not with this adjustment
are as follows.
Settings that are reset
- Auto Lighting Optimizer
- [Contrast] in the [Advanced] panel
Settings that are not reset
- Brightness adjustment
- White balance adjustment
- Linear*
* White points and black points are automatically adjusted.

|§| An image may look unnatural after automatic adjustment. In such a
case, reduce the degree of shadow and highlight adjustment.
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Using the Auto Lighting Optimizer

If the shooting result is dark or the contrast is low, you can use the Auto
Lighting Optimizer function to auto-correct the brightness and contrast,
and obtain a more favorable image.

You can also change the setting of the image shot with the camera’s
Auto Lighting Optimizer function.

This function also can be used for JPEG/TIFF images in addition to
RAW images.

* ALO stands for Auto Lighting Optimizer.

Checkmark the [Auto Lighting Optimizer] checkbox.

Auto Lighting Optimizer

Checkmark

Loy Standard Strong

For the image shot with the camera’s Auto Lighting Optimizer
function, the checkbox is already checked.

Change the setting according to your preferences.

Auto Lighting Optimizer

—

Loy Standard Strong

Select from three
levels: Low/Standard/
Strong

Auto correction is applied to the image to match the setting.
For the image shot with the camera’s Auto Lighting Optimizer
function, the setting at the time of shooting is applied as the
default value.

To cancel the Auto Lighting Optimizer, remove the check mark
from the checkbox.

When [Highlight tone priority] is set to [Enable] on any supported
EOS DIGITAL camera other than the EOS-1D Mark IV or EOS 5D
Mark Il, the Auto Lighting Optimizer cannot be used for RAW
images.

You cannot use the Auto Lighting Optimizer with multiple-
exposure RAW images created with the camera.

When you apply Auto Lighting Optimizer to the RAW and JPEG
images shot simultaneously, the correction results of the two
images may differ.
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Adjusting Image Sharpness

You can make the overall atmosphere of an image sharper or softer.
Adjustment can be made by selecting from two modes, [Sharpness] and
[Unsharp mask].

[Sharpness]: Controls the sharpness of an image by adjusting the
level of emphasis for the outline of the image. The
further to the right the [Sharpness] slider is moved (the
larger the setting value), the more the edges are
emphasized for a sharper image.

[Unsharp mask]: Adjusts the image’s sharpness more finely.

[Strength]: Shows the level of emphasis for the outline of the
image. The further to the right the slider is moved (the
larger the setting value), the more the image’s edges
are emphasized for a sharper image.

[Fineness]: Shows the fineness of the emphasized outline. The
further to the left the slider is moved (the smaller the
setting), the easier it becomes to emphasize fine
details.

[Threshold]:  Sets “how much contrast difference there should be
compared to surroundings before emphasizing
edges”.

|§| [Unsharp mask] cannot be used with images other than RAW
images.

Select [Sharpness] from the list box and adjust the
setting.

Picture Style Reverts the image to

Zll the original settings

Gamma adjustment

B Linear

80 -0 —-40 -20 0D 20 40

Select [Sharpness]

Enter a setting (in 0.1-
stop increments)

Drag the slider left or right

The adjustment range is 0 to 10.
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Detailed Setting of Image Sharpness

Select [Unsharp mask] from the list box and adjust
the setting.

Ficture Style |,

ﬂ [Standard) o Browse. .

Gamma adjustment L

B Line=r

20 40

Select [Unsharp mask]

Enter a setting (in
Threshold 0.1-stop increments)

Drag the slider left
or right

|§| Adjust image sharpness with the window view set to [400%], [200%]
or [100%]. If the view is set to [Fit to window] (full view), you may not
be able to correctly check the adjustment results.
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JPEG/TIFF

Editing with the Tone Adjustment Tool Palette

With the Tone Adjustment tool palette, you can adjust images with the
same functions as general image editing software.

Select an image in the main window, etc.

Display the Tone Adjustment tool palette.

Tool palette

Adjusting Brightness and Contrast

The brightness and contrast of an image can be adjusted. Since the
adjustment range is broader than the same functions in the Basic
Adjustment tool palette, the image color may be saturated, or the image
quality may deteriorate if you adjust too much. Be especially careful
when adjusting.

I~ Reverts the image to
the original settings

]

— Drag the sliders left or
right

—Enter a setting (in 0.1-
stop increments)
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Brightness: Move the slider to the right to make an image

brighter and to the left to make an image darker. Adjusting Color Tone Using Click White Balance

Downloading
Contrast: Used to adjust modulation and degree of contrast

You can adjust white balance using a selected part of an image as the Images
of color. Move the slider to the right to make standard for white to make the image appear natural. Using click white
contrast of an image stronger and to the left to balance is effective when using it in parts of an image where white color Viewing
make contrast weaker. tone has changed under the influence of a light source. Images

Click the [[EE] button.
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|§| The adjustment range is —100 to +100 (in 0.1-stop increments when

entering a value). @



Click on a point that is to be the standard for white.

Click
The coordinates of the cursor position and
the RGB values (8-bit conversion)

The color of the image is adjusted with the point you selected as
the standard for white.

If you click on another point in the image, the white balance is
adjusted again.

To finish click white balance, right-click with the mouse or click
the [[El] button again.

? When there are no white areas in your image

When there are no white areas in your image, you can adjust the white
balance by clicking on a grey point of the image in step 2. This has the
same adjustment result as selecting a white area.

@ The histogram display changes according to adjustment. You can
also display the histogram before making any adjustments.

Adjusting Tone Curve

You can adjust the brightness, contrast and color of a specific area by
changing the tone curve (p.148).

Select the tone curve mode and interpolation
method.
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Make adjustments.

. Luminance B G B
. Straight

RGB: Adjusts RGB
istogram in a batch
R, G, B: Adjusts
N each channel

You can display pre-
and post-adjustment
histograms

=

'—‘r—

Ak

Coordinates of [[1]
(when several
coordinates are set,
coordinates of last-
set[])

I

A

The horizontal axis shows the input level and the vertical axis
shows the output level.

The maximum number of [[J] is 8.

To delete a [[], either press the <Del> key or double-click on the [[].

Example of a Tone Curve Operation

Makes medium tones brighter

Makes medium tones darker

Makes tones sharper

Makes tones softer
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Adjusting Dynamic Range

Dynamic range (width of gradation expression) from dark points to bright
points in an image can be adjusted.

Move to the
right

Input black
points

Input black
point numerical
value

Output black
point numerical
value

Move downwards
Output white points

LA

Editeld image

Ak

255
255
0o
0.0

AR A

Move upwards
Output black points

Reverts the
image to the
original
settings

== Move to the

AbRArEARAERAY

left
Input white
points

Input white
pointnumerical
value

Output
white point
numerical
value

The horizontal axis shows the input level and the vertical axis shows

the output level.

@ The setting range of black points is 0 to 247 (in 1-stop increments

when entering a value).

The setting range of white points is 8 to 255 (in 1-stop increments
when entering a value).

You can display pre- and post-editing histograms (p.62).

Using the Auto Lighting Optimizer

For information on using the Auto Lighting Optimizer, see “Using the
Auto Lighting Optimizer” (p.56) in “Editing with the Basic Adjustment
Tool Palette”.
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H H H H Introduction/
Editing with the Color Adjustment Tool Palette "Contents
With the Color Adjustment tool palette, you can adjust the hue, —
saturation and luminance in a specific color gamut for 8 color gamuts . . Downloading
(red, orange, yellow, green, aqua, blue, purple and magenta). You can Edltlng with the Color Adjustment Tool Palette Images

also adjust the hue and saturation for the entire image and tune

h i . L] ] " gm — )
monochrome Images Adjusting a Specific Color Gamut Viewing
Select an image in the main window, etc. Use .the sliders t.o make adjgstments. You can also make adjustments Images
by directly entering a numeric value. —
H: Adjusts the hue.

Display the Color Adjustment tool palette. S: Adjusts the saturation.
L: Adjusts the luminosity.

Calor adjustment Revert a” adjustments to
Hue _ the original settings -
_ , Printing
Saturation : Images
Drag the sliders left -
iaht Processing
orrng Large Numbers
- Enter the values to set of RAW Images
ranas Revert color gamut Remote
i adjustments to the Shooting
original settings S ——
I~ Playing Back
v ovies and Saving
vellon Still Photos
Specifying
Preferences
Reference/
Index
N —
ﬁl The adjustment ranges are as follows: @ @

H: —20 to +20

S: 10 to +10 @
L: —10to +10



Adjusting Hue and Saturation for an Entire
Image
Use the sliders to make adjustments. You can also make adjustments
by directly entering a numeric value.

Hue: Move the slider to the right to make color tones more

yellowish, and to the left to make color tones more reddish.

Saturation: Adjusts the overall color intensity for the image. Move the
slider to the right for more intense colors, and to the left for
less intense colors.

Calor adjustment Revert all adjustments

e to the original settings

Saturation Enter the Va|ueS tO Set
Drag the sliders left or
right

I

Orange

|

Yellow

|

|§| The adjustment range for hue is —30 to +30; and for saturation is 0
to 200.

Adjusting in Monochrome

Press the [Monochrome] button to set the 8 color gamuts to their least

saturation (-10) and create a monochrome image. After creating it, you
can tune the monochrome image with the H and L sliders for each color
gamut, adjusting the hue and brightness.

Drag the sliders left or

right

Color adjustment Revert all adjustments
Hue to the original settings

Saturation . — M Enter the values to set

Monochrame

I~

Oranege

I~

*re o

I~
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JPEG/TIFF

Editing with the Detailed Adjustment Tool Palette

You can use the Detailed Adjustment tool palette to reduce the noise
that occurs in images shot at night or at high ISO settings. This tool
palette can also be used in conjunction with the sharpness adjustment
functions. Note that you can use the functions in this tool palette with
JPEG and TIFF images as well as RAW images.

Select an image in the main window, etc.

Display the Detailed Adjustment tool palette.

Tool palette

L ise
—

Reduce chrominance noise

————— s

Reducing Noise

You can reduce noise that arises in images shot at night or with a high
ISO speed.
* NR stands for Noise Reduction.

Adjust an image.

Enlargement
display
position

Check window

Drag the sliders

-
Reduce chroniirarce noise Enter a setting (In 0.1-
- - stop increments)

You can set a noise reduction level from within a range of 0 to 20.
The larger the setting, the larger the noise reduction effect.

The noise reduction effect can also be checked in the check
window.
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Vv
== Setting the same noise reduction level for several images

You can set the same noise reduction level for several images by first
selecting multiple images in the main window, and then adjusting the
noise reduction level using the [Reduce luminance noise] and [Reduce
chrominance noise] sliders.

|§| If [Reduce luminance noise] is set, resolution may be reduced
along with reduction of noise.
If [Reduce chrominance noise] is set, color bleeding may occur
along with reduction of noise.

Adjusting Image Sharpness

You can also use this palette to adjust the image sharpness. For
information on making adjustments, see “Adjusting Image Sharpness” in
“Editing with the Basic Adjustment Tool Palette” (p.57).

Reducing Color Moiré in an Image

You can reduce color moiré* occurring in an image.

*Color moiré: Occurrence of a color appearing that is not originally in an
image. In particular, tends to occur when taking photos of latticed or
similar patterns.

Checkmark the [Reduce color moiré] checkbox and
adjust using the slider.

Maize reduction

Reduce luminance noise

— =

Reduce chraminance noise

—— e

Reduce color mairé

s S—

® Depending on the subject, you may not be able to correct color

moiré completely.

Using this function may cause hue to change depending on the
subject. If there is a noticeable change in hue, lower the level of
adjustment.
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JPEG/TIFF

Editing with the Trimming/Angle Adjustment Tool Palette Introduction!

Contents
You can crop only the part of an image you need, or change the If you click [Center on Screen], you can display the trimming —
composition of an image where an image shot horizontally becomes range in the center of the window. Downloading
vertical. You can also adjust the angle of an image before cropping. When correcting lens aberrations, it is recommended to perform Images
lens aberration correction before adjusting the angle of the
Select the image to be cropped. image. .
If you have only adjusted the angle of the image, the image will er;’vs;gg
Display the Trimming/Angle Adjustment tool palette. be cropped at the largest possible trimming range.

You cannot make adjustments with the Trimming/Angle

) ) : _ Select a ratio and drag the trimming range.
Adjustment tool palette in a window that only shows thumbnails.

Sorting
Images

Editing
| 3

Select a trimming ratio

Adjust the angle of the image as needed. Cancel

Trimming/angle adjustment window

Largest possible
trimming range

————————

-\ — Printing
R Images

width [

Processing
Large Numbers
of RAW Images

Remote
Drag the trimming Shooting

N
range

Playing Back
ovies and Saving
Still Photos

The trimming range can be moved by dragging.
You can enlarge or reduce the size of the trimming range by

Drag (0.01-degree increments; adjustment range: —45 to +45 dragging the four corners of the trimming range.
degrees) Specifying
Preferences
Use the mouse (click A/V¥)to adjust the angle or directly enter
the adjustment angle (0.01-degree increments; adjustable
range: —45 to +45 degrees) Relfﬁai?(cel

|§| When aspect ratio information is attached to an image shot with any @ @

supported camera other than the EOS 5D Mark I, the displayed @
trimming range is based on the aspect ratio information.



List of aspect ratios (width : height)

b

T
= e
a1
i}

e =t R = R e s S e el (T

(1]

o

q
16
Custam

[Free]:

You can crop an image to any size, regardless of
the selectable ratio.
[Custom]: You can crop an image at the specified ratio.

Return to the main window.
The trimming range frame is displayed in the cropped image
(p.147).
When the cropped image is displayed in a preview window or the
edit image window, it is displayed in its cropped form.

? Cropped images

The trimmed range can be reverted to its original condition at
any time

A cropped image is displayed or printed as a cropped image.
However, since the image is not actually cropped, you can always
revert to the original image by clicking the [ [ lkalll] button in the
trimming/angle adjustment window or performing the “Re-Editing an
Image” procedure (p.93).

Display of the cropped image in each window

* Main window: The frame showing the trimming range is
displayed on the image (p.147).

* Preview window:  The image is displayed in its cropped condition.

+ Edit image window: The thumbnail image is the same as the main
window display, and the enlarged image is the
same as the preview window display.

Printing a cropped image
You can print as a cropped image by printing it in DPP.

The image becomes a cropped image when converted and saved
The cropped RAW image actually becomes a cropped image when
converted to a JPEG or TIFF image and saved (p.91).

Images that have aspect ratio set will be displayed as cropped
images

When aspect ratio or cropping information is attached to a RAW
image shot with any supported camera other than the EOS 5D Mark
I, the image will be displayed with the set trimming range based on
the information. Since the image is not actually cropped, you can
change the trimming range or revert to its condition before cropping.
However, when a JPEG image is shot either with an aspect ratio set
with a camera that supports aspect ratio information or with the EOS
5DS/EOS 5DS R set to crop shooting, its trimming range cannot be
changed or the image cannot be reverted to its condition before
cropping since the image is actually cropped and saved.*

When reverting to the trimming range that is based on the aspect ratio
information at the time of shooting, click the [ [ EaI] button. Also, if
you want to cancel all the trimming range, click the [Clear] button.
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* When shooting with EOS 5DS/EOS 5DS R, EOS 5D Mark IV, EOS
5D Mark I, or EOS 7D Mark Il and [Add cropping information] is set
in Custom Functions, aspect ratio information is only set and the
image is not actually cropped, even for JPEG images.

Operate using the menu
Each operation can also be performed with the menu which appears
when you right-click with the mouse on the image.

Apply the trimmed range to another image

You can apply the trimmed range to another image by clicking the
[Copy] button to copy the trimmed range, displaying another image
and then clicking the [Paste] button.

To batch apply a copied trimming range to multiple images, select the
cropped image in the main window together with the images to which
you want to apply the trimming range and then display the Trimming/
Angle Adjustment tool palette. With the cropped image displayed,
click the [Copy] button and then click the [Paste] button. This will
apply the trimming range to all the images selected when the
trimming/angle adjustment window is displayed.

To select multiple images in the main window, click the images while
holding down the <Ctrl> key. To select multiple consecutive images,
click on the first image, and then click on the last image while holding
down the <Shift> key.

@ For images shot with ISO speed range expansion set, noticeable
noise may make it difficult to view the image in detail in the
trimming/angle adjustment window.
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Editing with the Lens Correction Tool Palette

With the Lens Correction tool palette, you can use the lens aberration
correction functions and the Digital Lens Optimizer to correct lens
aberration in your images and to improve their resolution. This tool
palette can also be used in conjunction with the sharpness adjustment
functions. Note that the lens aberration correction functions and the
Digital Lens Optimizer can only be used with RAW images.

Select an image in the main window, etc.

Display the Lens Correction tool palette.

Correcting Lens Aberration

You can easily make corrections to drops in peripheral illumination,
distortions in the subject, and color blur which occur by the physical
characteristics of the lens or slightly remaining aberration.

You can only correct aberration in RAW images which have been shot
with compatible lenses. JPEG or TIFF images cannot be corrected.
Note that even though the EOS 20D/EOS 20Da, EOS 10D, EOS D2000,
EOS D6000, EOS D30, EOS D60, EOS DIGITAL REBEL XT/350D
DIGITAL, and EOS DIGITAL REBEL/300D are EOS DIGITAL cameras
supporting the Digital Photo Professional, they are not compatible with
the lens aberration correction function. Also, note that the lens
aberration correction function is compatible with the EOS 5D with the
firmware version 1.1.1 and the EOS 30D with the firmware version
1.0.6.

® To use this function, the EOS Lens Registration Tool (version 1.4.20
or later) must be installed.

|§| Lenses compatible with this function are those displayed in the
[Add or Remove lens data] window (p.77).
You can also correct RAW images taken with the compatible lens
even when the extender is attached.
You can also correct RAW images shot with EF50mm /2.5
Compact Macro fitted with Life Size Converter EF.
The aberration correction function is not available for images shot
with a lens other than those given under “Compatible Lenses”.
They are therefore not displayed and cannot be used.
The lens aberration correction function is not available for
multiple-exposure RAW images created on the camera.
EF cinema lenses (CN-E lenses) are not compatible.
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Making Corrections

You can make corrections to any of the five aberrations as below, either
one at a time or simultaneously.
Peripheral illumination
Chromatic aberration (color fringing which occurs in the periphery of
an image)
Color blur (blue or red color blur which sometimes occurs at the edge
of the highlighted area of an image)
Distortions Diffraction

Select an image in the main window.

Display the Lens Correction tool palette and
checkmark the items to be corrected.

Enlargement display section

The image is corrected and redisplayed.
In the main window, the [ }] mark is displayed on the image to
indicate that the lens aberration correction is applied (p.147).

Check the results of corrections to peripheral illumination or
distortions in the full view.

Check the results of corrections to chromatic aberration and color
blur by clicking the area on the image you want to check and
then checking the enlargement display section in the top of the
window. You can choose from 4 display scales between 1:1 and
1:4 for the enlargement display.

You can lessen the degree of correction by moving the slider to
the left.

You can respectively correct red chromatic aberration with the [R]
slider of the [Chromatic aberration] or blue chromatic aberration
with the [B] slider.

To correct distortion aberration of images shot with a fisheye lens
(EF8-15mm f/4L USM Fisheye or EF15mm /2.8 Fisheye), four
effects can be selected from the [Effect] list box in addition to
[Shot settings] normally used for distortion correction.

The level of an effect can be adjusted with the adjustment slider
located below [Distortion].

For detailed information on each effect, see “Effects of Distortion
Correction for Fisheye Lenses” (p.73).

For images shot with EF8-15mm f/4L USM Fisheye, a fine-tune
slider is also displayed when you select [Emphasize Linearity]
from the [Effect] list box.

Adjust the amount of correction for distortion aberration with the
adjustment slider, and then adjust with the fine-tune slider if more
adjustment is required.

When the list box for selecting an extender is displayed, select
the extender attached at the time of shooting from the list box.
[Diffraction correction] corrects only those images shot with a
camera with a diffraction correction function. By checkmarking
this option, images are corrected according to the camera’s
diffraction correction function. Note that this function cannot be
used at the same time as the Digital Lens Optimizer.
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Effects of Distortion Correction for Fisheye Emphasize Distance N o |
Lenses Th!s con_verfts the image to an “equﬂstant pro;e_ctlon”_ style image.
This projection method preserves distance relationships.
Shot settings Equidistant projection displays a distance in the same distance
By selecting this option, only the aberration corrections will be anywhere from the center to the periphery. In particular, when
performed to correct the optical distortions. shooting a celestial body such as the celestial sphere, same heights

above the horizon(declination) are captured at the same heights. This
method is therefore used in such photography as celestial
photography (star maps, solar path diagrams, etc.).

Emphasize Linearity

This converts the image to a “central projection” style image. This
projection method is employed for general lenses. . .
Since central projection displays straight lines as straight lines, a Emphasize Periphery

wide-view panoramic image can be obtained by selecting this option. This converts the image to a “stereographic projection” style image.

However, the periphery is stretched, resulting in decreased resolution. This projection method emphasizes the periphery.
Stereographic projection allows position relationships on a spherical

' surface, such as N, S, E, W on a map, to be displayed correctly. It is
/ therefore used for world maps and monitoring cameras.
By selecting this option, the periphery is stretched and may result in
decreased resolution.

Y
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Emphasize Center

This converts the image to an “orthographic projection” style image.
With this projection method, the center is more emphasized.

Since an orthogonal projection allows a subject of the same
brightness to be displayed as occupying the same area in the image,
this method has typical uses in photography for celestial luminance
distributions and center-emphasized animal photography. By
selecting this option, the center is stretched and may result in
decreased resolution.

® When selecting any of the options, [Emphasize Linearity],
[Emphasize Distance], [Emphasize Periphery], or [Emphasize
Center], it will yield results similar to that of the selected projection
method. However, the conversion does not really apply a change of
projection method in a strict sense.

Accordingly, be aware that they are not suited for scientific or other
such purposes.

Shooting Distance Information Slider

When correcting RAW images and if shooting distance information has
been saved to the image, the slider is set automatically according to
this shooting distance information. However, if no shooting distance
information is saved to the image, the slider is set automatically to the
right end at infinity position and a [<!>] appears above the slider.

If the image’s shooting distance is not infinite, you can minutely adjust
the distance by operating the slider while looking at the screen.

When correcting RAW images shot with the cameras in the table
below, it is set automatically to the right end at infinity position. You
can then minutely adjust the distance by operating the slider while
looking at the screen if the shooting distance is not infinite.

EOS-1D Mark II N EOS-1Ds Mark Il EOS-1D Mark Il
EOS-1D EOS-1Ds EOS 5D
EOS 30D EOS DIGITAL REBEL

XTi/400D DIGITAL

For RAW images shot with MP-E65mm /2.8 1-5x Macro Photo or
EF50mm /2.5 Compact Macro with Life Size Converter EF, the slider
indicator changes to [Magnification factor].

The [Shooting distance information] slider is applied to all the
correction items with check marks.

If the lens requires no adjustment with the [Shooting distance
information] slider, the slider cannot be used.

.
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Correcting Multiple Images at a Time

You can apply the same corrections to several images by first selecting
multiple images in the main window, and then performing correction
procedures (p.72).

Also, you can apply same corrections by copying the recipe of the
corrected image and pasting it onto the multiple images (p.95).

? Additional information

Some noise appeared in the periphery of an image after
correcting [Peripheral illumination]

You can reduce the noise by using luminance and/or chromatic noise
reduction of the noise reduction function (p.66). However, if you had
applied high amount of [Peripheral illumination] correction to the
images that have been shot at night or with a high 1ISO speed, the
noise might not be reduced.

The image appears with less resolution after correcting
[Distortion]

You can make the image similar to the one before correction by
applying more sharpness with the sharpness adjusting function
(p.67).

The colors of the image became weaker after correcting [Color
blur]

You can make the image similar to the one before correction by
adjusting the color tone (p.53) and/or the color saturation (p.65) to
make the color deeper.

The result of [Color blur] correction cannot be detected

[Color blur] correction is effective for correcting blue or red color blur
which occurs at the edge of the highlighted area of an image. If
conditions do not match, correction cannot be made.

@ The periphery of the image may be truncated when [Distortion]
correction is made.

Digital Lens Optimizer

This function enables the resolution of images to be increased by
removing any remaining aberration related to image-forming capability
or any deterioration of resolution resulting from diffraction phenomena.
These optical phenomena cannot be corrected under Lens aberration
correction (p.71). Correction is achieved using the designed value of
each lens. You can correct these optical phenomena in RAW images
which have been shot with compatible lenses. JPEG, TIFF, S-RAW, and
M-RAW images cannot be corrected. To use this function, [Lens data]
for the lens used to shoot images first needs to be downloaded to your
computer. Before using the Digital Lens Optimizer, it is recommended
that you set [Sharpness] or [Strength] for [Unsharp mask] for images to

Note that even though the EOS 20D/EOS 20Da, EOS 10D, EOS D2000,
EOS D6000, EOS D30, EOS D60, EOS DIGITAL REBEL XT/350D
DIGITAL, and EOS DIGITAL REBEL/300D are EOS DIGITAL cameras
supporting the Digital Photo Professional, they are not compatible with
the lens aberration correction function. Also, note that the lens
aberration correction function is compatible with the EOS 5D with the
firmware version 1.1.1 and the EOS 30D with the firmware version
1.0.6.

@ To use this function, the EOS Lens Registration Tool (version
1.4.20 or later) must be installed.
The Digital Lens Optimizer is also available for images shot with
an extender attached to a compatible lens.
You cannot use the Digital Lens Optimizer with multiple-exposure
RAW images created on the camera.
EF cinema lenses (CN-E lenses) are not compatible.
[Diffraction correction] cannot be used at the same time as the
Digital Lens Optimizer.

.
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Using the Digital Lens Optimizer

Check the status of [Lens data] for [Digital Lens
Optimizer].

Shooting distance information

[Not Available] is displayed for an image shot with a non-
compatible camera or lens, or for a non-compatible image such
as a JPEG, TIFF, S-RAW, or M-RAW image. The function cannot
be used for these images.

If [No] is displayed, proceed to step 2. To use the function, you
need to download the lens data for the lens used when shooting
the image. It is recommended that you check the lens used when
shooting the image beforehand. The lens used can be checked
using the image information and shooting information displays.
You can also check it with the menu that appears when you right-
click with the mouse on an image.

If [Yes] is displayed, proceed to step 4.

Click the [[lFZE] button.

Shoeting distance information

The [Add or Remove lens data] window appears.

® To use this function, an environment with Internet access
(subscription to a provider and an in-place line connection) is
required. Internet Service Provider (ISP) connection fees or access
point connection fees may apply.

ﬁl Before you click the [|jjif2l}] button in step 2, Lens data [No] may
be displayed instead of [Not Available] for non-compatible images.

Introduction/
Contents

N —

Downloading
Images

Viewing
Images

T

Printing
Images

Processing
Large Numbers
of RAW Images

Remote
Shooting

N —

Playing Back
ovies and Saving

Still Photos

Specifying
Preferences

Reference/
Index

S —

00




Checkmark the checkbox for the lens used to shoot
the image, and click the [Start] button.

L2 Add or Remove lens data (Version 1.8.20) H
Select a lens category
Ultra wide and wide Macro EF-M
Standard and medium telephota Zoom T3-E
Telephota EF-5 Select all Clear all
Extender EF1.43 EF2X [ L lenses only
[] EF20-35mm £/35-45 USM ~

[ EF24-70mm £/26L T USM
[] EF24-70mm £/2.8L LM
[ EF24-70mm £/4L IS USM

| EF24-108mm {/35-5f I3 5TM

11131 ]

[[] EF24-105mm t/4L IS USM

[] EF28-70mm f/28L USM

[] EF28-90mm f/4-65 11

[ ] EF28-30mm f/4-56 I

[] EF28-80mm £/4-5.6 LT USM
[[] EF28-105mm 173 5-45 LISM
[] EF28-105mm £/3.5-45 I USM
[[] EF28-105mm {/4-56

[ ] EF28-105mm 1/4-56 USM

[[] EF28-135mm 1/3 5-55 IS USM
[] EF28-200mm 1/35-55

[[] EF28-200mm 1/3.5-56 USM
[[] EF28-300mm £/3 5-5.6L 15 USM
[] EF55-200mm £/4 5-56 T USM
[C] EF55-200mm 174 5-5.5 LUSM
1 FFEIN-20Mmm §/3 81 15 T 1ISH

Destination Folder Add:1 7 Delete:0 ' Start ' Cancel

Mote

v

The lens data is downloaded to your computer.

When the downloading of the lens data ends, the indication for
the lens data changes to [Yes].

Lenses compatible with this function are those displayed in the
[Add or Remove lens data] window.

If you remove the check mark from the checkbox for already-
downloaded lens names and click the [Start] button, the lens data
will be deleted from your computer.

Depending on the type, current state, etc. of software running on
your computer, the download of the lens data may fail. If it occurs,
wait for a while then try downloading the data again.

If you want to change the destination where lens data is saved
when there is already downloaded lens data, move the previously
downloaded lens data from the old folder to the new destination
folder manually.

Checkmark the [Digital Lens Optimizer] checkbox
and adjust the image.

Shooting distance information

& Lens data : Yes
Digital Lens Optimizer Reverts to its condition
before adjustment

® Since the lens data downloaded with DPP version 3.x is not
compatible with DPP version 4.x, the lens data must be downloaded
again.

|§| When applying the Digital Lens Optimizer, the effect of [Sharpness]
or [Unsharp mask] may become excessive. It is recommended that
you set [Sharpness] or [Strength] for [Unsharp mask] for images to 0
before using the Digital Lens Optimizer. Adjust [Sharpness] or
[Unsharp mask] again after applying the Digital Lens Optimizer to
images.
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Use the slider to adjust the Digital Lens Optimizer effect. ~—
If no shooting distance information is saved to the image, the Downloading
shooting distance slider is set automatically to the right end at Images
infinity position and a [<!>] appears above the shooting distance
slider. _ . . . . Viewing
If the lens requires no adjustment with the [Shooting distance Images
information] slider, the slider cannot be used.
Images cannot be corrected for [Chromatic aberration] in the lens Sorting
aberration correction tool pallet if the Digital Lens Optimizer has Images
been applied.
In the main window, the [ﬁ] mark is displayed on the image to Edi
indicate that the Digital Lens Optimizer is applied (p.147). I
. . Printing
Adjusting Image Sharpness Images
You can also use this palette to adjust the image sharpness. For Processing
information on making adjustments, see “Adjusting Image Sharpness” in Large Numbers
“Editing with the Basic Adjustment Tool Palette” (p.57). of RAW Images
Remote
Shooting
T
Playing Back
ovies and Saving
Still Photos
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JPEGITIFF

Editing with the Partial Adjustment Tool Palette

The Partial Adjustment tool palette adjusts the selected area of an
image.

With this tool palette, you can adjust brightness, contrast, hue, and
saturation, and reduce color moiré.

Supported image formats are CR2, CR3, TIFF, and JPG.

® On 32-bit OSs, this function is not available.

Making Partial Adjustments to Images
([Brightness], [Contrast], [Hue], [Saturation])

Select an image in the main window, etc.

Display the Partial Adjustment tool palette.

Tool palette

Blur radius

—— [

Adjustment eroup

Saturation

—_—— =

Select [Adjustment group].

Adjustment eroup

Saturation

—_—— =

Select [Adjustment group] from (], [HE]. (NEM]. [MEM], and
().

(By default, [[JEH] is selected.)

For information on adjustment groups, see “Adjustment Groups”

(p.82).
Click the [Set Adjustment Area] button.

Set Adjustment Area

I

Slze

—— .

Blur radiuz

. —

A circular cursor appears in the window.
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Filter

Circular cursor

Drag the sliders to adjust [Size] and [Blur radius] for
the circular cursor.

Set Adjustment Srea

[
(el

Size

——— s

Blur radius

——— [

[Blur radius] adjusts blurring at the border of the selected area.

Click or drag the circular cursor on the image to
select the area of adjustment in the image.

Use the sliders to adjust [Adjustment items] as
necessary.

fdjustment eroup

Contrast

——

Hue

——— e

Saturation

—_—

Adjustments are applied to the area selected in step 6.

You can use the [ESEN], [IIESEN], (IEIN], and [T
buttons below [Adjustment items] to return and check positions
selected with the circular cursor. Available buttons, from the left,
are [Undo All], [Undo], [Redo], and [Redo All].

Introduction/
Contents

e

Downloading
Images

Viewing
Images

T

Printing
Images

Processing
Large Numbers
of RAW Images

Remote
Shooting

N —

Playing Back
ovies and Saving

Still Photos

Specifying
Preferences

Reference/
Index

S —

00



.

Introduction/
Contents

Making Partial Adjustments to Images Downloading
([Reduce color moiré]) Images

This function partially reduces color moiré in images. -
Before making adjustments, see “Reducing Color Moiré in an Image” Y'e‘”'“g

. . : - mages
(p.67) for information on reducing color moiré.

Changes edited with this function are not displayed in the
following images.
* Thumbnail images
* Navigator images
* Images in the HDR [Select images] window (see p.106, step 3)
* Images in the [Contact sheet] window for printing a thumbnail
list (see p.118, step 3)
However, edited changes are applied when four images or
fewer (JPEG/TIFF images) are selected.
Changes edited with this function are not applied in the DPP
histogram display.

Select an image in the main window, etc.
Display the Partial Adjustment tool palette.

Click the [Reduce color moiré] button in [Adjustment

group].
A dialog box for [Reduce color moiré] appears.

Click the [Set Adjustment Area] button, and use the
[Size] and [Blur radius] sliders for the circular cursor
to make adjustments.

Click or drag the circular cursor on the image to
select the area of adjustment in the image.

Use the [Reduce color moiré] slider in [Adjustment
items] to specify the setting.
Adjustments are applied to the area selected in step 5.

You can use the [ESEN], [IESEN], (IEIN], and [IETIN]
buttons below [Adjustment items] to return and check positions
selected with the circular cursor. Available buttons, from the left,
are [Undo All], [Undo], [Redo], and [Redo All].
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Changes edited with this function are not displayed in the
following images.
* Thumbnail images
* Navigator images
* Images in the HDR [Select images] window (see p.106, step 3)
* Images in the [Contact sheet] window for printing a thumbnail
list (see p.118, step 3)
However, edited changes are applied when four images or
fewer (JPEG/TIFF images) are selected.
Changes edited with this function are not applied in the DPP
histogram display.

Adjustment Groups

Adjuztment group

Reduce calar moiré

The Partial Adjustment tool palette comprises 5 adjustment groups

that allow adjustments to be made with [Brightness], [Contrast], [Hue],

and [Saturation] options, and 1 adjustment group that allows

adjustments to be made with the [Reduce color moiré] option.

« A different adjustment area can be selected for each adjustment
group.

» Adjustment groups [IER]. [IEE]. [IER]. [IEW]. and [IER] allow
different values to be specified even for a same adjustment option.

By default, adjustments from all adjustment groups are applied to an

image. However, you can click the [[g] button and select to apply or

not apply adjustments from each adjustment group.

Positions selected with the circular cursor, that can be checked using

the [INESNN], [IIESNN], (M), and [IEETEN) buttons below

[Adjustment items], can be checked per each group.

The order of adjustment groups in which adjustments are applied to

images is (1) [Reduce color moiré], (2) [IER]. (3) [IEE]. (4) [IEE].

(5) (M. and (6) [IEM)-
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JPEG/TIFF

Editing with the Dust Delete/Copy Stamp Tool Palette

You can use this tool palette to erase dust and other marks in a shot
image and to correct an image by copying part of the image and pasting
it onto an unnecessary part of the image.

Note that you can use the functions in this tool palette with JPEG and
TIFF images as well as RAW images.

Dust Delete/Copy Stamp Tool Palette

Tool palette

@ On 32-bit OSs, the results of erasing dust manually (repair
function) (p.85) and erasing unwanted parts of an image (copy
stamp function) (p.87) can only be checked in the window in which
erasure was performed, in the print results, or in the image after
being converted and saved.

Apply Duzt Delete Data

[Dark)

Performing Automatic Dust Erasure Processing

The Dust Delete Data that is appended to images can be used to
automatically erase dust spots.

Select an image with dust delete data attached in the
main window, etc.
Display the Dust Delete/Copy Stamp tool palette.

You cannot make adjustments with the Dust Delete/Copy Stamp
tool palette in a window that only shows thumbnails.

When the image has redrawn itself, click the [Apply
Dust Delete Data] button.

Dust spots are erased in a single operation.

Return to the main window.
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? Additional information

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [ [ ks3] button in
the Dust Delete/Copy Stamp tool palette or performing the “Re-Editing
an Image” procedure (p.93).

Printing dust-erased images
You can print as a dust-erased image by printing it in DPP.

To erase dust spots that cannot be erased with the automatic
dust erasure processing

In automatic dust erasure processing, dust spots are erased based on
information relating to dust saved in the Dust Delete Data. However,
there may be cases where you will not be able to erase dust spots
depending on the type of dust. If this occurs, erase those dust spots
using the repair function (p.85) or the copy stamp function (p.87).

The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.91).

Applying the dust erasure result to another image

You can apply dust erasure to the same place in another image by
clicking the [Copy] button to copy the dust erasure results and then
displaying the other image to which you want to apply the results and
clicking the [Paste] button.

Automatic Dust Erasure Processing in the Main Window

In the main window, you can also automatically erase dust spots in
multiple images appended with Dust Delete Data.

Select multiple images appended with Dust Delete
Data, and then select the [Adjustment] menu »
[Apply Dust Delete Data].

Dust spots in all the selected images are erased in a single
operation.

——
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Manually Erasing Dust (Repair Function)

You can erase dust spots in an image by selecting them one by one.

In the main window, select the image from which you
want to erase dust spots.

Display the Dust Delete/Copy Stamp tool palette.

Click the point from where dust is to be erased.

Click

The display changes to 100% view.
The display position can be changed by dragging.

Click the button that matches the dust spot to be
erased.
If the dust spot is dark in color, click the |
and if the dust spot is light in color, click the [
button.
When you move the cursor over the image, the dust erasure
range is indicated with [O].

] button,
]

Place the dust spot to be erased within the [O] and
click.

Click

The dust spot within the [O] is erased.

Click on another part of the image to continue erasing dust spots
within the displayed image.

To erase dust in another part of the image, either right-click with
the mouse, or click the button clicked in step 4 again to cancel dust
erasure processing and perform the operation again from step 3.
When the dust spot cannot be erased, [(§)] is displayed.

Return to the main window.

Introduction/
Contents

N —

Downloading
Images

Viewing
Images

T

Printing
Images

Processing
Large Numbers
of RAW Images

Remote
Shooting

N —

Playing Back
ovies and Saving

Still Photos

Specifying
Preferences

Reference/
Index

S —

00



? Additional information

Click several times when dust spots are not erased completely
Where unwanted dust spots are not erased even after performing
step 5 once, they may be erased completely when you click several
times.

Mainly spots of dust can be erased with the repair function
Spots of dust can be erased with the repair function. You may be
unable to erase lines of dust. In this case, use the copy stamp
function (p.87).

The dust-erased image can be reverted to its original condition
at any time

A dust-erased image is displayed or printed as a dust-erased image.
However, since the dust on the image is not actually erased, you can
always revert to the original image by clicking the [ [ liz3l] button in
the Dust Delete/Copy Stamp tool palette or performing the “Re-Editing
an Image” procedure (p.93).

Printing dust-erased images

You can print as a dust-erased image by printing it in DPP.

The image becomes a dust-erased image when converted and
saved

The dust-erased RAW image actually becomes a dust-erased image
when converted to a JPEG or TIFF image and saved (p.91).

~
-

A/

> Useful functions of the copy stamp window

Switch between full screen display/normal screen display using
shortcut keys

You can also switch between full screen display/normal screen
display by pressing the <Alt> + <Enter> keys.

© For images shot with ISO speed range expansion set, noticeable

noise may make it difficult to view dust spots in the copy stamp
window, so using this function is not recommended.
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Erasing Unwanted Parts of an Image (Copy Stamp Function)

You can correct an image by pasting a section copied from another part
of the image to an unwanted part of the image.

Follow steps 1 to 3 in “Manually Erasing Dust (Repair
Function)” (p.85).

Specify the section to be copied.
Click on the section that is to be the copy source after clicking the
[Select Copy Source] button.
To change the section that is to be the copy source, perform the
operation above again.

To fix the position of the copy source, checkmark [Fix Copy
Source position].

Correct the image.
Click or drag on the part of the image you want to modify. [+] in
the window indicates the copy source and [Q] indicates the copy
destination.
The copied image is pasted in the position to which it was
dragged.
For [Pen type], you can select from [Brush] (the pasted image’s
borders simulate a brush) and [Pencil] (the pasted image’s
borders are sharp).

Return to the main window.
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Setting Work Color Space

A different work color space (p.149) from the default settings (p.141) can
be set for each image.

Display the Settings tool palette » select the color
space to be set.

Settings tool palette

Tool palette
[E ]
]

Wifork color space

. E;I:Ift_pr'l:ll:lf colors

ulation profile

? A color space set individually does not change even when the
default setting is changed

If you set an image with a color space different to the default setting and
then subsequently change the default color space setting (p.141), this
default setting will not be applied and the individually set color space will
remain.

-Z\@/E The color space of a RAW image can be changed freely as
many times as required

Since only the image processing conditions information changes, the
color space of a RAW image can be changed at any time.
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Using the Soft-Proof Colors Function

By using the soft-proof colors function, you can apply a selected printing
profile or CMYK simulation profile to the displayed image. The reliability
of the soft-proof colors function depends on the monitor quality, the
monitor and printer profiles, and surrounding lighting conditions where
you are working.

Click the [Settings] button.

The [Color management] tab sheet in [Preferences] appears.

Select the profile to apply from the [Printing profile]
or [CMYK simulation profile] list box, and click the
[OK] button.

Preferences “

General settings Defalt settings of Work calor space *
) Rpple RGE

) ColorMatch RGB

O sRGB
® Lse the 05 settings

) Moniter profilc

Printme protile Hender ing mtents

e - ) Posesprst

® Ralative Colarimetric

GMYE simulation profile

[-= Mo —

#Changes take effect after restarting. Ok Uancel

The [Color management] tab sheet in [Preferences] closes.

According to the profile selected in step 2, select
either [Use printing profile] or [Use CMYK simulation
profile], and checkmark the [Soft-proof colors]
checkbox.

Tool palette

lation profile

The profile selected in step 2 is applied to the displayed image
including its thumbnail.

The profile is not applied to images displayed in the quick check
window.
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Specifying the Size when Opening RAW Images

This applies only to RAW images with the extension “.CR3” that were
shot with [ cxm ] selected on the camera.

This function specifies the image size when a RAW image is selected
and opened in DPP. When the selected RAW image is converted and
saved as a JPEG or TIFF image, it is also saved at the same size.

Select the RAW image » display the Settings tool
palette » select the size when opening RAW images
in DPP.

Settings tool palette

lation profile

= opening RAW images

Original zize (do nat chanee) -

The image size when opening RAW images in DPP is set.

The default setting shows the size set in [Default size when
opening RAW images] in the [Image Processing 2] tab sheet in
[Preferences].

The settings are saved as recipes for each image.
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JPEG/TIFF

Saving Editing Results

Saving Editing Contents to an Image

All the contents adjusted with the tool palette (recipe) can be saved to
the image or saved as a separate image.

Select the [File] menu » desired item.

Close window Ctrl+W
Save Ctrl+5
Save As... Ctrl+Shift+5
Convert and save.., Ctrl+D
Batch process... Ctrl+B

Save still image from movie...  Ctrl+Shift+D

Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Print contact sheets Alt+5Shift+P
Plug-in printing »
Add to collection Ctrl+G
Remove from collection Ctrl+5hift+G

Clear collection

Select collection 3
Delete collection 3
Bookmark

Remove bookmark

Mave to Recycle Bin Del

Exit Alt+F4

Your adjustments are saved to the image.

Saving as a separate image

To view, edit and print a RAW image with software other than DPP,
convert to a more versatile JPEG or TIFF image and save.

If a JPEG or TIFF image is saved as described below, the image can be
saved as a separate image with the adjustments (recipe) applied to it.
The image is saved as a separate image, so the original image remains
unaffected.

Select the image to be converted.

Select the [File] menu » [Convert and save].

Close window Ctrl+W
Save Ctrl+S
Save As... Ctrl+Shift+5
[ Convert and save... Ctrl+D ]
Batch process... Ctrl+B

Save still image from movie..  Ctrl+5hift+D

Print... Ctrl+P
Print with detailed setting... Ctrl+Alt+P
Print contact sheets Alt+5hift+P
Plug-in printing 2
Add to collection Ctrl+G
Rermove from collection Ctrl+5Shift+ G

Clear collection

Select collection »
Delete collection 3
Bookmark

Remove bookmark

Move to Recycle Bin Del

Exit Alt+F4

The [Convert and save] window appears.
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Specify the necessary settings, and then click the

[Save] button.

By default, the image is converted and saved to a JPEG image
with the highest image quality, without changing the image size.
Change the settings according to your requirements.

@ Convert and save “

ssve infll | oo 03 vl @3 Er

4

Recent places
o m — Select the save

Desktop i i
G o001 destination
r="
Libraries

This PC

(".‘. (Fl\egeme i, o007 V] [ o= [J— C|ICk and save
e || Seve estipe TIFF 18bit + Exif-JFEG (4 TIF, * JPG) v
—— = Enter a file name
and select an
Dl fesie v image type

“Width Height
6472 x 3648 (6472 pixel x 3648 pixel) Unit | picel

Embed ICC profile

Shooting infa setting  Include all shooting info

The RAW image is converted to a JPEG or TIFF image which is
then saved as a new image in the specified save destination.

Ay

=)= To save the developing/editing results for the version you are

currently using

DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.

Meaning that, between two different versions of DPP, processing results
may differ very slightly even if with the same RAW image data, or the
results of significant editing of RAW image data with an attached recipe
may be different.

When you want to save the developing or editing results of the version
you are currently using as it is, saving the image as a separate file (p.91)
is recommended.

ﬁl By saving as a separate JPEG or TIFF image as explained
above, some image deterioration that accompanies editing/saving
occurs as when editing with general image editing software.
By saving as explained above, a trimmed image (p.68) or dust-
erased image (p.83 to p.87) actually becomes a trimmed image
or dust-erased image.
You can batch convert and save multiple images (p.123).
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Re-Editing an Image

Only the image processing conditions are changed in images adjusted
with the tool palette (p.43 to p.88), so the “original image data itself”
remains unaffected. (The trimming range or dust-erasure information of
a cropped image (p.68) or dust-erased image (p.83 to p.87) is simply
saved to the image.)

For this reason, you can undo any adjustments saved (p.91) to the
image, trimming range and dust-erasure information, and revert to the
condition when last saved, or when the image was shot.

Select the image that is to be re-edited.

Select the [Adjustment] menu P desired item.

Adjustment

Rotate Left Ctri+L
Rotate Right Ctrl+R

Apply Dust Delete Data

Work color space 3

Revert to last saved settings  Ctrl+Alt+Z
Revert to shot settings Ctrl+Shift+7

The image reverts to the conditions of the selected item.
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Utilizing Adjustment Contents (Recipe)

All the adjustment contents (recipe) made using the tool palette can be
saved as an individual recipe file (extension “.dr4”) and loaded and
applied to another image.

You can edit images efficiently by selecting and adjusting one image
from images shot with the same shooting environment and batch
applying the adjustment results to a large number of images.

JPEG, 1 , TIFF image data
Image processing conditions information

_ " > ‘L RAW i |mage data:
Image processing conditions information

I \N
Ldrd

Contents adjusted using the tool
palette can be handled
individually as a recipe file
(extension “.dr4”).

A recipe file with contents that can only be adjusted in RAW
images are not reflected even if it is applied to a JPEG or TIFF
image.

Recipes are not compatible between DPP version 4.x and DPP
version 1.x to 3.x. Images with DPP version 1.x to 3.x recipe files
attached are displayed with the shot settings in DPP version 4.x.
Conversely, images with DPP version 4.x recipe files attached are
displayed with the shot settings in DPP version 1.x to 3.x.
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Copying a Recipe and Applying to Another Image Saving a Recipe as a File

Downloading

You can copy a recipe of an edited image and then apply it to another Select an edited image, and then select the [Edit] Images
'mage. menu » [Save recipe in file].

] . . ipe in fi i . Viewing

Select the image with the recipe you want to copy. The [Save recipe in file] dialog box appears Images

To copy all items of a recipe, select the [Edit] menu »
[Copy recipe]. To copy only selected items of a
recipe, select the [Edit] menu » [Copy selected
recipe].
The recipe is copied.
To select recipe items, select the [Edit] menu P [Select and copy
recipe settings] and select items in the window that appears.
After specifying settings, click the [OK] button and close the
window.

Select the image to which the recipe is to be applied
and then select the [Edit] menu » [Paste recipe].
The recipe is applied to the image.

|§| When a recipe for an image is copied and applied to an image in a

different orientation, the image orientation also changes. To prevent
the orientation of the image from changing, select the [Edit] menu »
[Select and copy recipe settings] and remove the check mark from
the [Rotate left / Rotate right: 0°] checkbox in the window that
appears.

To save all of a recipe, select the [Save all recipes] option in the
window displayed.

To select and save recipe settings, select the [Save selected
recipes] option in the window displayed and then click the
[Specify Recipe Details] button. In the window displayed,
checkmark the recipe settings to be saved and then click the
[OK] button.

Select the destination folder, enter a file name, and
then click the [Save] button.
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Loading and Applying Recipes

Select the image to which a recipe is to be applied,
and then select the [Edit] menu » [Read and paste
recipe from file].

The [Open] dialog box appears.

Select a recipe and click the [Open] button.
The recipe is applied to the image.
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JPEG/TIFF

Adjusting by Comparing Multiple Images

You can synchronize the areas in different images to be displayed
among multiple preview windows, and adjust images while comparing
them.

In the preview window, display the multiple images
to be compared.

Align the images.
Select the [Window] menu » [Arrange horizontally] or [Arrange
vertically].
The preview windows are aligned.

Select the [Preview] menu » [Sync preview position]
and [Sync preview display size].

Enlarge the image.
Enlarge and display any of the preview windows.

Other preview windows will also be displayed in the same
position/enlargement ratio.

Move the area to be displayed.
If you move the enlargement display area in one of the preview
windows, the enlargement display area will also change in all
other preview windows.
To cancel synchronization, select the [Preview] menu » [Sync
preview position] and [Sync preview display size] again.

@ Synchronization only applies to the enlargement display position
and the enlargement ratio. Adjustments to the images are not
synchronized.
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Editing Efficiently

Editing in the Edit Image Window

The thumbnail display and the preview window are combined, and

images can be edited efficiently while quickly switching between images

to be edited. Select the images to be edited beforehand in the main
window.

In the main window, select the images you want to

edit.

Switch to the edit image window.

File Edit View Thumbnpails Preview Label Adjustment Tools Window

Edit Irmage ck

Remote Shooting

Folder k= ON OFF o'

Click
The main window switches to the edit image window.

Edit image window

¥
ha
@

T N I |

Edit the image.

Change the display magnification

Select the image to be edited

The selected image is displayed as an enlargement in the
middle of the window

For information on icons displayed on the frame of a thumbnail,
see “Image Frame Information in the Main Window and Edit
Image Window” (p.147).

The tool palettes, navigator palette, and histogram palette are
displayed and you can edit the image.

To revert to the condition before the last operation performed on
the tool palette, select [Undo] in the [Edit] menu or press <Ctrl> +
<Z> keys.
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Click the area you want to enlarge.

Changing the Thumbnail Display Position to Horizontal

Select the [View] menu » [Horizontal Thumbnails].

Downloading
Images

E— il Viewing
Images

T

Click

Printing
Images

Processing
Large Numbers

If you select [Vertical Thumbnails], the thumbnail display reverts of RAW Images

: . ) , to the vertical position.
The area you clicked is enlarged to 100% (actual pixel size). Remote

To change the display area, drag on the image or drag the Shooting
enlargement display area (p.18) of the navigator palette. S —
Click again to revert to the full view ([Fit to window]). Playing Back
- . ovies and Saving
To return to the main window, click the [] button on the still Photos

toolbar.
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|§| With the edit image window, you can only select images from a @

folder. To gather images from several folders for editing, see
“Gathering and Editing Images in the Collection Window” (p.100).



Gathering and Editing Images in the Collection Window
You can gather selected images together in Collection folders for
viewing, comparison and editing.

You can gather images from several folders as well as from a single
folder, allowing you to work with them efficiently.

Click [+ Add collection] in the [Collection] area in the
main window.

1y
15016

[ R IMG_0019.CR2

GCollection

A new collection folder is created in the [Collection] area.

Enter a name for the collection folder.

To create additional collection folders, repeat the operation. Up to
20 folders can be created.

Select the [File] Menu » [Select collection], and
select a collection folder to gather images from the
collection folder names displayed.

Select images or image folders in the main window.
Select the [File] menu » [Add to collection].

The images are added to the selected collection folder, and the
number of selected images in the collection folder is displayed.
When an image set to single-image display (p.22) is added, the
number of images is indicated as two images.

You can also add images to a collection folder by selecting
images and folders and then selecting [Add to collection] from
the menu that appears when you right-click the mouse.

Select a collection folder in the [Collection] area.

Collection
150100

B3 0001(35)
i 0002031)

Images in the selected folder are displayed.
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Check the displayed images.

Edit the images.

Edit the displayed images.
Displayed images are retained in the collection folders even after
exiting DPP.

® On 32-bit OSs, only up to 1000 images can be displayed per
collection folder. Starting with the 1001st image, images are handled
in the same way as non-supported images. Try to maintain 1000
images or less per folder.

Y

-@> To remove images from collection folders

Removing selected images

Select images in a collection folder, select images, and select
[Remove from collection] in the [File] menu. (You can also remove
images from a collection folder by selecting the images, right-clicking
with the mouse, and selecting [Remove from collection] from the
menu that appears.) Note that even if you remove an image from a
collection folder, the original image remains unaffected.

Removing all images

Select [Clear collection] in the [File] menu. Note that even if you
remove all images from a collection folder, the original images remain
unaffected.

Deleting a collection folder

Select a collection folder in the collection area, then select [Delete
collection] from the menu that appears when you right-click with the
mouse. Note that if you delete a collection folder, the original images
remain unaffected.

@ Modifications to the image are applied to the original image

Modifications made to images in a collection folder are all applied to

the original image.
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Compositing Images
You can combine two images into a single image. You can further
combine images by adding another image to the composited image.

Since the composited image is saved as a separate image, the original
images remain as they are.

® On 32-bit OSs, this function is not available.

|§| This function can be used with all image types (p.4) supported by
DPP.

The color space of a composited image will be the color space of
the background image.
Image information is not appended to a composited image.

Select a background image in the main window.

Ema 2 oo lm @ > N

You can also select a background image from the edit image
window or [Collection] window.

Select the [Tools] menu P [Start Compositing tool].
The compositing tool window appears.

CA\Users\woocod\Pictureshiooood IMG_0001.CR2 [5760 x3840] = [l) “

P

Introduction/
Contents

e

Downloading
Images

For image compositing, select an image to combine.

Viewing
Images

T

Printing
Images

Processing
Large Numbers
of RAW Images

Remote
Shooting

S —

Playing Back

ovies and Saving
Still Photos

Specifying
Preferences

Reference/
Index

00
©

102




Select the image to combine.
Select the image to combine from the [Foreground Image] list

box.
-

100%0 view

Foreground Image
IMG_0001.CR2 W
Select an image

IMG_0001.CR2

IMG 0002.CR2

IMG_0003.CR2
IMG_0004,CR2

Composite Method

The selected image is displayed in the [Foreground Image]

thumbnail display.

A preview of the combined background image and [Foreground

Image] is displayed in the composite preview.

The following images can be combined.

* When a background image is selected in the main window:
images in same folder as background image

* When a background image is selected in the [Collection]
window: images in the [Collection] window

* When a background image is selected in the edit image
window: images displayed in the thumbnail display area

You can also combine images of different sizes.

Select a compositing method.
Select a compositing method from the [Composite Method] list

box.
B

100%0 view

Foreground Image

IMG_0002.CR2 W

Compaosite Method
Add ]

Add
Average

Lighten
|Darken

Position

The compositing method selected in the composite preview is
applied.

The compositing method can be selected from five types: Add,
Average, Weighted, Lighten, and Darken. For details on each
compositing method, see “Compositing Methods” (p.105).

If you select [Weighted], you can set the proportion of the image
to be combined. Use the [Weight] slider at the bottom of the
[Composite Method] list box or directly enter a value to set the
proportion.

By clicking the [100% view] button, the image is displayed at
100% magnification (actual pixel size).
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Position the images.

(-3 C:\Users\iooood\Pictures\iooood IMG_0001.CR2 [5760 x38401 =

100% view

Foreground Image

IMG_0002.CR2 L4

Compasite Method
Weighted v

Compose in RAW Format
P

Weight 50.0 =

Position |

2
- Shift small amount (1 pixel)
W e
;| Align image centers
x[p B You can also directly enter the position
e coordinates of the [Foreground Image]
save e to align it.
By default, the background image and the [Foreground Image] are
displayed with their centers aligned.
[Compose in RAW Format]
Checkmark the [Compose in RAW Format] checkbox as necessary.
@ You can set [Compose in RAW Format] under the following
conditions.
Both the background image and [Foreground Image] are RAW
images, and all the following conditions are met.
» The cameras used to shoot were of the same model
* The ISO speed setting at the time of shooting was the same @ The following functions are not available for images composited
 The highlight tone priority setting at the time of shooting was with [Compose in RAW Format].
the same * Auto Lighting Optimizer (p.56)

» The image sizes (original size) are the same

Shift large amount (50 pixels)

* Picture Style Auto (automatically set to Standard) (p.47)
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Click the [Save As] button.

Position

"

b

4

“

Continue

Save As...

Close

Specify the required settings in the window that appears and then
click the [Save] button.

By clicking the [Continue] button, images are combined to create
a new background image, and you can continue by combining
another image.

To finish, click the [Close] button.

Compositing Methods

Add

The background image and [Foreground Image] are added and
images are combined.

Average

The background image and the [Foreground Image] are combined in
proportions of 50% each.

If you want to change the proportion of the [Foreground Image], select
[Weighted].

Weighted

Set the proportion of the [Foreground Image] and then combine the
background image and [Foreground Image].

Lighten

The background image and the [Foreground Image] are compared,
with only brighter portions of the [Foreground Image] being combined.
Darken

The background image and the [Foreground Image] are compared,
with only darker portions of the [Foreground Image] being combined.

@ You can display this function as a function button in the main

window’s toolbar (p.114).
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JPEG/TIFF

Creating HDR (High Dynamic Range) Images

You can create images with a wide dynamic range where clipping in
highlights and shadows has been reduced, and images that appear like
paintings. This is suited for scenes such as still-lifes and landscapes.
This function is most effective when using three images with different
exposures for the same scene (negative exposure, standard exposure,
positive exposure) to create an HDR image. However, you can also
create an HDR image from two images, or even only one.

Since an HDR image is saved as a separate image, the original images
remain as they are.

* HDR stands for High Dynamic Range.

® On 32-bit OSs, this function is not available.

|§| This function can be used with all image types (p.4) supported by
DPP.

Image information is not appended to an HDR image.

Select an image in the main window.

Select the [Tools] menu » [Start HDR tool].
The [Select Images] window appears.
You can also display the [Select Images] window from the edit

window and edit image window.

Specify the required settings, then click the [Start

HDR] button.

&

Select Images

IMG_0001.CR2

Browse...

[ Auto Align

IMG_0002,CR2

Browse...

IMG_0003.CR2

Browse...

Close
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To change the selected image or add another image, click the
[Browse] button, and in the [Open] dialog box that appears,
select the image file and click the [Open] button.

If you select two images of the same size, you can checkmark
the [Auto Align] checkbox for auto image alignment. However,
auto image alignment may not work properly with repetitive
patterns (lattice, stripes, etc.) or flat, single-tone images.

By clicking the [Start HDR] button, the [Adjust Image] window

appears.

@ After using auto image alignment, the periphery of the images is

partially deleted.
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Make required selections to adjust the image.

@ Adjust Image s =

Presets

Natural v

Tone/Calor

Brightriess:(50)

Saturation:(50)

Contrast:(30)

Detail Enhancement
Strength:(0)

Smaothness:(0)

IMG_D0D1.CR2 / IMG_D002.CR2 { IMG_D003.CR2

Sliders in [Adjust Image] window
[Tone/Color]

[Brightness]: Adjusts the overall brightness of the image. Move
the slider to the right to brighten the image, and to
the left to darken the image.

[Saturation]: Adjusts the overall color saturation of the image.
Move the slider to the right to make the color
deeper, and to the left to make the color weaker.

[Contrast]:  Adjusts the overall contrast of the image. Move
the slider to the right to make contrast stronger
and to the left to make contrast weaker.

[Detail Enhancement]

[Strength]: Adjusts the overall contrast and contrast of
details together. Move the slider to the right for a
stronger effect.

[Smoothness]: Adjusts the overall smoothness of the image.
Move the slider to the right for a smooth and
natural impression.

[Fineness]:  Adjusts the clearness of details. Move the slider
to the right for a sharper outline.

[Presets] and finishing effects

With [Presets], you can select from the five preset finishing

effects below from a pulldown menu ([Natural] is selected by

default), instead of operating the sliders individually. By selecting

a finishing effect, each slider moves according to the setting. You

can also operate and adjust the sliders after selecting an effect.

[Natural]: In high-contrast scenes, rendering in areas
where highlights or shadows are usually clipped
is corrected, for a finish with reduced highlight
and shadow clipping.

[Art standard]: Gives a finish with painting-like tonality for an

impressive image.

For a more vivid look than with [Art standard].

For a more vivid look than with [Art standard],

that makes the subject pop out.

[Art embossed]: Tones down vividness more than [Art standard],
for an old-fashioned feel.

[Art vivid]:
[Art bold]:
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Click the [Save As] button.

Fineness: {0}

Save As...

Close

Specify the required settings in the window that appears by
clicking the [Save As] button and click the [Save] button.

|§| You can display this function as a function button in the main
window’s toolbar (p.114).
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Using the Dual Pixel RAW Optimizer

By setting the Dual Pixel RAW function on the camera compatible with
the function before shooting RAW images, images are recorded as
“special RAW images (Dual Pixel RAW images)” with dual pixel
information appended from the imaging sensor. This is called Dual Pixel
RAW shooting. Using this function, the [Dual Pixel RAW Optimizer], with
Dual Pixel RAW images, you can make use of the Dual Pixel data
recorded with the Dual Pixel RAW image for microadjustment of the
position of maximum sharpness and resolution using the depth
information contained within the file, repositioning the viewpoint or
foreground bokeh for a more pleasing result, and reducing the
appearance of ghosting in images.

® Cautions for Dual Pixel RAW shooting
Note the following when shooting in Dual Pixel RAW.
Common to all functions
 Effects are most easily gained when the lens aperture value is
f/5.6 or lower.
 Effects may be different between shooting in vertical orientation
and horizontal orientation.
* It is recommended that the ISO speed be ISO 1600 or lower.
Only for “Microadjustment of the position of maximum sharpness
and resolution using the depth information contained within the
Dual Pixel RAW file”
* |t is recommended that the lens focal length be at least 50 mm.
* It is recommended that this function be used when the camera
is at a distance from the subject.”
* Use the following as a guide to subject distances according to
focal length.
When the lens focal length is 50 mm, the subject distance
should be approx. 1 m-10m/ 3.3 ft. - 32.8 ft.
When the lens focal length is 100 mm, the subject distance
should be approx.2m-20 m/ 6.6 ft. - 65.6 ft.
When the lens focal length is 200 mm, the subject distance
should be approx.4 m-40m/13.1 ft. - 131.2 ft.

|§| You can display this function as a function button in the main
window’s toolbar (p.114).

Microadjustment of the Position of Maximum
Sharpness and Resolution Using the Depth
Information Contained within the Dual Pixel RAW File

Microadjust the position of maximum sharpness and resolution, using the
depth information contained within the Dual Pixel RAW images.

In the main window or edit image window, select the
Dual Pixel RAW image you want to adjust, and then
select [Start Dual Pixel RAW Optimizer] from the
[Tools] menu.

The Dual Pixel RAW Optimizer window appears.

C\Users\user\Pictures\ioooo\IMG_0010.CR2 [6720 x 4480] = “

100%

o

Checkmark the [Image Microadjustment] checkbox.
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Adjust the image.

()

CUsers\userPictures\oouoIMG 0010.CR2 [6720 x 44801 =8

| ——

Use the slider to adjust the resolution based on depth information
and the level of resolution.

Click the [OK] button.

Adjustment results are applied to the image.
For information on saving adjustment results to images, see
“Saving Editing Results” (p.91).

If the subject’s outline or any bokeh look unnatural, or there is an
increase in noise or noticeable changes in hue or brightness,
lower the level of adjustment.

This function cannot be used at the same time as “Reposition the
viewpoint or foreground bokeh for a more pleasing result” or
“‘Reduces the appearance of ghosting in images”.

Reposition the Viewpoint or Foreground
Bokeh for a More Pleasing Result

Reposition the viewpoint or foreground bokeh for a more pleasing result,
using the dual pixel information recorded in Dual Pixel RAW images.

In the main window or edit image window, select the
Dual Pixel RAW image you want to adjust, and then
select [Start Dual Pixel RAW Optimizer] from the
[Tools] menu.

The Dual Pixel RAW Optimizer window appears.
Checkmark the [Bokeh Shift] checkbox.

Specify the area to adjust.

L C\Users\user\Pictures\ooood IMG_0020.CR2 [6720 x 4480] = -

Click the [Select area] button and drag on the image to specify
the area to be adjusted, and right-click with the mouse to fix the
area.

You can also remove the check mark from the [Show borders]
checkbox to hide the border.
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Adjust the image.

= C\Users\user\Pictures\oooo)\IMG_0020.CR2 [6720 x 4480] - clEN

Use the slider to adjust the viewpoint.

Click the [OK] button.
Adjustment results are applied to the image.
For information on saving adjustment results to images, see
“Saving Editing Results” (p.91).

If the subject’s outline or any bokeh look unnatural, or there is an
increase in noise or noticeable changes in hue or brightness,
lower the level of adjustment.

Resolution may expand in the depth direction according to the
level of adjustment.

If the border of the selected area in the image appears unnatural,
lower the level of adjustment.

This function cannot be used at the same time as
“Microadjustment of the position of maximum sharpness and
resolution using the depth information contained within the Dual
Pixel RAW file” or “Reduces the appearance of ghosting in
images”.

Reduces the Appearance of Ghosting in Images

Reduce the appearance of ghosting in images, using the dual pixel
information in Dual Pixel RAW images.

In the main window or edit image window, select the
Dual Pixel RAW image you want to adjust, and then
select [Start Dual Pixel RAW Optimizer] from the
[Tools] menu.

The Dual Pixel RAW Optimizer window appears.

Checkmark the [Ghosting Reduction] checkbox, and
specify the area.

L= C\Users\user\Picluresiyooosd IMG_0030.CR2 [6720 x 4480] =G -

Click the [Select area] button and drag on the image to specify
the area to be adjusted, and right-click with the mouse to fix the
area.

You can also remove the check mark from the [Show borders]
checkbox to hide the border.

Any ghosting and flare in the specified area is reduced.
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Click the [OK] button.
Adjustment results are applied to the image.

For information on saving adjustment results to images, see
“Saving Editing Results” (p.91).

There may be cases where the subject's outline and any bokeh
look unnatural, or where an increase in noise or noticeable
changes in hue or brightness occur.

There may be cases where the border of the selected area in the
image looks unnatural.

This function cannot be used at the same time as
“Microadjustment of the position of maximum sharpness and
resolution using the depth information contained within the Dual

Pixel RAW file” or “Reposition the viewpoint or foreground bokeh
for a more pleasing result”.

Introduction/
Contents

N —

Downloading
Images

Viewing
Images

T

Printing
Images

Processing
Large Numbers
of RAW Images

Remote
Shooting

N —

Playing Back
ovies and Saving

Still Photos

Specifying
Preferences

N ——

Reference/
Index

00
©

112



Transferring a RAW Image to Photoshop

A RAW image can be converted to a TIFF image (16bit) and transferred
to Adobe Photoshop.

Select the [Tools] menu » [Transfer to Photoshop].
Photoshop starts up and the transferred image is displayed.

? A single image can be transferred at a time

Only one image can be transferred at a time. To send multiple images at
a time, see p.125.

|§| Compatible versions of Photoshop are 7.0 or later.
Transferred images are automatically converted to TIFF images
(16bit) to which an ICC profile (p.148) is added. The ICC profile
contains information about [Preferences] (p.141) or work color
space (p.88) set for each image as described and the appropriate
color information is relayed to Photoshop.

When you exit Photoshop, only the original RAW image remains,
and the transferred image will disappear. Saving the transferred
image as a separate image in Photoshop is recommended.

of RAW Images
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Customizing the Main Window Toolbar

You can display buttons for frequently-used functions in the main
window’s toolbar.
You can also change how the buttons are laid out.

Select the [Tools] menu » [Customize toolbar].

The [Configure Toolbar] window appears.

Select functions to display in the toolbar.

Configure Toolbar E

Select itemsz to show in the toolbar.

Print Mave Lp

Maowve Diovn

HDR Tool
Dual Pixel RAW Optimizer
Photoshop

Close

To rearrange buttons, select the function you want to change,
and then click the [Move Up] or [Move Down] button.

After specifying settings, click the [Close] button and close the
window.

The settings are applied to the main window’s toolbar.
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H H Introduction/
Printing an Image Contents
You can print images with a printer. As an example, the procedure to —
print one image on one sheet of paper is described here.

Downloading
Images
Select the image to be printed.
Viewing
Select the [File] menu » [Print]. Images

Close window Ctrl+W
Save Ctrl+5§
Save As.. Ctrl+5hift+5
Convert and save... Ctrl+D Editing
Batch process... Ctrl+B Images

Save still image from movie...  Ctrl+5Shift+D

( eiint.. Ctrl+P Prihging
Print with detailed setting... Ctrl+Alt+P | es

Print contact sheets Alt+Shift+P .
Plug-in printing » Processing
. . Large Numbers
Add to collection Ctrl+G of RAW |mages
Remove from collection Ctrl+Shift+G —
Clear collection
Remote
Select collection 3 Shooting
Delete collection 3 -/
Bookmark Playing Back
Remove bookmark ovies and Saving
Still Photos
Move to Recycle Bin Del
Exit Alt+F4 SPecifying
The printer’s print settings dialog box appears. B
—
Print. e /
Specify the optimum settings for printing photographs in the eﬁ;ir;(ce
printer’s print settings dialog box and click the [OK] button.

Printing begins. @ @
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Printing with Shooting Information

You can freely layout one image on one sheet of paper and print
together with titles and shooting information, etc.

Select one image to be printed.

Select the [File] menu » [Print with detailed setting].

Specify the required settings for printing, and then

click the [Print] button.

Switches the settings tab sheet

o C:\Users\iood\Desktop\oooo 03\IMG_0001.CR2
Printer | Image | Text SethngsJ
Printer:
OO v
Properties...
Media: 297.0mm x 210.0mm
A4 v
Media orientation:
() Portrait (® Landscape
Media type:
Print Quality:
Borderless:
Print profile:
CMYK profile:
CMS settings...
Print Cancel Apply

Print preview

The image can be moved by dragging.

Drag the four corners of the image to change the size.
For the shooting information, click [E]] on the [Text] tab sheet
and select the necessary items in the window that appears.

-~ To maintain the settings

The settings of each tab sheet in step 3 are memorized when printing or
the [Apply] button is clicked. The settings can be applied to another
image when printing.

Memorized settings are options in [Printer], [Media], [Media orientation],
[Registration marks], [Header], [Footer], and [Image Information], and
settings in the [Settings] tab sheet.

ﬁl You can set printer profiles (p.142).
If CMYK simulation is set, the image is printed in the set colors.
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Printing a Thumbnail List (Contact Sheet Printing)

You can print rows of multiple images on one sheet of paper.

Select images to be printed in a thumbnail list.

Select the [File] menu » [Print contact sheets].

Specify the required settings for printing, and then

click the [Print] button.

Switches the settings tab sheet

& Contact sheet | < |
Printer | |mage | Text Set‘tmgsJ
Printer:
AR g
Properties...
Media: 210.0mm x 297.0mm
A4 i

Media orientation:
(@) Partrait () Landscape
Media type:

Print Quality:

Borderless:

Print profile:

CMYK profile:

CMS settings...

' Print ' Cancel Apply

Print preview

—Z\@i— To maintain the settings

The settings of each tab sheet in step 3 are memorized when printing or
the [Apply] button is clicked. The settings can also be applied to another
image when printing.

Memorized settings are [Printer], [Media], and [Media orientation], and
settings in the [Image] and [Settings] tab sheets.

|§| You can set printer profiles (p.142).
If CMYK simulation has been set, the image is printed in the set
colors (p.141).
By using this function in the edit image window, all images in the
window (not only the selected ones) are printed in a thumbnail
list.
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Plug-in printing
Select the [File] menu » [Plug-in printing] » Plug-In
for the printer you use.
The Plug-In starts up.
Specify the required settings for printing
photographs and then print.
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6 Processing Large Numbers of RAW Images

Batch Apply White Balance to Images (Personal White

Balance) .......cooo i 121
Registering Personal White Balance........................ 121
Applying Personal White Balance ...............cccceee..... 122

Batch Save as JPEG or TIFF Images (Batch

Processing).....cccoeeuuiiiiiiiece e 123

Batch Transfer Images to Image Editing Software ......... 125

Batch Change the File Name of Images................ 126
Changing the File Name of Images in the Order in the
Main WiNAOW .......cocuviiiieeecciiieee e 126

Introduction/
Contents

Downloading
Images

Viewing
Images

Editing
Images

Printing
Images

Procgssing
Large bers
of RA ages

Remote
Shooting

Playing Back
Movies and Saving
Still Photos

Specifying
Preferences

Reference/
Index

00

120



Batch Apply White Balance to Images (Personal White Balance)

The white balance adjustments made to a RAW image shot in a specific
shooting environment can be registered as personal white balance. You
can then perform efficient white balance adjustment by applying this
personal white balance to a large number of RAW images shot in the
same shooting environment.

Personal white balance data for versions before DPP 4 cannot be
applied.

Registering Personal White Balance

Adjust the white balance (p.50, p.51).
To adjust white balance, select a setting other than [ ()] from
the [White balance adjustment] list box (p.49). Registering the
adjustments is not possible if [ ()] is selected.

In the Basic adjustment tool palette, click the
[Register] button.
The [Register personal white balance] dialog box appears.

Select the button number to be registered from the
list and click the [OK] button.

Register personal white balance H

Register current setting in personal white balance

Save...

? To use the registered personal white balance on another
computer

In step 3, click the [Save] button to write as a file.

Copy the file to another computer.

In DPP on another computer, display the window of step 3.

Click the [Load] button and in the window that appears, select the
copied file.

® You cannot change or adjust white balance with multiple-exposure
RAW images created on the camera.

Introduction/
Contents

—
—

Downloading
Images

Viewing
Images

Sorting
Images

Editing
Images

—

Printing
Images

Procgssing
Large bers

of RA ages

Remote
Shooting

Playing Back
Movies and Saving
Still Photos
Specifying
Preferences

—

Reference/
Index

00

121



Applying Personal White Balance

In the main window, select the image to which a
personal white balance is to be applied.

Select the [View] menu » [Tool palette].
The tool palette appears.

Click the personal white balance number button that
is to be applied.

Taal |:|E||E=ttE=

Brizh justrnent

*m

= balance adjustment

Fine-tune

B —— o

'ﬂ-

Auto Lighting Optimizer |

Loy Standard Strong
licture Style
3 (Landscape) -
Gamma adjugtment ¥

B Linesr
DA

A0

Personal white balance is applied to all the selected images.
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Batch Save as JPEG or TIFF Images (Batch Processing)

You can batch convert and save edited RAW images to highly versatile
JPEG or TIFF images.

The images are saved as separate images, so the RAW images remain
unaffected.

In the main window, select multiple images to be
converted.

Select the [File] menu » [Batch process].
The [Batch settings] window appears.

Specify the required settings, and then click the
[Execute] button.

IMG_0006.CR2

Greate storage subfolders for each file type
IMG_0007CR2 o o

IMG_0008 GR2 Exif- JPEG Subfolder name  JFEG
IMG_0003CR2

IMG_0010GR2 Output setting

IMG_0011GR2

MG 01268 Save as type Exif-JPEG (*.JPG) . Image guality 10
IMG_0013GR2

MG 018 6RS Output resalution 350 dpi

IMG_0015.GR2

MG 0017.CR2 [ R=sce T

IMG_1018GR2 Width Height

MG D019.CR2 BT % 3645 (5472 pixel x 3648 pixel] Unit | pivel
IMG_1020GR2

IMG_0021.CR2 Embed ISG profile

IMG_1022.GR2

IMG_1023.CR2 Shooting info setting  Ihclude all shooting info

IMG_1024 GR2

IMG_0025GR2

IMG_0026CR2 Fils name

IMG_0027.GR2 @® Gurrent file name

IMG_0028.CR2 ) New file nams

IMG_0028GR2 -

IMG_0030CR2 Siring Additional string

IMG_0031.GR2 00000001

IMG_0032GR2 7

IMG_0033CR2
Ex.: IMG_0001.JPG, IMG_0002.JPG

Image transfer settings

[ Open imaes using softwars

Convert RAW images only Gancel

Batch settings E
IMG_0001.CR2 Destination falder
IMG_0002CR2 (®) Same as original files
IMG_0003CR2 ~
TG 1004 CR2 ) Use this folder
IMG_0005CR2 C¥llsers¥user¥Pictures

The batch processing dialog box appears and saving begins.
When all the images are saved, the [Exit] button appears in the
batch processing dialog box.

In the processing dialog box, click the [Exit] button.

If you have selected [New file name] in [File name], [Sequence
number] has to be set.

By saving as explained above, a trimmed image (p.68) or dust-
erased image (p.83 to p.87) actually becomes a trimmed image
or dust-erased image.

You can also use this function in the editimage window. However,
all images in the window (not only the selected ones) are
converted and saved.

Introduction/
Contents

— ¢
)

Downloading
Images

Viewing
Images

Sorting
Images

)
Editing
Images

_— —
)

Printing
Images

Procgssing

Large bers
of RA ages

Remote
Shooting

Playing Back
Movies and Saving
Still Photos

— 4
G |

Specifying
Preferences

Reference/
Index

00

123




? Saving images with recipe is not possible

In the [Batch settings] window, you cannot perform [Save] or [Save As]
(p.91) to edited RAW images.

-Z\@IE To save the developing/editing results for the version you are
currently using

DPP’s RAW image development processing technology is continually
being improved upon so that you can perform the latest image
processing more appropriately.

Meaning that, between two different versions of DPP, processing results
may differ very slightly even if with the same RAW image data, or the
results of significant editing of RAW image data with an attached recipe
may be different.

When you want to save the developing or editing results of the version
you are currently using as it is, converting and saving images as JPEG
or TIFF images is recommended.

Q% Skillful batch saving

While saving is being performed, you can continue working in
another window

Since the saving function operates independently in the background,
you can continue with an operation in another window such as the
main window or the preview window during the saving process.

To convert all images and save, do not select an image in the
main window

If you do not perform step 1 and perform step 2 with no image
selected in the main window, all the images displayed in the main
window will be converted and saved.
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Batch Transfer Images to Image Editing Software

You can transfer multiple images to image editing software. Unlike
“Transferring a RAW Image to Photoshop” (p.113), you transfer images
that have first been converted and saved as a separate image, so the
transferred image will not be deleted after exiting the destination
software. The software used here as an example is Adobe Photoshop.

In the main window, select multiple images to be

transferred.

Select the [File] menu » [Batch process].
The [Batch settings] window appears.

Perform settings required for transferring (e.g. file

format).
Checkmark [Open im in ftwar
eckma pen image using software].
Batch settings “
MG_0001GR2 Destination folder
IMG_D002GR2 (®) Same as original files
IMG_0003 G2 =y )
MG 0008 CR2 _) Use this folder
IMG_00055R2 C¥Users¥user¥Pictures
MG, 0006 GR2 [7] Greate storage subfaldars for each file typs
IMG_0007CR2
IMG_00085R2 Exif-JPEG Subfolder name  JPEG
IMG_0009GR2
IMG_0010GR2 Qutput setting
IMG_0011GR2
Save as type Exif-JPEG (x.JPG) Image quality 1n

IMG_00125R2
IMG_00135R2
IMG_0014 GR2
IMG_00155R2
IMG_0017GR2
IMG_0018CR2
IMG_00185R2
IMG_0020GR2
IMG_00215R2
IMG_0022GR2
IMG_0023CR2
IMG_0024 GR2
IMG_0026GR2
IMG_00265R2
IMG_0027 GR2
IMG_0028CR2
IMG_00285R2
IMG_0080GR2
IMG_00315R2
IMG_0032GR2
IMG_0033CR2

Output resolution 360 dpi
[ Resize v
Width Height

472 x 2648 (5472 pixel x 3648 pixel}
Embed ISG profile

Shooting infa setting  Include all shooting info

File name
(@) Gurrent file name
) New file: name
String Additional string
nonoann

v
Ex.: IMG_0001.JPG, IMG_0002.JPG
Image transfer settings

[[] Open image usine software

Gonvert RAW images only

Unit |pixel

Execute Gancel

The [Open] dialog box appears.

Select Photoshop.
In the [Open] dialog box, select a Photoshop file or a shortcut
and click the [Open] button.
The [Open] dialog box closes and [Image transfer settings] in the
[Batch settings] window is set to Photoshop.

Click the [Execute] button.
The processing dialog box appears and batch transfer begins.
When the first image has been transferred, Photoshop starts up
and transferred images are displayed in transferred order.

To reset the transfer destination to another software, click the
[Browse] button in [Image transfer settings], and in the [Open]
dialog that appears, select the software and click the [Open]
button.

You can also use this function in the edit image window. However,
all images in the window (not only the selected ones) are
transferred.

.
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Batch Change the File Name of Images

In the main window, select multiple images of which
the file names are to be changed.

Select the [Tools] menu » [Start Rename tool].
The rename window appears.

Specify the required settings and click the [Execute]
button.

& C\Usersvood\Desktopvooos 03\ - OIEN|
File name Extension
DPP || Shooting Date/Time: v || Sequence number v | Donotchange v
Basic Settings Format settings
Sort Sequence number
(@) Fit to main window 0001 Save sequence number
_) File name
Shooting Date/Time
Shooting Date/Time
Year Month Day v
[#] same file name for RAW +IPEG images
YY-MM-0D v

Copy and Rename =
[¥] Insert underbar

Original File Name Modified File Name
IMG_0001.CR2 “ DPP_12-08-08_0001.CR2 A
IMG_0001.)PG DPP_12-08-08_0001.1PG
IMG_0002.CR2 DPP_12-06-23_0002.CR2
IMG_D003.CR2 DPP_12-08-09_0003.CR2
IMG_0004.CR2 * DPP_12-08-10_0004.CR2
IMG_0005.CR2 DPP_12-08-10_0005.CR2

IMG_0006.CR2 DPP_12-08-12_0006.CR2

IMG_D007.CR2 DPP_12-08-12_0007.CR2

IMG_0008.CR2 v DPP_12-08-12_0008.CR2 v
‘ Execute ' Cancel

Processing begins and the file names are changed.

? Changes cannot be made when the file name is duplicated

If a file name in red text appears in [Modified File Name], the file name is
duplicated. Changes cannot be made if even one file name is
duplicated. Change the settings so that duplication does not occur.

|§| You can change the file name of only one image in the main
window by selecting the thumbnail, right-clicking with the mouse,
and selecting [Rename] from the menu that appears.
You cannot start up the rename tool from the [Collection] window
(p.100). You also cannot change the file name of one image.

Changing the File Name of Images in the
Order in the Main Window

When you change the order of the images in the main window, you can
change in one operation the names of the files for the images, in the
order they were rearranged.

Change the order of the images in the main window
(p-35).

In the main window, select multiple images of which
the file names are to be changed.

Select the [Tools] menu » [Start Rename tool].

Select [Fit to main window].

e C:\Users\xxx\Desk|

File name
DPp v | Shooting Date/Time
Basic Settings

Sort

(@) Fit to main window

(_!File name

(_J Shooting Date/Time

Specify the required settings.
To copy an image, checkmark [Copy and Renamel].

Click the [Execute] button.
The file names are changed and the order in the main window is
maintained.
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Remote Shooting

Remote Shooting.........ccoooviiiiiiiii
Registering Click White Balance in the Camera
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Remote Shooting

You can perform remote shooting by using “EOS Ultility” which enables
communication with a camera in combination.

For remote shooting, “EOS Utility Ver. 3.x” must be installed on your
computer. For information on cameras compatible with “EOS Ultility Ver.
3.x", refer to “EOS Utility Ver. 3.x Instruction Manual” (electronic manual
in PDF format). This function is not available on EOS M series cameras
other than the EOS M50, or PowerShot cameras.

Click the [Remote Shooting] button on the toolbar in
the main window.

@ Digital Photo Professional 4 - [Folder: C:\Users\xood Desktop\xoooo_03]

File Edit View Thumbpails Preview Label Adjustment Tools Window Help

Edit Irmage 1 i Check Remote Shooting

Folder Eank mark Filter ON OFF o

Remote shooting setting window appears.

Set the [Destination] in the Specify Remote Shooting
Folder window.

Specify Remote Shooting Folder E

Destination

() Current Folder
G Usersioooca ¥ oo
(®) Usze this folder
G Ugerginonodbonm Select..

Destination folder

Mewe folder 1

File MNas
Do not modify ] Settings..

Cancel

To save to the currently selected folder, select [Current Folder].
To create a new folder for saving images, select [Use this folder],
click the [Select] button, then select the destination and enter a
name for [Destination folder].

After specifying settings, click the [OK] button.

The remote shooting window appears.
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|§| You can change the [File Name] for Specify Remote Shooting

Folder window.

(If [Do not modify] is selected, images are saved with the file names

set on the camera.)

Click the [Settings] button to display the Set file name for captured

image window.

Set file name for captured image

Do not modify

IMG

Assign Sequence MNo.
MNumber of Digits 4
Start 1

Shooting Date Format | Day Month Year v

DD-MM-YYYY v

W

File Prefix Customize...

Delimiter | Underline

()

Cancel

Select a naming rule for image file names from the list box.
You can click the [Customize] button and customize naming rules

for file names.

You can individually set prefix characters, number of digits for
serial numbers, and the start number for file names.

If you are using the shooting date in file names, you can specify
the date format (order and style for year-month-date) and
dividing characters on the Set file name for captured image

window.

Atfter specifying settings, click the [OK] button.
The Set file name for captured image window closes.
After clicking the [Remote Shooting] button, you can click the
[m] button at the bottom right of the main window to show/

hide the [Camera Control] palette.

You can perform shooting while checking the image by switching
the window to multi-layout.

Connect a camera and a computer, and turn on the
camera’s power.

Click the [Live View] button.

Liamera

EOQS KKK

1760 F40 IS0400

inatian :

subfolder

Re:

to
e s svesy -

Paiad * |

Live View window of “EOS Ultility” appears.
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Specify the required settings.

L] Remote Live View window - oIl

PC1 v) |Lv_ClickwB

Apply to shot images

For detailed instructions on setting procedures, refer to “EOS
Utility Instruction Manual” (PDF electronic manual).

Click the [Settings] button.

l.amera

EQS WK

1760 Fa.0 IS0400

Create subfolder

d

Re:

to:
IGO0 -

The capture window of “EOS Utility” appears.

Specify the required settings.

= EOS XXX = ‘:'

(=1

M

=
~M J _J
s O ,
e J _J

oEEEd

JP lity
WE SHIFT

Live View shoot. .

Introduction/
Contents

|

Downloading
Images

Viewing
Images

|

Sorting
Images

Editing
Images

Printing
Images
N
Processing
Large Numbers

For detailed instructions on setting procedures, refer to “EOS
Utility Instruction Manual” (PDF electronic manual).
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ECQIS W
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R
O -

e

The shot image is displayed.

The shot image will be saved in the folder created in step 2.

The images in the folder mentioned above will be displayed in

the thumbnail display area.

You can also create a sub-folder in the folder mentioned above to

save images. To create a sub-folder, click the [Create subfolder]

button on the remote shooting window, enter [Folder name] on

the screen appeared, then click the [OK] button.

Press the [l ] button to display DPP and EOS Utility windows

uniformly in line.

» Supported with EOS Utility version 3.8 and later.

* If you are using multiple monitors, DPP’s main window and
EOS Utility’s remote window can only be lined up uniformly
when on the same monitor.

@ Do not exit “EOS Utility” when remote shooting is being set or

5

performed.

In the cases below, perform shooting with EOS Utility.

* You want to autofocus with EOS Utility’s shoot button

* You want to perform continuous shooting

You can perform shooting while comparing the shot image with a
pinned image by pinning an image (p.20). This is convenient for
image selection.

Registering Click White Balance in the Camera

During remote shooting, you can register click white balance to the
connected camera. To use this function, EOS Utility version 3.4.20 or
later must be installed on your computer.

This function is not available on EOS M series cameras other than the
EOS M50, or PowerShot cameras.

Display the shot image to be used as the standard
for white balance.

extension.

Select the destination where to register click white
balance.

Camera

ECQIS W

1/60 F4.0 IS0400

zubfolder

Registered to :

HHRRRHHRER -

Pad ® |

Select the destination where to register white balance from the
[Registered to] list box. Options in the list box depend on the
camera model.
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Select a point that is to be the standard for white
balance in the shot image, and register the white
balance in the camera.

ECQIS WO

1/60 F40 IS0400

1Ider

R

=] (e
S0

Click the [[EZT=H] button, and in the displayed image in step 1,
click on a point that is to be the standard for white balance with
the mouse.

The white balance is registered to the destination selected in
step 2, and applied to displayed images.

Click [[EZT=H] again to exit the function.
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8 Playing Back Movies and Saving Still Photos

Playing Back Movies and Saving Still Photos

134
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Playing Back Movies and Saving Still Photos

In systems running 64-bit versions of Windows 8.1 or later, you can use DPP to play back MOV or MP4 movies shot using a supported camera and
save still photos from the movies as JPEG or TIFF images. To use this function, [Play with Digital Photo Professional 4] must be selected in [Movie file
playback] in the [General Settings] tab sheet in [Preferences].

Note that you cannot edit movies in DPP.

Double-click the movie thumbnail in the main window (thumbnail layout).

JEoaQ e

JRGE (

The preview window appears.
If the preview control panel does not appear, select the [Preview] menu » [Preview control panel].
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Use the preview control panel for each operation.

(1)

(2)

@)

(4)

()

(6)

(10) Save as still photo

(4) Show playback time

(5) Frame position slider

2Hoq >

(6) Frame no./Total frames

+

(2) Next frame
(1) Play/pause

(3) Previous frame

Play/pause
Play and pause the selected movie.

Next frame
Move forward one frame. When movie playback is paused,

this allows you to advance the movie one frame at a time.

Previous frame
Move back one frame. When movie playback is paused,
this allows you to rewind the movie one frame at a time.

Show playback time
Shows the playback time.

Frame position slider
By dragging the slider left or right, you can move the
playback position while a movie is playing or paused.

Frame no./Total frames
Shows the current frame number in the movie being
played back or shown and the total number of frames.

(7) Mute/unmute

(8) Volume slider
(9) Viewing LUT on/off

(7) Mute/unmute
Turns audio output on or off.

(8) Volume slider
Drag the slider left or right to adjust the volume for the
movie being played back.

(9) Viewing LUT on/off
Enables or disables Viewing LUT for movies shot with
Canon LOG specified.
This setting can also be changed during movie playback.

(10) Save as still photo
Allows you to capture a still photo of the movie frame
currently being displayed.
When you click the button, the [Convert and save] window
(p.92) appears. Specify the necessary settings, and then
click the [Save] button to save the image.
Note that you cannot save a still photo while the movie is
playing back. Pause the movie and then save the still
photo.

If the preview control panel does not appear, select the [Preview] menu P [Preview control panel].
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@ On some supported cameras, shooting a movie generates a “. THM”

5

file that is saved together with the movie file.The “. THM” file has the
same image number as the movie file and records the shooting
information. In DPP, the movie file and “. THM” file must be stored in
the same folder when the movie is played back.

You can also play back movies in the following windows:

* Main window (multi-layout)

+ Edit image window

» Remote shooting window (multi-layout)

* Multi-function preview window

In Preferences, you can change the movie playback application
to that used by your computer’s OS or to EOS MOVIE Utility.
(p.138)

For information on EOS MOVIE Utility, refer to the EOS MOVIE
Utility Instruction Manual.
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Specifying Preferences

You can change the various functions of DPP in the [Preferences]
window. Check the contents of each window and set.

Refer to the detailed explanations if available, as well as to each
window.

Select the [Tools] menu » [Preferences].

The [Preferences] window appears.

Select a tab sheet, specify the settings, and then
click the [OK] button.

Preferences
Startup folder ¥
Image Processing 1 (@) Last displayed folder
Image Pracessing 2 () Specified folder
GColor management C¥UserskuserdPictures Browse...

Wiew settings

Praperties display Ee 2
settines (@ Display message when adding file

) fidd to file automatically

Movie file playbacit
(®) Play with Digital Photo Professional 4

) Play with defautt application
Mavies that cannot be played with Ganon applications are passed to the default application.

Receiving files from EOS Utility
Automatically focus on a file received

Detault value of autput resalution %
350) dpi(1-50000)

Tamporary Files*

Gurrently used 05 ME Delete Resst
Amount of Dual Pixel RAHW cache used 00 ME Delete

Masximum available on disk 4GB0 8

Destination G Users¥user¥AppData¥Roaming¥Canon Tne G Browse...

*Changes take effect after restarting Sace)

General Settings

You can specify the folder that opens when DPP is started up, saving of
recipes, etc.

Preferences H

Giern settings Startup folder *

Image Pracessing 1 (®) Last displayed folder

Imsgs Processing 2 ) Specified folder

Golor management C¥Users¥ussr¥Pictures Browse..
View settings

Properties display £ el

settines ® Display message when addine file

() Add to file sutomatically

Movie file playback*
(®) Play with Digital Photo Frofessional 4

() Play with default application
Moviss that cannot be played with Ganon applications are passed to the default pplication

Receiving files from EOS Liility
Automatically focus on a file received

Dedault value of output resolution *
250 dpi(1-60000)

Temparary Files*

Currently used 05 MB Delete Reset
Amount of Dusl Pixel RAW cache ussd 00 MB Delete

Mescimum available on disk 4GB0 k]

Destination G¥lsers¥user¥AppData¥Roaming¥Canon o IG Bromse

#Changes take effect after restarting

Movie file playback
Choose the application used for playing back movie files. Movies that
cannot be played back in DPP or EOS MOVIE Utility are played back
with the movie playback application specified with the computer’'s OS
settings. For information on EOS MOVIE Utility, refer to the EOS MOVIE
Utility Instruction Manual.

®

If you have changed the movie playback application to EOS
MOVIE Utility, and playback does not start after starting up EOS
MOVIE Utility, check compatible models with the EOS MOVIE
Utility Instruction Manual.

If the movie playback application specified with the computer’s
OS settings is set to EOS MOVIE Utility, MOV and MP4 files shot
with the models that are not compatible with EOS MOVIE Utility
will not be played back. Check the OS settings and change the
movie playback application.
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Default value of output resolution

Temporarily saved files
You can delete temporarily saved files that were created and improve
operation speed, change file save destinations, or set a limit on disk
usage. Any changes you made will be applied when you start up DPP
again.

[Delete] button:

[Maximum available on disk]:

[Destination]:

[Reset] button:

possible.

When saving JPEG or TIFF images created by converting RAW images
(p.91, p.123), the resolution of the JPEG or TIFF images can be set.

Click the [Delete] button to delete
temporarily saved files.

Set with the slider (setting range: 0 to
32 GB).

Once usage reaches the limit, files
are erased starting with the oldest.
Click the [Browse] button to change
the save destination in the dialog that
appears.

Click the [Reset] button to revert all
changes to the original settings.

® On 32-bit OSs, only deleting temporarily saved files is

Image processing
You can specify settings for processing images in DPP.

Image Processing 1

Preferences H

JPEG image quality *
[] Remave block noise and mosquita noise

Modified Picture Style settings ¥
Retain settings of each Picture Style

Praview imags settings
Shom stamp editing status on preview images

Select to show stamp editing status on all preview screens

Glear o show stamp editing status only on the stamp editing sereen
Noise reduction defaultss
(®) Apply camera settings Applies to RAW images anly
O Set as defaults

00

0.0

Sharpress defaultst

@® Apply camera settings fpplies to RAW images only

0.0
0.0
0.0

*Changes take effect after restarting Cancel

JPEG image quality

[Remove block noise and mosquito noise]
You can improve the quality of a JPEG image by reducing the noise
particular to JPEG images.
This setting is also effective when RAW images are converted to
JPEG images and saved (p.91, p.123) and for JPEG images that to
be saved with a different name. The higher the JPEG image’s
compression rate, the better the effect. And when the compression
rate is low, the effect of noise reduction may not be noticeable.

Modified Picture Style settings
If you checkmark the checkbox, setting values for [Color tone], [Color
saturation], [Contrast], [Unsharp mask], [Sharpness], and other options
will be retained for each Picture Style.
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Noise reduction defaults
You can set a default beforehand for the noise reduction level. Only
RAW images are supported.
When [Apply camera settings] is selected, you can pre-set a noise
reduction level that suits the camera settings beforehand as the
default.
When [Set as defaults] is selected, you can pre-set a preferred
default setting for the noise reduction level beforehand.

For images not having a recipe attached, the default noise reduction
level set here is applied. If you changed settings, they will be applied to
images as the default noise reduction level when you start up DPP
again.

For images with a recipe attached, the noise level recorded in the recipe
remains as it is and the default for noise reduction level set here is not
applied.

Sharpness defaults
You can set a default beforehand for the sharpness. Only RAW images
are supported.
When [Apply camera settings] is selected, you can pre-set a

sharpness that suits the camera settings beforehand as the default.

When [Set as defaults] is selected, you can pre-set preferred
default settings for the sharpness and unsharp mask beforehand.

For images not having a recipe attached, the defaults for sharpness and
unsharp mask set here are applied. If you changed settings, they will be
applied to images as the default sharpness level when you start up DPP
again.

For images with a recipe attached, the sharpness level recorded in the
recipe remains as it is and the defaults for sharpness and unsharp mask
set here are not applied.

® On 32-bit OSs, the [Preview image settings] menu is not
displayed.

Image Processing 2

neral settings Quick cheok window settings*
@) Shaw ariginal image

() Showm image with recipe applisd

ced up preview display

Detault size when opening RAW imagest
Original size (do not change) v

* Applies to display of compact GRS files and ta resizing when images ars converted

*Changes take effect after restarting

Preferences H

Quick check window settings
You can specify image display settings for the quick check window. By
selecting [Show image with recipe applied], images with a recipe
attached are displayed with the recipe applied. Any changes you made
will be applied when you start up DPP again.

Graphic processor settings
If you checkmark [Use graphics processor for image processing], the
graphics processor is used to allow a faster preview display. The CPU
handles convert and save tasks as well as print tasks as usual. Settings
will be applied the next time DPP is started up.
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To use this function, a NVIDIA CUDA (Compute Capability 2.0 or
higher) GPU* with at least 1.0 GB of video memory is necessary.
Additionally, the latest NVIDIA GPU driver must be installed.

Color Management

You can specify settings relating to color management, such as settings
for work color space, conditions for color matching, etc.

* GPU is an abbreviation of “Graphics Processing Unit”.

The [Use graphics processor for image processing] checkbox is
available only when a supporting GPU is installed.

If the OS or other application software is using the GPU,
processing by the GPU may not be possible in some
circumstances. In such a case, the CPU handles processing as
usual.

Default size when opening RAW images
This applies only to RAW images with the extension “.CR3” that were
shot with [c@¥] selected on the camera.
This specifies the size defaults when RAW images are opened in DPP.
This default size is also set when RAW images are converted and saved
as JPEG or TIFF images.
The settings are applied the next time DPP is started up.

Preferences H

Default settings of Work color space *

® sRGE O fpple RGB

() Adobe RGB O GolorMatch RGE
() Wide Gamut RGE

[[] Use shooting color space as work color space
Gaolor matching settings
For display

) sRGE

(®) Use the 0S settings

) Menitor profile

Printing profile
[-— MNone —- -]

GMYK simulation profile
[ Mo —- -]

#Changss take effect after restarting el

Default settings of Work color space

You can select the color space (p.149) to be applied as a default setting
of RAW images from five types. The color space set will be applied as
the color space when a RAW image is converted and saved (p.91,
p.123) or printed (p.116 to p.119).

If you change the color space, and you restart DPP, the set color

space is applied as the default color space.

You can check the color space that is set in an image in all windows

except the quick check window.

If you checkmark [Use shooting color space as work color space],

the color space specified with the camera when the image was shot

will be set as work color space.
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-Z\@IE Changes are not applied to the edited image

Even if the default setting is changed, the new default setting is not
applied to edited (i.e., adjusted using the tool palette, cropped, dust-
erased) images. Change the settings individually.

|§| You can set a color space that is different from the default settings
for each image (p.88).

Color matching settings (color setting of the monitor)

Where a profile (p.148) is attached to the monitor you are using, you can

display an image in more faithful colors by setting the profile.
If you select [Use the OS settings], the color profile set in Windows
will also be applied in DPP. If you are using multiple monitors, the
profile set for each monitor is applied to DPP.
Select the [Monitor profile], click the [Browse] button. You can
select a profile for your monitor in the dialog box that appears.

A/

5@3 Precise coloring with a third-party monitor color reader

If you use a profile created using a third-party monitor color reader,
images can be displayed in even more precise colors.

Printing profile (color setting of the printer)
Where a profile is not attached to the printer you are using to print
images, you can print an image, simulating the colors displayed on
screen by setting the profile in DPP.

|§| When you set a profile for printing in DPP, set the color adjustment
function of the printer driver to off. If it is left on, the image may not
be printed in colors close to those displayed on screen.

View Settings

You can set layout for screen display.

Preferences

General settings Thumbnail order

Image Processing 1 Default sort order File name v @ Ascending
Image Processing 2

roperties display Tool tips
nes
Shaw toal tips

Reset user interface *
[ Restore defaults at startup
.

Tmage hackeround colar

Previem screen backeround color

I (default) -

Image z00ming

@® Single-click ) Double-slick

HOhanges ake effect after restarting Gancel
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. . . Properties to display —
Propertles D|5p|ay Settmgs You can specify detailed settings for [Display settings for thumbnails Downloading
You can specify settings for shooting and recipe information that with info], [Display settings for thumbnail list], and [Display settings for Images
appears with thumbnails and in the preview window. preview properties].
Items that can be selected appear in the list box at left, and actually 'y
— 1 displayed items appear in the list box at right. Specify items with the er;vg;gg
S [Add >>] button and [<< Remove] button. You can also change the
e display order with the [Move Up] button and [Move Down] button.
e i Sorting
Preview properties font |mages
Display settings for thumbnails with info v Editi ng
Sheve o + e Images
]ESX e + S:::er Speed
Color space add 53 Printing
- Images
Processing
Wors | [ Mers o Large Numbers
of RAW Images
¥Changes take effect after restarting Eare e
Remote
Shootin
Thumbnail display settings J
You can specify information that appears on thumbnails. Biavins Badk
If the [Show Av/Tv/ISO on thumbnails] checkbox is checked, Av/Tv/ISO O S
information is displayed on thumbnails if thumbnails are set at Size 3 or Still Photos
larger.
Spgling
Preview properties font Prefefghces
You can specify the font used for information displayed in the preview
window.
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.

- Introduction/
Troubleshooting "Contents.
If DPP is not operating correctly, refer to the subjects below. ——

A recipe could not be pasted (applied) to another image

. Contents that can only be adjusted for RAW images cannot be Images

Installation can not be completed correctly applied as a recipe to JPEG images or TIFF images.

Select an administrator-level privilege ([Computer administrator], . . . . Viewing

[Administrator], etc.) when setting the user. You cannot install the Colors are subdued in the image when viewed with Images

software if the user setting other than an administrator-level privilege other software S

is selected. For detailed information on selecting an administrator- ) ) ) .

level privilege, refer to your computer User’s Manual. If a RAW image which has a color space pther than sRGB is ISortmg
converted and saved as a JPEG or TIFF image (p.88, p.141), the mages '
colors will be subdued when viewed in software that is only )

DPP does not work compatible with sRGB color space. In such a case, set the RAW Editing ]
DPP does not operate correctly on a computer if its system image’s color space to sRGB, convert and save again as a JPEG or Images
requirements are not met. Use DPP on a computer with compatible TIFF image, and then view the image. -
system requirements (p.3). The Auto Lighting Optimizer (p.56) is a function compatible with
Even if your computer has the RAM capacity (memory) described in cameras equipped with the Auto Lighting Optimizer. Printing

. . S . : . P . : Images
the system requirements (p.3), if other applications are running at the Adjustments made with the Auto Lighting Optimizer cannot be applied
same time as DPP, you may not have sufficient RAM (memory). Exit to RAW images shot with the cameras not compatible with this :
any applications other than DPP. function. L Processing
arge Numbers
. . of RAW Images

The card reader does not detect the SD card The colors of the image displayed on screen and —
Depending on the card reader and computer OS used, SDXC cards the colors of the printed image do not match s'?ggg:le
may not be correctly detected. In such a case, connect your camera If the color of the monitor that displays an image is not adjusted J
and computer with the provided interface cable, and transfer the correctly, or if the profile for a printer that is to print image is not set :
images to your computer using EOS Utility. up, the color of the image displayed on screen and the color of the Mocilgzlgr?sta:\lf(ing

printed photograph may differ greatly. If the color of the monitor that Still Photos

Images are not displayed properly displays images is corrected and the profile for a printer is set up

) ) correctly (p.142), the color of a printed photograph and the color of an Specifying
Images that are not supported by DPP are not displayed. (Thumbnail image on screen can be more closely matched. Using a Canon printer Preferences
images are displayed as [?].) On a 32-bit version PC, when more automatically sets up the profiles for the printer, so you only need to

images than the maximum displayable amount are detected, images
beyond the maximum are not displayed. (Thumbnail images are
displayed as [?].) There are various types of JPEG and TIFF images,
so JPEG images other than Exif 2.2, 2.21 or 2.3 compatible images
and TIFF images other than Exif compatible images may not to be
displayed properly (p.4).

set the color of the monitor to bring the colors closer to each other.

Printing a large number of images in batches
cannot be performed
If a large number of images are printed in batches, printing may stop

in the middle or the images may not be printed. Reduce the number of
images to print or increase the memory on your computer.
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Deleting the Software (Uninstalling)

Exit any applications before uninstalling the software.

Log in under an administrator-level privilege when uninstalling the
software.

Uninstall the software according to the OS software uninstalling
method.

To prevent computer malfunctions, always restart your computer after
you have uninstalled the software. Re-installing the software without
first restarting your computer is particularly likely to result in computer
malfunctions.
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Image Frame Information in the Main Window and Edit Image Window (v.12, p.98)

Trimming (cropping) range*2 (p.68)

Check mark
(p.32, p.33)

Recipe mark

Image type

*3
Rating mark (p.32, p.33) GPS mark

Digital Lens Optimizer mark
(p.76)

*1 Displayed on RAW+JPEG images displayed as a
single image (p.14).

[[ R ]]is displayed in RAW images.

[[DPR]] is displayed in Dual Pixel RAW images.

*2 \When aspect ratio information is attached to an image
shot with any supported camera other than the EOS 5D
Mark Il, the image is displayed as a cropped image.

Pinned image setting mark (p.20)

IMG_0003.CR2

File name

Multiple image display mark
(p-21)

"2
150800

IMG_0030.CR2

Lens aberration
correction mark

(p.72)

Shooting
information

Unsaved editing content mark

*3 Displayed on images shot on a GPS function-
compatible Canon camera.

*4 Shows that the movie is splitand includes movies
other than that shown in the thumbnail.
The following icons may be displayed:

n : No final movie
n : No initial or final movie
n : No initial movie
5] : All split movies present

VGA3DIPB.MOV

Split movie mark *

[ ] is displayed in an image
frame when editing is not
possible.

Movies played back using
software other than DPP are
displayed with a [ [ ] icon in the
thumbnail image.
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Glossary
RAW image

EOS DIGITAL camera RAW images are recorded in an uncompressed
14bit or 12bit format.

Because RAW images are special images in an undeveloped status,
you need software with development processing functions such as DPP
in order to view them. The advantage of the undeveloped RAW images
is that you can make a variety of adjustments to RAW images with
almost no deterioration of the image.

* “RAW” meaning “in a natural condition” or “not processed or refined”.

JPEG image

The most ordinary image in non-reversible compressed 8bit format.
The advantage of this is that by saving at a high compression rate, the
file size can be small, even for image data that has a high pixel count.
Because during saving and compression part of the data is thinned out
to make the file size small, every time you edit or save, the image
deteriorates.

With DPP, even if you repeat editing/saving, only the recipe data is
modified, and no overwriting or compression occurs so the original
image data does not deteriorate.

* JPEG is an abbreviation of “Joint Photographic Experts Group”.

TIFF image

Bitmap-format image recorded in a 8bit/16bit uncompressed format.
Because TIFF images are in uncompressed format, they are suitable for
saving an image while maintaining the original high image quality.

* TIFF is an abbreviation of “Tagged Image File Format”.

Recipe

The “Image processing conditions information” for RAW images that can
be edited in DPP is called a “recipe”.

Further, in DPP, you can perform image editing on JPEG and TIFF
images that use “recipes” as with RAW images.

bit number

Binary unit of information volume in the color of an image. The number
shows the number of bits per pixel.

The larger the number of bits, the more the color numbers and the
gradation becomes smoother. A one-bit image is a black-and-white
image.

Color Management System (Color Matching)

Digital cameras that shoot images, monitors that display images, and
printers that print images each have a different way of creating color. For
this reason, there may be a difference between the color of an image
when viewed on a monitor and when printed.

A color management system is a system for managing color in order to
bring these colors closer together. With DPP, you can more closely
match color between different devices using ICC profiles between
different devices.

ICC profiles

ICC profiles are files containing color information such as color
characteristics and color space for various devices, set by the ICC
(International Color Consortium). Most devices such as the monitor we
use to view images or the printer we use to print images can be
managed (color management) using these ICC profiles and the color
between different devices can be more closely matched.

DPP has color management that uses these ICC profiles.

Tone Curve

A tone curve shows values before adjustment (input) as the horizontal
axis on a graph, and the values after adjustment (output) as the vertical
axis. Since the values of before adjustment and after adjustment are the
same before any adjustment is made, the tone curve displays as a
straight line from bottom left to top right, and by changing this tone
curve, you can adjust in detail the image’s brightness, contrast and
color. The more you go right on the horizontal axis, the more the plus
value it becomes, and the higher you go on the vertical axis, the more
the plus value it becomes.

.
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Color space

A color space is the reproducible color range (color gamut
characteristics). DPP supports the following five kinds of color space.

sRGB :

Adobe RGB :

Apple RGB :

ColorMatch RGB :

Standard color space for Windows. Widely used for

the standard color space of monitors, digital
cameras, and scanners.

A wider color space than sRGB. Mainly used for
printing for business purposes.

Standard color space for Macintosh. A slightly
wider color space than sRGB.

A slightly wider color space than sRGB. Mainly
used for printing for business purposes.

Wide Gamut RGB : A wider color space than Adobe RGB.
Refer to the color chart below for the color area of each color space.

Color chart of color spaces compatible with DPP

Y

0.8

sRGB

— v Adobe RGB
-------- Apple RGB
————— ColorMatch RGB
=— — — — Wide Gamut RGB

Color range that can be
seen by the human eye

08 X
Gamma White point
value (color temp.)
sRGB 2.2 6500K(D65)
———————-- Adobe RGB 2.2 6500K(D65)
............ Apple RGB 1.8 6500K(D65)
————— ColorMatch RGB 1.8 5000K(D50)
—————— Wide Gamut RGB 2.2 5000K(D50)

CMYK simulation profiles

A profile that simulates colors when printing in a CMYK environment
(printing machine, etc.). With DPP, you can simulate color with four

types of profile.
Euro Standard :

JMPA :

U.S.Web Coated :

Profile normally used for book printing in
Europe, suitable for simulation of standard
European printing.

Profile normally used for book printing, etc. in
Japan, suitable for simulation of magazine
advertising standard color printing.

Profile normally used for book printing in
North America, suitable for simulation of
North American standard printing.

JapanColor2001 type3 : Profile becoming a standard in the Japanese

printing industry, suitable for simulation of
JapanColor standard printing.

Rendering intent

Rendering intents are color conversion methods when printing an image.
The conversion method of each rendering intent is shown below.

Perceptual :

Relative Colorimetric :

Before and after conversion, all colors are
converted to maintain the relationship between
colors. Even where colors slightly change, you
can print a natural-looking image which has
maintained color harmony. However,
depending on the image, the saturation may
change overall.

There will not be much conversion to colors
which are similar before and after conversion,
but colors which are not similar are converted
appropriately. Because there are little changes
to similar colors which comprise most of an
image, you can print a natural-looking image in
which the saturation has not changed greatly.
However, depending on the image, there are
cases where the overall tone of an image
changes somewhat as colors which are not
similar and highlights change.
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Index
A
Adjust JPEG IMagesS.....ccooieiiieiiee e 43
Adjust TIFF IMages......ccooviiiiiiiiii et 43
Adjusting
Adjustment Contents (Recipe) ..., 96
APPIlY AJUSTMENTS ..o 95
Automatic Adjustment (Gradation, Luminance)............ccccccccuneees 55
Brightness ........uueiiiiiiiiii e 46, 59
Brightness of Highlights.............cooiii 52
Brightness of Shadows.............cooiiiiiii e 52
Click White BalanCe ...........ooouiiieeeeeeeeee e 50, 60
Color SAturation ............cooeiiiiiiiiee e 53
Color TEMPEIALUIE ........vveiiiiiiiiiiiiiiiiiiieieeee e eee e 51
LO70] o] gl 1o 1= TSR 53
(076] 011 7= 11 SR UUTT TR TTR 52, 59
Copy AQJUSTMENLS ... 95
DynamiC RanNge.........uuuueeiieiiiieiieiieeeieeeeee e 54, 63
Filter Effect ... 54
[ LTS 64, 65
1Y/ [o] gloTel a1 o] o 1 [T 53, 65
Personal White Balance ..............cooviiiiiiiiiiiicii e 121
Picture Style File .......ooooeiiiiiee e 49
SatUratioN ... 64, 65
Save AdJUSIMENLS .......uii 95
SNAMPNESS ... bbb e b 57
Tone Curve Adjustment.........ccoooiiiiii s 61
Toning Effect ... 53, 54
White BalanCe ........oooovviiiiiiei 49
Adjusting Brightness ........ccooiiiiiiiii e 46
Adjusting TONE CUIVE ........uuuuiiiiiiiiiiiiiiiiiiiiiee e eeseeeseeeee 61
Adjustment Contents (RECIPE) .......uuuuumummmmiiiiiiiiiiiiiiiiiiiiiiiieeeeees 94, 148
AdODE RGB.....coiiiiiie e 149
AF POINES ..o 21
F Y o] o1 L= €] = PP 149
F N =T aTo L= [ F=To [ PSR 35
Auto Lighting Optimizer.........coocuiiiiiiiee e 56
Automatic Adjustment (Gradation, Luminance) ............ccceeeeeeeeeeeeeneee. 55
Automatic Dust Erasure Processing ..........cceveeeveeiieeeiiiiiiiiin e eeeeeeeennns 84

B
Basic Adjustment Tool Palette............cccccoooiiiiiiiiiiii 46
Batch Apply White Balance to Images (Personal White Balance)..... 121
Batch Change the File Name of Images..........ccccccoviiiiiiiiiiniii, 126
Batch Convert/Save Images (Batch Process) ........cccvvvvvvvvvvveeeeeeeeee. 123
Batch Process (Batch Save JPEG and TIFF Images)........cccccoou..ee. 123
Batch Process of Multiple Images
Change File Name ... 126
Convert/Save (Batch ProCess)........cccvvvvvvveriveieieiieeieeeeeeeeeeeeeeee 123
Personal White Balance................cccccooiiiiii 121
ReCipe Data ........ccoeeiieiiie e 94
L= 10 = SRR 125
Batch Settings WIiNndow...........coooiiiiiiiiiii, 123, 125
Batch Transfer Images ... 125
Batch Transfer Images to Image Editing Software...............cccccvvvnnee 125
Before/After Comparison Display .........ccccccveiviiiiiiiiiiiiiiiiieiiieeeeeeeeeeee 23
DIt NUMIDET ... 148
BOOKMArK ... 39
BrightNeSS. ... —————— 59
C
Change File Name..........ouuiiiiiiie e 126
Change the Display ........ccoeeeiiiiie

Changing the File Name of Images in the Order in the Main
WINAOW ... et
L0 T=Tod 1Y F= T o G
Chromatic Aberration Correction...........ccoooovveeiiiiiiiiieeeiee e,
Chrominance Noise Reduction...........ccccoooieiiiiiiiiceeeeeeeeeeeeee e
Click White Balance..............cooeveeiiiiiiieeeeeeeee e
CMYK SImMUIAtioN ..o
Collection WINAOW .........ooeiiiiieieee e
1070 (o] gl =] [N g 07014 =Y o1 { (] o W
L070] (o] S04 1 I- T o (5P
Color Management (Color Matching) .........cooocveeiiieeeiiiiiieeeeee e

(070] (o] gS] o 7= X
[CC Profiles ...
Color Management (Preferences) .........ccccooviciiiieiiiiiiiiiiiieeee e
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Color saturation..............eiiiiii e 53
Color Setting of the Monitor (Profiles)........cccccccc, 141
Color Setting of the Printer (Profiles) ... 142
COlOr SPACE ..o 149
AdODBE RGB ... 149
APPIE RGB ... 149
Color Space Setting for Each Image............cccccevvviiiiiiii i, 88
ColorMatch RGB .......ooiic e 149
SRGB ... . 149
Wide Gamut RGB.........cciiiiiiieee e 149
Color Space Setting for Each Image............ccccoee 88
Color Temperature..........coooeeiiiieee 51
(O70] o] g 1o 1= T PR 53
ColorMatch RGBi........oouiiii e 149
Compositing IMages ........cooovvviiiiiiiiiii 102
1070] 011 7= 1) (T 52, 59
Convert ONe IMage........oovvvviiiiiiiie 91
Convert to JPEG or TIFF Image and Save..............c.ccoeeeeeeen. 91, 123
Copy Stamp (Image Correction) .........cccevvviiiiiiiiiiii 87
Copying and Pasting (Applying) ReCIpes..........cccuvvieiiiiiiiiiiiiieeeeeee 95
Correct Images (Copy Stamp Function) ..., 87
L©7 o] o] o] T 68
Customize t00IDAr ..o 114
D
Default Color Space Setting...........ooooeeiiiiiiiei e, 141
Delete IMages. ... 38
Deleting
Do) (oI [ =T L= P 38
Delete the Software...........ccveeeieieiiiii e 146
Deleting DPP (Uninstalling) ........oooooiiiiiiieeeeiieeee e 146
Detailed Setting Printing (Printing with Shooting Information).......... 117
Digital Lens OptiMizZer..........oouvi oo 75
Digital Lens Optimizer mark............coooooi oo 147
Display
Before/After Comparison Display .......ccccevvvvviiiiiiiiiiiiiii, 23
Enlarged Display (Preview WiNndow) ..........ccceeviviiiiiiieeiieiiiniieennnn, 17

Enlarged Display (Quick Check Window) ...........cccceeveiiiiiiiineenen. 30
Multi-Function Preview............coovevvvviiiiiiiii 24
Single Image Display ..........ccuueiiiiiiiiiiiiee e 36
Synchronize Preview WIiNdOW............oooiiiiiiiiiiiiiiieeee e 97
Thumbnail Display (Main WindOw)............ccuuviiiiiiiiiiiiiiiieeee e 12
Thumbnail Display and Enlarged Display
(Edit Image WINAOW)...........uueiiiiiiiiiiiiiiiiiiireeseeeeeeveeeeeeeeeeeeeeeeeeeeeeees 98
Displaying Image Properties.........cccveuvvciiiii e 23
Displaying Shooting Information ... 23
Distortion CorreCtioN .........ccuueeeiiiiiiiiiiee e 72
Downloading an Image to Your Computer ..........cccccoiiiiiiieieiiiincinnee. 10
Downloading Images from a Camera ..................cccooeeeeeeeee. 10
Downloading Images from a Card Reader............................... 10
Downloading ImMages .........couuiiiiii i 10
Downloading Images from a Camera...........cccceeeeeeeiiiiiiiiieeee e 10
Dual Pixel RAW Optimizer.........ccvviiiieeeiiiiieee e 109
Dust Delete Data ........coooeeiiieieeeeeeee e 83, 84
Dust Delete/Copy Stamp Tool Palette............cccccvvvvvviiiiiiiiiiiieiieeeeeeee, 83
Dust Erasure Processing
Automatic Dust Erasure Processing ..........ccccevveeevivviiiiieeeeeeeeeennn, 83
Dust Delete/Copy Stamp Tool Palette ...........ccccccooeel. 83
Image Correction (Copy Stamp Function) ..........ccccoiiiiiiiiiinnnnns 87
Manual Dust Erasure (Repair Function) 85
DynamiC RANGE .....cooouiiiiiiiiie e
E
Edit ImMage WiNAOW........cooiiiiiiiii e
EditiNg. ..o
Enlarged Display (Preview WiNndow) ...........ccccccvviiiiiiiiiiiiieiieeeeeeeeeeeee,
EOS ULIIIEY .ot
EXItING DPP .ot
F
Filter EfECt ...
G
General Settings (Preferences) ..o
GPS MaACK ...t e e e
Grid LINES oo
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H
HDR (High Dynamic Range) Images...........ccccceviiiiiiiiiiiieeeeii, 106
Highlight Area Warning Indicator ...........ccccooveiiiiiiiicii e, 22
Histogram Palette ... 16
HUEB oo 44, 64, 65
|
[CC PrOfilES...ceeiieeee e 148
Image INformation ... 37
Image Marks (Image Frame Information) ...........cccceeveeviieiiievieniinnnnnn.. 147
Image processing (Preferences)........cccouviiieeiiiiiiiiiiiee e 139
Image Quality
NOiISE REAUCHION ......cueiiiiiiiiiiieeeeeeeeeeeee e 66
J
| =l 1 4= To [ TSR 43,148
L
Lens Aberration Correction ... 71
Lens aberration correction mark ............oooooiiiiiiiiiiiis 147
g T TR 55
Loading and Pasting (Applying) Recipes...........ccoeeiiiiiiiiiiiccccccc, 96
Luminance Noise Reduction............cccccoooe e, 66
M
Main WINAOW ..o, 12
Main Window (Multi-layout)............c..uuveeiiiiiiiiii e 19
Main Window (Thumbnail Layout) .............ccoooiiiiiiiiiicccc, 12
Manual Dust Erasure (Repair Function) ...........ccccceeiiiiiiiiicee 85
MONOCNIOME ... .. 53
Filter Effect ... 54
Toning effect.......oooi i 54
Move or CopY FOIAEIS. .......ueiiiiiiiiieee e 39
Move or Copy IMages.........ccoooiiiiiiiii, 38
Movies
L F= LY = 7= Vo] G 134
Save Still PROtOS ........oeiiiiiiee e 134
Split MOVIE MArK........ueiiiiiiiiii e 147
Multi-Function Preview. ... 24

MUHI-IAYOUL ... 19
Multiple image display mark ...........oooeuiiiciiniieeccer e 147
N
Navigator Palette .............oooeiiiiiii e 18
NoiSe ReAUCHION ... 66
(0]
Organize IMagES ......oooviiiiiieiee et 38
Organizing IMages .......cooooeiiiiiii s 38
Delete IMagesS ......ueeiiiiiiiiie s 38
Move or Copy Folders.........ccccvvvviiiiiiiiii 39
Move or Copy IMageS........ccovvvviiiiiiiiiiieie e 38
Register Folders as BOOKMArks........ccooovvvvvvveeviiiiciiiie e, 39
P
Palettes
Display Method of Palettes ... 27
Rearranging Palettes ... 27
Perceptual ..o 149
Peripheral lllumination Correction ..............cccceeviiiiiiiiiiiiiiiiiieeieeeeeeee 72
Personal White Balance ..o 121
PiICture STYIE ..o 47
Picture Style File.......ccooooiiiii e 49
T RSP 20
Pinned image setting mark............cooveeiiiciii e, 147
PrefereNCES ... 138
(070] (ol 1Y/ =T aF=To [T 1 1= o | SO 141
General SettiNgS ......uuviiiiiei e 138
IMAage ProCESSING....cceviiriiiiiie i e eee e e e e e e e e e e e e e eranaas 139
Properties Display Settings..........coociiiiiiieiiiiieee e, 143
View Settings ......oooooiiiiiii e 142
Preview Control Panel ... 20
Preview Display Ar€a .........uuucoiiii it 19
Preview WINAOW ..........oooiiici et 17
Printing
Printing a Thumbnail List (Contact Sheet Printing) ..................... 118
Printing One Sheet of Paper.........cccovv 116

Printing with Shooting Information (Detailed Setting Printing) .... 117
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Printing One Sheet of Paper ... 116
Printing with Shooting Information (Detailed Setting Printing) .......... 117
Properties Display Settings (Preferences)..........ccccccciiiiiiiiiiiiinns 143
Q
QUICK CheCk WINAOW........ciiiiiiiie et e e naeee e 30
R
= 111V 32, 33
= 1] o .= o 147
RAW IMage... .o eeeennees 42,148
Re-Adjusting an Image ..........ceeiiiiiiiieeeces e 93
RECIPE ... e 94,148
RECIPE File ...t 94
Re-Editing an Image ... 93
Registering Folders as Bookmarks..........ccccooeiviiiiiiiiiiicee e, 39
Remote Shooting ........uuveiiiiiii 128
Rename WINAOW........... e 126
Rendering Intent (Matching Method) ..., 149
Repair (Manual Dust Erasure) ............cccuvvvvvevvveviviriieeeeeeeeeeeeeeeeeeeeeees 85
Rotate IMages. ..o 12
S
SAtUrAtioN....cceeie e 44,64, 65
Save

Batch Convert/Save Images (Batch Process).........cccccccovinnnee. 123

ST Y USSP 91

SV AS i 91
SAVE AS. . 91
SaVING RECIPES ..ooviiiiiiieiieieeee 95
SecoNd WINAOWS ......ooovviiiiiiiiieieeee e, 25
SeleCt IMAgES ..coovviiiiiiieeee 12, 30, 98
Shadow Area Warning Indicator ... 22
SharPNeSsS.......oooiiiiii 57,78
Shooting Information Display ...........cccuveiiiiiiiiiiiii e 23, 37
Single Image Display ..., 36
Single Image Display of RAW and JPEG Image ..........occcvvveeeeeiiininns 36

Soft-Proof Colors Function ..., 89
Sorting Images
L0 0 1=To Q1 0 1 1= 1 16 32, 33
RatiNgS ..ceeeeiieeeeeeeeeeeeee e 32, 33
SRGB ... aaa s 149
Starting UP DPP .o 9
Supported IMAagES .....cccoeeeeeeeeeeee 4
Synchronization (Preview Window) ..o, 97
SYNCroNiZe IMAgES ........uuviiiiiiiiiiiee e 97
Synchronize Preview Window ..............cccooeiiiii e, 97
System RequIremMents ..........coooiiiiiiii e 3
T
Thumbnail Display (Filter/Sort Function) .............ccccccol. 15
Thumbnail Display (Main WIiNdOW) ...........cceiiiiiiiiiiieiieeeeee e 12
Change the Display...........ccuuuiuuiiiiiiiiiiiiiiiiiieiiiiesireeeeeeeeeeeeeeeeeeeeee. 13
Thumbnail Display (Multi-layout) .............cceeeriiiiiiiieeeeeeee 19
Thumbnail Display and Enlarged Display (Edit Image Window) ......... 98
Thumbnail Display Area ...........coooiiiiiiiiieee e 19
Thumbnail LayOut ..........cooiiiiiiieeece e 12
Thumbnails Control Panel ... 14
LI 4=V T 43, 148
TONE CUIVE ...t 148
TONING €ffECE...oiiiiiieeeeeeeee 54
ToOol Palette ....cooooiiiiiiieiieeeeeeee 44
Basic Adjustment Tool Palette ... 46
Color Adjustment Tool Palette ..............ouvvvvivviiiiiiiiiieieieiieeeeeeeeeeee, 64
Detailed Adjustment Tool Palette.............cccc 66
Dust Delete/Copy Stamp Tool Palette ...........cccccooool. 83
Lens Correction Tool Palette ...........cccveeeeeeiiiiiiiieeee e 71
Partial Adjustment tool palette ... 79
Settings Tool Palette ... 88
Tone Adjustment Tool Palette.............ooooiiiiiiiiiiies 59
Trimming/Angle Adjustment Tool Palette..............cccooois 68
LI To] 1 o = PP 12
Transfer
Batch Transfer Images to Image Editing Software .................... 125
Transfer an Image to Photoshop ........ccoooeiiiiiiiiis 113
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Transfer an Image to PhotoShop ............oeevviiiiiiiiiiiieeen 113
Trimming (CroppiNg) FANGE........uuurrrierrreerrrereereeeeeerereeeeeeerrereeeeeeeeeeeee. 147
Trimming/Angle Adjustment Tool Palette.............cccooeeiiiiiiis 68
Trimming/Angle Adjustment Window ..., 68
U
Unsaved editing content mark ... 147
O TS = Ty o 1Y = T RPN 58
\'
View Settings (Preferences) ... 142
Viewing Images in the Main Window (Thumbnail Layout) .................. 12
w
White BalanCe..........uueeiiiiiiiiiiiiiiiieeeeeeeeeeeeeee e 49
Click White BalancCe ..........cooouuiiiiiiiii e 50, 60
Color TEmMPErature ..............ueueeeueeiiiiiiiiiiieiieeieeeeieeeeeeeeeeee e eeeeeeeees 51
Personal White BalanCe .............uuuviviiiiiiiiiiiiiiiiieieeeeeeeeeeeeeeeeeeee 121
Wide GamuUt RGB ...........uuviiiiiiiiiiiiiiiiiiiiiiieiiiieeeveeeee e eeeeeeeeeees 149
WOIK COlOr SPACE......uuuiiiiieiieiieeeeeeeeeee ettt ee e e e e e e e e e e e e e e 88
Color Management.........cooooiiiiiiiiii e 141

About This Instruction Manual

It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.

Canon may change without notice the software specifications and
contents of this Instruction Manual.

The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.

Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademarks
Microsoft and Windows are trademarks or registered trademarks of
Microsoft Corporation in the United States and/or other countries.
Adobe and Photoshop are registered trademarks or trademarks of
Adobe Systems Incorporated in the United States and/or other
countries.
All other trademarks are the property of their respective owners.
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